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Chapter-1
INTRODUCTION OF MICROSOFT EXCEL

Structure
1.0 Learning Objectives
1.1  Introduction
1.2  Basic of Microsoft Excel
1.2.1 Microsoft Excel
1.2.2 Features of Microsoft Excel
1.3 How to Open Microsoft Excel?
1.3.1 Open Microsoft Excel in Windows 7
1.3.2 Open Microsoft Excel in Windows 8,8.1,10
1.3.3 Open Microsoft Excel in Windows 11
1.4 Understanding Microsoft Excel Basic Function
1.5 Understanding the Ribbon
1.6 Summary
1.7  Answer to Self-Check exercises
1.8  Suggested Readings
1.0 LEARNING OBJECTIVES
After going through this lesson, you will be able to:
» Understand the basic of Microsoft Excel
» Understand how to open Microsoft Excel
» Understand the basic function of Microsoft Excel
» Understand the concept of Ribbon
1.1 Introduction

Microsoft Excel is an application for creating spreadsheets that employs tables to
store and analyse numerical and statistical data using formulae and functions.

Simply said, MS Excel is a robust spreadsheet application that comes with Microsoft
Office and is primarily used to enter data into tables. It has a number of rows and columns
where data can be entered. The programme is regarded as useful for a variety of activities,
including bookkeeping, creating payslips, sorting and filtering data interactively, and calculating
weekly expenses.
1.2 Basic of Microsof t Excel

1.2.1 Microsof t Excel



Microsoft's Excel spreadsheet programme is a part of the Office family of business
software programmes. Users of Microsoft Excel may format, arrange, and compute data in
a spreadsheet.

One can enter data in the form of tables using the spreadsheet tool MS Excel. An
Excel spreadsheet makes it simple to analyse data. An Excel spreadsheet looks like this, as

shown in the image below:
m3

1.2.2 Features of Microsof t Excel
The following are some of Microsoft Excel’s key attributes:

Home

Font size, font styles, font colour, background colour, alignment, formatting options
and styles, cell insertion and deletion, and editing options all are available under the home
option.
Insert

Insertincludes features like table format and style, image and figure insertion, graph,
chart, and sparkline addition, header and footer choice, equation and symbol options, and

more.
2



Page Layout
Page Layout comprises options like themes, orientation and page setup.
Formulas
In order to generate a value, a cell can contain formulas, cell references, or functions.

Formulas must be introduced with an equal’s sign (“=").
Data

This category offers tools for adding external data (from the web), filtering choices,
and data.
Review

A reader may write comments in this section after proofreading an excel sheet (using
a feature similar to spell check).
View

Here, we can adjust the various views in which we want the spreadsheet to be
shown. Under this area, options for pane organisation and zooming in and out are provided.
You must first comprehend the three most crucial Excel features:

1. Cell: The smallest but most useful component of a spreadsheet is a cell. You have
the option of typing or copying and pasting your data into a cell. Text, numbers, and
dates all qualify as data. Additionally, you can alter its size, font colour, background
colour, borders, and other features. A cell's address, which includes its column
number and row number, serves as a unique identifier for each individual cell (If a
cell is on 11th row and on column AB, then its address will be AB11).
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Worksheet: Aworksheetis made up of individual cells may contain text, a formula,
or a value. Additionally, it contains an unseen sketch layer that stores diagrams,
charts, and photos. Clicking the tab at the bottom of the workbook window will take
you to each worksheet in the workbook. A chart sheet, which displays a single chart
and is accessed by clicking a tab, can also be stored in a workbook.
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Workbook: Every application has a separate file, just like a workbook does. There
are one or more worksheets in every workbook. A workbook is often referred to as
a collection of worksheets or as a single worksheet. Worksheets can be added or

removed, hidden without being deleted from the workbook, and the arrangement of
your worksheets can be modified.




1.3 How to open MS Excel?
1.3.1 Open Microsof t Excel in W indows 7
The procedures listed below should help you open Microsoft Excel on your computer:
> Click Start, followed by All Programs.
> Next step is to click on MS Office
> Finally, select MS-Excel as your output type.

Your Microsoft Excel programme will start, and you'll see the Microsoft Excel window
shown below.

1.3.2 Open Microsof t Excel in W indows 8,8.1,10

> Press the Windows key on the keyboard or click the Windows button in the
taskbar’s lower-left corner.

> In the lower-left corner of the screen, select “Search Box.”
> Type “Excel”.
> Click the Excel icon as shown in the screenshot below.




Your Microsoft Excel programme will start, and you'll see the Microsoft Excel window
shown below.
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1.3.3 Open Microsof t Excel in W indows 1 1

> Press the Windows key on the keyboardor click the Windows button in the taskbar’s
lower-left corner.

» Click the Excel icon as shown in the screenshot below.
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» Next step is to click on Blank Workbook as shown in the screenshot below:
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» Your Microsoft Excel programme will start, and you'll see the Microsoft Excel window
shown below.

1.4 Underst anding Microsof t Excel Basic Function
Excel has two primary methods for performing calculations: formulas and functions.



FORMULA:

A formula in Excel is an expression that manipulates values in a cell or a range of
cells. Consider the formula =A1+A2+A3, which calculates the sum of the values in cells Al
through A3.

FUNCTIONS:
In Excel, functions are predefined formulas. They provide formulas human-friendly

labels and do away with tedious manual entry. for instance, =SUM (A1:A3). The formula
adds up each value from Al to A3, or array A.

One of Excel's most crucial features is the functions. You can use it to conduct both
simple and complicated computations.

SUM: It gives back the total of the cell’'s numerical values. You can insert the values directly
into the function or refer to the cells where you have data.Using the Excel AutoSum button
is the quickest and most straightforward approach to add a group of cells. The selected cell
receives an automatic Excel SUM function entry. With the SUM function, you may add up any
number in a set of cells.

COUNT: It gives back the number of numerical values found in a cell. You can insert the
values directly into the function or refer to the cells where you have data.The COUNT
function counts cells with numbers in a range.

AVERAGE: It gives back the cell's mean of all the numerical values. The AVERAGEIF
function calculates the average of a range based on a true or false condition.

TIME: According to Excel’s time format, it returns a legitimate time serial number.
Hours, minutes, and seconds must be specified [...]

DATE: It gives back a legitimate date serial number that follows Excel’s time format.
You must select the day, month, and year.

LEFT: With the leftmost character coming first, this method extracts particular characters
from a cell or string (start). The text and the quantity of characters to be extracted must be
specified.

RIGHT: Starting from the right, this method removes particular characters from a cell or
string (last). The text and the quantity of characters to be extracted must be specified.

VLOOKUP: When avalue is searched for in a column, it can either return that value directly
or a value from the adjacent columns using the same row number.A one-column or one-row
range is searched for a close match using the Excel LOOKUP function, which then retrieves
the comparable value from another one-column or one-row range.

IF: When a value is searched for in a column, it can either return that value directly or a value
from the adjacent columns using the same row number.The IF function in Microsoft Excel
returns one value if the condition is TRUE and a different value if it is FALSE.

8



The IF function, an Excel built-in function, falls under the category of a logical function.
It can be used in Excel as a worksheet function (WS). The IF function can be used as a
worksheet function to input a formula as part of a formula in a worksheet cell.

Syntax:

The syntax for the IF function in Microsoft Excel is:

IF (condition, [value_if true], [value_if false])

Parameters or Arguments

condition

The value that you want to test.

value_if true

It is the value that is returned if condition evaluates to TRUE.

value_if _false

Optional. It is the value that is returned if condition evaluates to FALSE.

Nested IF: Nested IF functions, meaning one IF function inside of another, allows you to
test multiple criteria and increases the number of possible outcomes.

NOW: The cell you insert is updated with the current date and time.It using the settings on
your computer [...]

LARGE: When a list is sorted by value in descending order, the Excel LARGE function
produces a numeric value based on its position inside the list. In other words, LARGE can
return the “nth largest” value, which includes the first, second, third, etc. largest value.

SORT:The SORT function orders the elements of an array or range either in ascending or
descending order.

MAX: The MAX function finds the highest number in a range.

SQRT:Anumber’s square root is a quantity that, when multiplied by itself, yields the original
number. Excel's SQRT function gives the square root of an integer.

Exponential: The EXP function in Excel, which is classified as a Math/Trig function and
returns a numerical value equal to e raised to the power of a specified number, is an
exponential function. The value of the exponential growth and decay mathematical constant
e is roughly 2.71828.

Square: The power function, denoted by the carat sign, in Excel allows you to square a
number. Use the equation =N"2, where N might be a number or the value of the cell you want
to square. A worksheet can make numerous uses of this formula.



1.5 Underst anding the Ribbon

Shortcuts to Excel commands are available via the ribbon. Acommand is a task that the user
carries out. Making a new document, printing a document, etc. are examples of commands.
The Excel 2021 ribbon is displayed in the picture below.

Ribbon st art button

It is used to access commands, such as those for generating new documents, saving
completed work, printing, and accessing Excel customization options, among others.
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Ribbont abs
Similar instructions are grouped together using tabs. The home tab is used for basic operations
like sorting and finding specific data inside the spreadsheet as well as formatting the data
to make it more attractive.
Ribbon bar
The bars are used to group together similar commands. The instructions used to align data,
for instance, are all gathered together in the Alignment ribbon bar.
1.6 Summary
In this chapter, we have studied:
» Microsoft Excel is an effective spreadsheet tool used to collect, process, and store
numerical data.
» In Excel, the ribbon is utilised to access multiple commands.
» We've reviewed many procedures for opening Microsoft Excel.
1.7 Answers to self-check exercises
Q.1 Explain various features of Microsoft Excel?
Q.2 What are the various function of Microsoft Excel?
Q.3 Explain the various ways to open Microsoft Excel?
Q.4 How Ribbon tab is different from Ribbon bar?
10



1.8 Suggested Reading
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Ron Mansfield, The Compact Guide to Microsoft office; BPB Publication.
Dienes, Sheila s., Microsoft office, Professional for windows 95.

Joan Lambert, Curtis Frye, Microsoft Office Step by Step (Office 2021 and Microsoft
365),Microsoft Press Publication.

Kenneth N. Berk,Data Analysis with Microsoft Excel.
Wayne L. Winston,Microsoft Excel 2013: Data Analysis and Business Modeling.

Danielle Stein, Using Excel for business analysis: a guide to financial modelling
fundamentals.

Olafusi M., Microsoft Excel and Business Data Analysis for The Busy Professional
Rajiv Mattus: Learning Excel 97 for windows step by step BPB publication.
Lonnie. E. Moseley & David M. Boodey: Mastering office 97.

Micro Soft Office 97: Unleashed:Techmedia.

John Walken Bach: Excel 97.
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Chapter-2
MICROSOFT EXCEL WORKBOOK AND WORKSHEET

STRUCTURE
2.0 Learning Objectives
2.1 Introductionof Microsoft Excel Workbook
2.1.1 How to create a new workbook?
2.1.2 How to create a workbook from a template?
2.1.3 How to rename a workbook?
2.2 Introduction of Microsoft Excel Worksheet
2.2.1 How to select a Worksheet?
2.2.2 How to insert a Worksheet?
2.2.3 How to rename a Worksheet?
2.2.4 How to move a Worksheet?
2.2.5 How to Delete a Worksheet?
2.2.6 How to Copy a Worksheet?
2.3 Introduction to Row
2.3.1 How to insert a row in Excel?
2.3.2 How to delete a row in Excel?
2.4 Introduction to Column
2.4.1 Howto insert column in Excel?
2.4.2 How to delete column in Excel?
2.5 Summary
2.6 Answer to Self-Check exercises
2.7 Suggested Readings
2.0 LEARNING OBJECTIVES
After going through this lesson, you will be able to:
» Understand the basic of Microsoft Excel Workbook
» Understand the basic of Microsoft Excel Worksheet
» Understand the basic of Microsoft Excel Row
>

Understand the basic of Microsoft Excel Column

12



2.1 Introduction of Microsof t Excel W orkbook

A set of worksheets called an Excel workbook has rows and columns of data storage.
By default, a new Excel workbook is titled Book1 (see at the top of the Excel). Depending
on the data included inside, you can give and save the workbook. A single Excel worksheet
typically has 16,384 columns and 1,048,576 rows.

The worksheets in a workbook are numbered Sheetl, Sheet2, Sheet3,....SheetN.
By selecting the + sign next to the worksheets, you can add these worksheets to your
workbook. A single worksheet may be in use at once. It indicates that only one worksheet
may be active at a time in an Excel spreadsheet. However, a workbook can contain multiple
worksheets.

2.1.1 How to create a new workbook?

The procedures listed below should help you to create a new workbook on your computer:
» Open Excel.
» Press Ctrl+N or choose Blank workbook.
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» Start typing
2.1.2 How to create a workbook froma T emplate?

The procedures listed below should help you to create a new workbookfrom a template
on your computer:

» Choosing File > New.
13



» Double-click a template.
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2.1.3 How to rename a workbook?

» Torename a workbook, locate it in Windows Explore, then you can press F2, or right-
click and select Rename, then type the new name.

» If your workbook is currently open, you can save it with an alternative name by
selecting File > Save As. This will make a duplicate of the current worksheet.

2.2 Introduction of Microsof t Excel W orksheet

Aworksheet is a single page with a number of cells where the user can input, modify,
and store data. Spreadsheets are also referred to as worksheets. The worksheet has rows,
columns, and cells init.

Worksheet

[ T
Y 1

Each individual data cell in an Excel worksheet is defined and arranged with the aid
of the vertical column and horizontal row that are combined to produce a cell reference,
unlike B1 or A25.

The current versions of Excel Worksheet include the following specifications:
» Each worksheet has 1,048,576 rows.
» There are 16,384 rows per worksheet.
» There are 17,179,869,184 total cells on each worksheet.

2.2.1 How to select a worksheet?

By default, Excel opens the Sheet 1 worksheet whenever you start an Excel workbook.
The worksheet’'s name, “Sheetl,” is shown on its sheet tab at the bottom of the windowpane,
as seen in the image below.

15
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2.2.2 How to insert a worksheet?

Excel gives the user the option to insert as many spreadsheets as they need. Click
on the addition (+) sign at the bottom of the window to add a new worksheet to Excel. The

default name of the new worksheet is “SheetN,” where N is one of the integers 1, 2, 3, 4, 5,
6, 7,..., Nn.

In the example below, Sheet? is the name of a new worksheet that has been added.

Click On This
Option
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2.2.3 How to rename a worksheet?

Sheel?

The steps listed below should be followed in order to rename your worksheet with a
unigue and relevant name.

» Click with your right mouse button on the sheet tab whose name you want to modify.
> You'll see the toolbar window.
» Select Rename from the menu.

Click On This
Option

» Type the name you like. For instance, we have changed the name of “Sheetl” to
“FirstTest” in the screenshot below.

17
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2.2.4 How to move a worksheet?

Excel gives the user complete control over where and how to move their worksheets.
Drag the worksheet sheet tab to the desired spot by clicking on it.

2.2.5 How to delete a worksheet?

The procedures listed below should help you to delete a worksheet:
> Right-click on a sheet tab at the bottom of the page.
» There will be a dialogue box. Select “Delete”

Sulvct Thelwte Chplion

/

» The sheet will be removed right away as shown below.
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2.2.6 How to copy a worksheet?
The procedures listed below should help you to copy a worksheet:
» To copy a sheet tab, use the right-click menu.
> You'll see the toolbar window. Select “Move or Copy” from the menu.

= k-,/'i lick vl Mwve or Cops Opun

> It will show the “Move or Copy” dialogue box. Make sure to check the “create a copy”
box when choosing the “move to end” option in the Before Sheet section.

» Select OK. Your information will be transferred to the new worksheet.

19



2.3 Introduction to Row

The worksheet has horizontal rows that go from 1 to 1048576. The number on the left
side of the row, which indicates where the row came from, is used to identify a row.
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2.3.1 How to insert a row in Excel?

The procedures listed below should help you to insert a row in Excel:

» Choose the cell within the row where you want to introduce a new row by right-

clicking it.
» The dialogue box will appear. Pick Insert.
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> You'll see the insert dialogue box. Select “Entire row.”
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> At the top of the cell you've chosen, it will insert a new row.
2.3.2 How to delete a row in Excel?
The procedures listed below should help you to delete a row in Excel:

» The cell you want to delete must be chosen from the row. Right-click the cell.

> It will show the dialogue box. Select Delete.
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> You'll see the Delete dialogue box. Select “entire row” from the menu.

> It will immediately erase the entire row.
2.4 Introduction to Column

The worksheet is divided vertically into columns from Ato XFD (in total 16384 columns).

A column’s header, which shows where the column comes from, at the top of the column
serves as its identifier.
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2.4.1 How to insert column in Excel?
The procedures listed below should help you to insert column in Excel:

» Choose the cell within the column you wish to insert a new column in by performing
a right-click.

» It will show the dialogue box. Select Insert.
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> You'll see the insert dialogue box. Select “Entire column.”
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> It will add a new column to the left of the cell you’'ve chosen.
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2.4.1 How to delete column in Excel?

The procedures listed below should help you to delete a column in Excel:
» The cell you want to delete must be chosen from the column. Right-click the cell.
> It will show the dialogue box. Select Delete.
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> You'll see the delete dialogue box. Select “Entire column.”
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> It will immediately erase the entire column.
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2.5 Summary

In this chapter, we have studied:

> A set of worksheets called an Excel workbook has rows and columns of data

storage.

» A worksheet is a single page with a number of cells where the user can input,

modify, and store data.

» The worksheet has horizontal rows that go from 1 to 1048576.

» The worksheet is divided vertically into columns from A to XFD (in total 16384

columns).

2.6 Answers to self-check exercises

Q.1 What is the difference between row and column?

Q.2 How workbook is different from worksheet?

Q.3 What are the various ways to create a new workbook?

Q.4 How we can rename a workbook?

Q.5 How we can move a worksheet?

Q.6 Mention various steps to insert a row and a column in Excel?
Q.7 How we can copy a worksheet?

2.7 Suggested Reading
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Ron Mansfield, The Compact Guide to Microsoft office; BPB Publication.
Dienes, Sheila s., Microsoft office, Professional for windows 95.

Joan Lambert, Curtis Frye, Microsoft Office Step by Step (Office 2021 and Microsoft
365), Microsoft Press Publication.

Kenneth N. Berk, Data Analysis with Microsoft Excel.
Wayne L. Winston, Microsoft Excel 2013: Data Analysis and Business Modeling.

Danielle Stein, Using Excel for business analysis: a guide to financial modelling
fundamentals.

Olafusi M., Microsoft Excel and Business Data Analysis for The Busy Professional.
Rajiv Mattus: Learning Excel 97 for windows step by step BPB publication.
Lonnie. E. Moseley & David M. Boodey: Mastering office 97.

Micro Soft Office 97: Unleashed: Techmedia.

John Walken Bach: Excel 97.
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Chapter-3
MICROSOFT EXCEL WORKSHEETCELL

STRUCTURE
3.0 Learning Objectives
3.1 Introductionof Microsoft Excel Worksheet Cell
3.1.1 How to select a Cell?
3.1.2 How to select Cell Range?
3.1.3 How to insert content to a cell?
3.1.4 How to delete cell content?
3.1.5 How to delete Cell?
3.1.6 How to drag and drop Cell?
3.2 History of Microsoft Excel
3.3 Advantages of Microsoft Excel for Statistical Analysis
3.4 Disadvantages of Microsoft Excel for Statistical Analysis
3.5 Summary
3.6 Answer to Self-Check exercises
3.7 Suggested Readings
3.0 LEARNING OBJECTIVES
After going through this lesson, you will be able to:
» Understand the basic of Microsoft Excel Worksheet Cell
» Understand the advantages of Microsoft Excel for Statistical Analysis
» Understand the disadvantage of Microsoft Excel for Statistical Analysis
3.1 Introduction of Microsof t Excel W orksheet Cell

The worksheet'’s cells are the little, rectangular boxes where we enter data. Row and
column intersections form cells. The column header and row number serve as identifiers.
Using a set of coordinates or positions, such as Al (where A stands for a column and 1 for
arow), C2, or H15, each cell in Excel is uniquely recognized.

Unlike changing the font style, font size, background colour, text alignment, format painter,
wrap text, and conditional formatting, Excel cells can be used for a variety of activities.

Multiple cells can be selected simultaneously in Excel. Cell range refers to a collection of
chosen cells. The user refers to a cell range rather than a single cell address by using the
colon-separated cell addresses of the first and final cells they have chosen. As anillustration,
C1:C10 would be used to refer to a cell range that includes C2, C3, C4, C5, C6, C7, C8, C9,
and C10.
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3.1.1 How to select a Cell?
The steps to pick a cell in Excel are listed below:
» Select any cell by clicking it with your pointer.

> Your cell is now highlighted, has a rectangular border around it, and the column
and row headings are now highlighted.

Sebietion el Uil

> Until the user moves the cursor to another cell, the selected cell will remain
such.
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3.1.2 How to select Cell Range?
The steps to select a cell range in Excel are listed below:

» Selecting a cell begins with clicking on the first cell. When you wish to finish the cell
range, hold your cursor down and drag it to the final adjacent cells.
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» When you're finished, click and drag the cursor to pick the desired cell range.
> Until the user moves the cursor to another cell, the selected cell will stay selected.
3.1.3 How to insert content to a cell?

The steps to insert content to a cell in Excel are listed below:
» The cell where you want to insert the content should be clicked and selected.

> Enter the required information into the highlighted cell, then press Enter or shift your

pointer to a different cell. Both the formula bar and the cell’s content will display the
content.
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3.1.4 How to delete cell content?
The steps to delete cell content in Excel are listed below:
» Select the cell by clicking.
> Press the Delete or Backspace key on your keyboard to remove the cell’s content.
> Select the cell range, then press the Erase key to delete several cells.
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3.1.5 How to delete cell?
The steps to delete cell in Excel are listed below:
» Select the cell by clicking it (s).
> Simply right-click the cell. It will show the dialogue box. Select Delete.

€ Mok ey i deleie selediod ewll
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» The Delete dialogue box shown below will appear. Select “entire row” from the menu.
» The cells underneath the deleted cell will immediately move upward.

3.1.6 How to drag and drop cell?

The steps to drag and drop cell in Excel are listed below:
> Select the cell by clicking it (s).

» When your cursor turns into a black cross with four arrows, move it over the border
of the selected cell or cells. Excel Worksheet, Rows, Columns, and Cells

» To paste the content, move the mouse cursor to the desired cell. The mouse pointer
will now appear as a dot-filled rectangle.
» The content will be copied from the source cell and pasted in the chosen location
once the cursor is released.
3.2 History of Microsof t Excel

Excel has seen numerous changes in terms of function diversity, functionality, and
capacity since its creation. In 1985, Microsoft released the initial version of Excel, which
was exclusively compatible with Apple Macintosh computers. The description of Microsoft
Excel in all versions is provided below:

Sr. No. Name Released Description

1 Version 1 1985 Excel's initial release was limited to
Macs only. Many Excel lovers are still
unaware of this, which may sound
unusual. In 1982, Microsoft actually
created a spreadsheet tool called
Multiplan, but it was a failure. Up to
2016, Excel versions for various
operating systems had several
names.

2 Excel 2 1987 To match the Mac version, the first
Microsoft Excel release for Windows
was labeled “2”. It was essentially a
port of the Mac “Excel 2,” and it
incorporated a run-time version of
Windows.

3 Excel 3 1990 Toolbars, drawing capabilities,
outlining, support for add-ins, 3D
charts, and numerous other additional
features were included in the
subsequent edition.
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Excel 4

1992

The first “popular” version of Excel
was version 4. Numerous usability
features were implemented, such as
AutoFill, which was initially made
available in this edition.

Excel 5

1993

A significant improvement came with
Excel version 5. Workbooks with
multiple worksheets, support for VBA,
and macros were all included. Excel's
vulnerability to macro virus attacks
increased as a result of these
additional features, and this problem
persisted all the way up to the 2007
update.

Excel 95

1995

It was the first significant 32-bit version
of Excel and was referred to as Excel
95. A 32-bit version of Excel 5 was
also available, but due to distribution
issues, it was not extensively used.
Excel 95 and Excel 5 are quite
comparable in terms of features. You
might also be perplexed as to why
Excel 6 doesn’t exist. Version
numbering was altered, and starting
with Excel 7, the same version number
was implemented throughout all
Microsoft Office programmes.

Excel 97

1997

This version included many new
features, including UserForms, data
validation, and a new interface for
VBA developers. Do you recall the
annoying Office Assistant Clippy? He
was part of this version.

Excel 2000

1999

The usage of HTML as a native file
format, a “self-repair” function, an
improved clipboard, pivot charts, and
modeless user forms are some of the
new features.
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Excel 2002

2001

This is the first version of Excel
included with Office XP. The extensive
list of new features wasn’t really
useful to the typical user. The new
option that enables you to recover
your work should Excel crash was one
of the most important innovations.
Additionally, this edition includes a
useful feature called product
activation technology, sometimes
referred to as copy protection, which
restricts the use of the software to a
single machine. The implications of this
should be taken into account before
determining whether to update.

10

Microsoft
Office Excel
2003

2003

This version added enhanced XML
compatibility, a new “list range”
feature, improvements to Smart Tags,
and rectified statistical functions. The
majority of people won't think the
upgrade connected to data is
desirable.

11

Microsoft
Office Excel
2007

2007

Excel had some significant changes
with this Windows release. These
included the introduction of the Ribbon
interface and the switch from the
original .xIs file format to the more
widely used .xIsx and.xlsm. This
maodification improved Excel's security
(remember the issues with macro
viruses in earlier versions?) and made
greater row data storage possible
(over 1 million). Also substantially
enhanced were the charting features.
The loss of Clippy from Microsoft
Excel was a tragic aspect of the
upgrade, which caused some people
joy and others pain.

32




12

Microsoft Offi

ce Excel 2010

2010 Sparkline graphics, pivot
table slicers, an updated Solver, and
a 64-bit version were among the new
features in this Excel edition. If you're
wondering why Microsoft chose
version 14 over 13 instead, it’s
because 13isregarded as a bad luck
number.

13

Microsoft
Excel 2013

2013

This version featured the single-
document interface, suggested charts
and pivot tables, new charting
upgrades, and more than 50 new
functions.

14

Microsoft
Excel 2016

2016

Despite having separate software

versions, Excel for Mac and Windows
are now referred to by the same
name. If you also subscribe to Office
365, certain Internet upgrades for
Excel are available that can greatly
alter your user experience. Thus, older
versions including ones purchased at
retail are at a disadvantage.
Histograms, Pareto charts, and
PowerPivot, which allows for the
import of higher levels of data and has
its own language, are some of the
newly added features in this version.
Histograms are used to depict
frequency in data.

15

Microsoft
Excel 2019

2019

The new charts, which change how

data is presented, are one of the more
noticeable new additions of this
version. Some of the new data
presentation charts that help your data
look tidy and organised include map
charts and funnel diagrams.
Additionally, you have the option to
add 3D images to your workbooks.
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Microsoft 2021 As of right now, this is Microsoft
Excel 2021 Excel's most recent version. Naturally,
it has all the functionality of older Excel
versions and even more. This version
adds numerous features to earlier
versions, including Unhide Multiple
Sheets, Navigation Pane, Resize
Conditional Formatting Box, and
LAMBDA Helper Functions.

3.3 Advant ages of Microsof t Excel for S tatistical Analysis

>

Easy Data Storage: MS Excel is frequently used to save or analyse data because
there is no limit to the amount of information that can be recorded in a spreadsheet.
In Excel, information filtering is simple and practical.

Simple Dat a Recovery: Finding the information might take longer if it were written
on paper, but this is not the case with excel spreadsheets. It is simple to locate and
retrieve data.

Use of Mathematical Formulas: The MS Excel formulae function has made performing
calculations simpler and quicker.

Extra Secure: When compared to data stored on registers or paper, these
spreadsheets have a much lower chance of being lost and can be password-secured
on a laptop or desktop computer.

Data in one location: When the paperwork was completed, data had to be preserved
in various files and registers. Now that multiple worksheets may be added to a single
MS Excel file, this has become convenient.

Information V isibility Is Sharper and Clearer.  Analysing the data is much simpler
when itis recorded as a table. Information is therefore a more readable and intelligible
spreadsheet.

3.4 Disadvant ages of Microsof t Excel for S tatistical Analysis

>

The data source is challenging with Excel:  Excel’s difficulty in evaluating real-time
unstructured and semi-structured data is one of its biggest drawbacks. On the other
hand, a lot of recent and upcoming data analytics technologies are capable of swiftly
identifying this kind of data and producing representations. When it comes to data
formats like JSON, Excel likewise struggles. JSON is the fastest-growing data type
due to the rise of mobile data, apps, and loT devices. Even the most seasoned Excel
users face a hurdle with its intricate structure. However, individuals employing
contemporary analytics tools may quickly decode and examine this kind of data in an
Excel-like setting.
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» Excel cannot create interactive dashboards: Utilizing a data visualization tool, you
can mix various chart types to produce dynamic dashboards that list all of your KPIs
in one location. After that, you can delve more deeply into each chart, examining its
level of detail and looking for trends. Excel allows you to create dashboards, but they
are static, only display high-level trends, and act as an endpoint rather than the
beginning of the additional investigation. When compared to dynamic dashboards,
which have the capability of automatic updates, this is a drawback.

> Exceldoesn’t provide real-time up dates: Spreadsheets in Excel are used to store
stale data. Data gets outdated the instant you import a CSV file and build out a
worksheet because itisn’t connected to a live data warehouse. Users are compelled
by this to endure tedious manual procedures in order to repeatedly submit the same
information. A cloud-based data visualization tool may easily connect to dozens of
data sources using a cloud data warehouse like Snowflake, whereas Excel can
connect to external data sources via plugins. In this way, you can rapidly get the most
recent data, display it quickly, distribute it around your organisation, and use it to
instantly make smarter business decisions.

> Excells Nota Collaboration T ool: Most Excel files live locally. While they do have
connectivity to the cloud, the worksheets are primarily intended for solitary usage
and lack sophisticated collaboration features. Every time someone wants to build on
the work of another person, this leads to infinite duplication of effort and chaos from
an organisational standpoint. Analyses carried out in a vacuum are a waste of time.
Excel can eventually put businesses at a disadvantage since it makes it difficult for
teams to properly communicate information, collaborate, and find solutions. Teams
may eliminate data silos, work more effectively together, and elevate each other’s
work by using a data visualisation tool. By first deriving insights from the primary and
then deriving insights from those insights, this is how you construct compound interest
with data.

» Sprawling S preadsheet s Poses a Security Risk: Itis risky to download data to a
spreadsheet and store it locally. Excel spreadsheets don’t require professional SQL
coding knowledge, unlike BI tools, which is why so many corporate customers still
use them in spite of the dangers. Unfortunately, the risks are numerous, and it also
has many drawbacks. There is a lack of security and compliance monitoring when
data is downloaded to Excel since the data team is unable to monitor how employees
utilise or distribute the data. Vulnerabilities, lost data, and misuse result from this.

3.5 Summary
In this chapter, we have studied:
» The worksheet'’s cells are the little, rectangular boxes where we enter data.

» Excel has seen numerous changes in terms of function diversity, functionality, and
capacity since its creation.
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>

The MS Excel formulae function has made performing calculations simpler and quicker.

MS Excel is frequently used to save or analyse data because there is no limit to the
amount of information that can be recorded in a spreadsheet.

3.6 Answers to self-check exercises
Q.1 What do you mean by Cell?
Q.2 How to select a Cell?

Q.3 How to drag and drop cell?

Q.4 How to delete cell content?

Q.5 How to insert content to a cell?

Q.6 How to select Cell Range?

Q.7 Explain history of Microsoft Excel.

Q.8 What are various advantages of Microsoft Excel for Statistical Analysis?

Q.9 Explain various disadvantages of Microsoft Excel for Statistical Analysis?

3.7 Suggested Reading

>
>
>
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Ron Mansfield, The Compact Guide to Microsoft office; BPB Publication.
Dienes, Sheila s., Microsoft office, Professional for windows 95.

Joan Lambert, Curtis Frye, Microsoft Office Step by Step (Office 2021 and Microsoft
365), Microsoft Press Publication.

Kenneth N. Berk, Data Analysis with Microsoft Excel.
Wayne L. Winston, Microsoft Excel 2013: Data Analysis and Business Modeling.

Danielle Stein, Using Excel for business analysis: a guide to financial modelling
fundamentals.

Olafusi M., Microsoft Excel and Business Data Analysis for The Busy Professional.
Rajiv Mattus: Learning Excel 97 for windows step by step BPB publication.
Lonnie. E. Moseley & David M. Boodey: Mastering office 97.

Micro Soft Office 97: Unleashed: Techmedia.

John Walken Bach: Excel 97.
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Chapter-4
MICROSOFT EXCEL TITLE BAR,
MENU BAR AND TOOLBAR

STRUCTURE
4.0 Learning Objectives
4.1  Introduction of Microsoft Excel Worksheet Title Bar
4.2  Introduction of Microsoft Excel Worksheet Menu Bar
4.3  Introduction of Microsoft Excel Worksheet Toolbar
4.4  Introduction of Formula and Function
4.4.1 How to enter formula in Excel?
4.5 Summary
4.6  Answer to Self-Check exercises
4.7  Suggested Readings
4.0 LEARNING OBJECTIVES
After going through this lesson, you will be able to:
» Understand the basic of Microsoft Excel Worksheet Title Bar
» Understand the basic of Microsoft Excel Worksheet Menu Bar
» Understand the basic of Microsoft Excel Worksheet Toolbar
» Understand the basic of Formula and Function
4.1 Introduction of Microsof t Excel W orksheet T itle Bar

The excel file’s title is held by the bar known as the Title Bar. But it also has a lot of
other crucial features in addition to presenting the title.

The title bar has three sections:

» Quick Access Toolbar

> File Name

» The Minimize, Maximize/Restore, and Close buttons
Quick Access T oolbar

We can add commands to the Quick Access Toolbar that we commonly use. You can add
the desired commands here by following these procedures.
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» Right-click the command you want to use. (In the example below, we have “Format
Painter” chosen as a desired command.)

» Choose “Add to Quick Access Toolbar” from the menu.
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» The “Format Painter” command has now been added to the Quick Access Toolbar,
as you can see.
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» Simply right-click on the relevant command and choose “Remove from Quick Access
Toolbar” from the menu that appears.
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> You will now see that the “Format Painter” command has been deleted from the
Quick Access Toolbar.
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File Name

It displays the file name we gave to our excel file. The excel file name is “Book 1” in
the screenshot below, and “- Excel” signifies that this is an excel file.
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Minimize, Maximize/Restore, Close Buttons
On the right side of the Title Bar are these buttons:

» Minimize: This button has a minus-like appearance. This button will relocate the Excel
window to the Taskbar (Taskbar is located at the bottom of the screen).

» Maximize/Restore: When we click on this, the Excel window will fill the entire screen.
The Excel window will appear in a lesser size if we click this button after it has already
been stretched to fill the entire screen, allowing us to resize the window.

» Close: Select this button to shut off the Excel document.

Slinkmiss
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4.2 Introduction of Microsof t Excel W orksheet Menu Bar

You may access several commands required for tasks like opening and closing files,
printing documents, formatting data, and other actions using the Menu Bar at the top of the
screen. The options in the Menu Bar and how they work are captured on screen in the
images below.
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Nowadays, the name of Excel's primary menu bar is “Ribbon.” The ribbon’s items
come with collections of icons that serve the same purposes.

ittt lm= mosmeremoialomess o=en aaede oo S o P

These consist of:
File, Home, Insert, Formulas, Page Layout, View, Data
File

The item on the Excel ribbon farthest to the left is the File menu. You may manage
your files by using the open, save, close, and print options available on the File ribbon items.
Along with tools that let you modify Excel itself; you may import data into Excel from outside
sources using the File menu.
Home

The second option in the Excel menu bar is the home menu. Formatting options for
font, colour, conditional formatting, filter, number type, and more are available in the home
ribbon items. Each of these functions’ aids in the execution of several efficient calculations.

Insert

The Insert menu, as its name implies, enables you to add a variety of choices and
objects to an Excel spreadsheet. A pivot table, a photo, clip art, shapes, screen captures,
charts and graphs, text boxes, header and footers, symbols, equations, and more can all be
inserted.

Page Layout

Once more, the name alludes to the group of options available on the Page Layout
menu. You'll find a variety of options for setting up pages for reading and printing, including
options for page size, margins, colours, and fonts. On the Page Layout menu, you may also
change the width and height of individual cells.
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Formulas

You can find all the options for number-crunching in the Formulas menu. There are
several formulae in Excel, including ones for algebra and trigonometry as well as for financial,
logical, text, date and time, lookup and reference.
Data

Numerous crucial Excel features, such as imports and links to databases, are now
available under the Data menu. On the Data menu, you can also access the sort, filter,
duplicate-removal, data validation, consolidation, group, ungroup, and subtotal options.
Review

The majority of the tasks can be found in the Review menu. Using features from the
Review menu, you may track changes, check spelling, add comments in cells for your
colleagues, and even restrict authorization.
View

You can alter how spreadsheets display on your screen by using the View menu. Grid
lines between cells can be displayed, the formula bar and headings can be switched, and
more options are available. You have the ability to see and record macros from this menu as
well, which saves you from having to repeat actions you already know how to accomplish
over and over again.
4.3 Introduction of Microsof t Excel W orksheet T oolbar
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\ Standard Toolbar

Active Sheet Formatting Toolbar

The Excel toolbar is a place where you can put various commands or tools. It can be
seen by default in the Excel window’s upper right corner, above the ribbon with various tools.
Toolbars can now be customized based on how frequently users use particular tools, which
improves customer friendliness.

There are two toolbars that offer easy access to many of the Excel features that are
utilized the most. The Standard Toolbar is the first bar, followed by the Formatting Toolbar.
A yellow box will display next to a toolbar icon when the mouse pointer is placed over it

without clicking.
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Using the Tools menu, you may modify how the Standard and Formatting toolbars are
displayed as seen below:

» Click Tools on the Menu Bar.

» Customize can be selected (clicked) from the drop-down menu.

» To move it to the front, click the Options tab.

» The box nextto “Standard and Formatting Toolbar share one row” can be checked or

unchecked.
> If the checkbox is unchecked, just one row will be shared by the toolbars.
» The toolbars will be displayed in separate rows if the checkbox is left empty.

» To get back to your workbook window, select Close.

From left to right in the standard toolbar, the buttons are: New Worksheet, Open
Worksheet, Save, Print, Print Preview, Spell Check, Cut, Copy, Paste, Format Paint, Undo,
Redo, Insert Hyperlink, Web Toolbar, AutoSum, Function Wizard, Sort Ascending, Sort
Descending, Chart Wizard, Mapping, Drawing, Zoom, and Help. Additionally, each of these
options can be selected from a pull-down menu.
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standard Toolbar

The buttons in the formatting toolbar are, in order, Bold, Italics, Underline, Margins,
Font Type, Font Size, and (left, center, right, merge &center,) Borders, fill colour, font
colour, increase decimal, decrease decimal, decrease indent, increase indent, currency
style, percent style, comma style, and all of the above. Additionally, each of these options
can be selected from a pull-down menu.
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Formatting
Toolbar
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Toolbars are really helpful. They provide quick access to commands without requiring
users to navigate through menu options. Excel comes with a lot of toolbars. Click “Get” on
the Menu Bar and choose “Toolbars” to view a list of all the toolbars that are currently
accessible. The toolbars are visible in a submenu that emerges. Simply click on a toolbar in
the submenu to choose it. Your choice will now be seen from your worksheet due to the
check mark that will now appear in front of it.

Function or Formula Bar: The active cell's or block’s contents are shown in the
formula bar. Text, numbers, formulas, and functions are all included.

Active Cell

The chosen cell at the moment is the active cell. The active cell is surrounded by a
large border block known as the Cell Pointer. The active cell is filled with data.

Active Sheet

A file frequently contains multiple worksheets. To switch between sheets, click the
tab located on each sheet. To make it simpler to recall what each sheet includes, you can
rename them. To accomplish this, double-click Sheetl, for example, type a new name, and
then press the ENTER key.

Worksheet Window

The Excel worksheet is visible in the worksheet window. There are rows and columns
in it. The alphabetic letters, such as A, B, C, etc., are used to identify the columns. On the
left side, the rows are numbered. Cells are formed when rows and columns cross. The
column name and row number can be used to refer to any cell.

4.4 Introduction of Formula and Function
Formula

Calculating values in a cell or a group of cells is done by a formula, which is an
expression.

For instance, the values in cells A2 through A4 can be added up using the formula
=A2+A2+A3+A4.

Function

Function is a built-in, predefined formula in Excel. Based on the supplied values,
referred to as arguments or parameters, functions carry out specific calculations in a precise
order.

To sum a range of cells, for instance, use the SUM function rather than specifying each value
to be added as in the formula above: =SUM(A2:A4)
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All of the Excel functions are listed in the Function Library under the Formulas tab:

“ Home Insert Page Layout Data Review View Farmiulas
2 : =
A2 EHERIODER B &

[rsert AutoSum Recently Financial Logical Text Date & Lookup & Math & More
Function v Used = - - =  Time~ Reference~ Tng= Functions -

Fundion Library

4.4.1 How to enter formula in Excel?

» Click the cell in a spreadsheet with numerical columns where you wish the formula
results to show.

» Add the equal sign =.

» To include the first cell in your computation, click it
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> Type an operator. An operator is a specific type of calculation that the formula carries
out. For instance, the * operator multiplies numbers. To subtract in this instance, use
the - operator. Your formula should now resemble the following:
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» To add the following cell to your computation, click it. Your formula should now seem

as follows:
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» Press RETURN.
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4.5 Summary

In this chapter, we have studied:

>
>

>

The Excel toolbar is a place where you can put various commands or tools.

The Insert menu enables you to add a variety of choices and objects to an Excel
spreadsheet.

Calculating values in a cell or a group of cells is done by a formula, which is an
expression.

4.6 Answers to self-check exercises

Q.1 What do you mean by Function?

Q.2 Explain Title bar briefly?

Q.3 What are various options available under Menu bar?
Q.4 How to enter formula in Excel?

Q.5 Explain Toolbar briefly?

4.7 Suggested Reading

>
>
>
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Ron Mansfield, The Compact Guide to Microsoft office; BPB Publication
Dienes, Sheila s., Microsoft office, Professional for windows 95

Joan Lambert, Curtis Frye, Microsoft Office Step by Step (Office 2021 and Microsoft
365), Microsoft Press Publication

Kenneth N. Berk, Data Analysis with Microsoft Excel
Wayne L. Winston, Microsoft Excel 2013: Data Analysis and Business Modeling

Danielle Stein, Using Excel for business analysis: a guide to financial modelling
fundamentals

Olafusi M., Microsoft Excel and Business Data Analysis for The Busy Professional
Rajiv Mattus: Learning Excel 97 for windows step by step BPB publication.
Lonnie. E. Moseley & David M. Boodey: Mastering office 97.

Micro Soft Office 97: Unleashed: Techmedia.

John Walken Bach: Excel 97.
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Chapter-5
CELL FORMATTING, CUT, COPY AND PASTE OPERATION

STRUCTURE
5.0 Learning Objectives
5.1 Introduction of Microsoft Excel Worksheet Cell
5.1.1 How to change format of Cell?
5.1.2 How to enter data into a Cell?
5.1.3 How to clear data from a Cell?
5.2 Introduction ofVarious types of Operation
5.2.1 Cut
5.2.2 Copy
5.2.3 Paste
5.2.4 Paste Special
5.2.5 Paste Value
5.2.6 Paste Formula
5.2.7 Paste Transpose of Data Set
5.3 Summary
5.4 Answer to Self-Check exercises
5.5 Suggested Readings
5.0 LEARNING OBJECTIVES
After going through this lesson, you will be able to:
» Understand the basic of Cell Formatting
» Understand the basic of Cut, Copy, Paste Operation
» Understand the basic of Paste Special, Paste Transpose
5.1 Introduction of Microsof t Excel W orksheet Cell

The worksheet’s cells are the little, rectangular boxes where we enter data. Row and
column intersections form cells. The column header and row number serve as identifiers.
Using a set of coordinates or positions, such as Al (where A stands for a column and 1 for
arow), C2, or H15, each cell in Excel is uniquely recognized.

5.1.1 How to change format of a Cell?

A cell's contents, including its data, and a set of related cells can all be formatted.
One way to conceptualise this is as if the data were the picture inside the frame and the cells
were the picture’s frame.
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Format Cells

The steps to format cells in Excel are listed below:

> Select the cells.
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» To make adjustments such as Bold, Font Color, or Font Size, use the ribbon.
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How to apply style to a Cell in Excel?

The steps to apply style to a cell in Excel are listed below:

» Choose the cells.
> Pick a style by selecting Home > Cell Style.
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How to modify style of a Cell in Excel?

» Choose the cells with the Excel Style.
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» Right-click the style that was just applied under Home > Cell Styles.
» To make the changes you wish, choose Modify > Format.
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5.1.2 How to enter dat a into a Cell?
The steps to enter data into a cell in Excel are listed below:
» The cell where you want to enter the data should be clicked and selected.

> Enter the required information into the highlighted cell, then press Enter or shift your
pointer to a different cell. Both the formula bar and the cell’s content will display the
content.
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5.1.3 How to clear dat a from a Cell?

The steps to clear Cell data in Excel are listed below:
> Select the cell by clicking.
» Press the Delete or Backspace key on your keyboard to remove the cell’s content.
> Select the cell range, then press the Erase key to delete several cells.
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5.2 Introduction of V arious types of Operation
5.2.1 CUT Operation

Transferring data from one place to another is known as cutting data in Excel. This can be
done by moving the data to a new position in the same worksheet, another worksheet in the
same workbook, a different Excel workbook, or even a different application.

Move cells by using Cut and Paste
» Choose a cell or a range of cells.
» Press Ctrl + X, choose Home > Cut, or both.
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» The cell you want to move the data to is selected.
» Ctrl + V or Home >Paste are two options.
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5.2.2 COPY Operation

The steps to copy Cell datafrom one location to another location in Excel are listed below:
» Choose a cell or a range of cells.
» Press Ctrl + C or choose Copy.
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» Choose Paste or click Ctrl + V.

C I R S —-u_n-u‘ - - L] =
Pl (R Peplamal femals Dl R e il [ m
E S . B i - E Fy =sR £

o [E #- 3 Eewhiew ¢ - W1 amar g v T e b e firly Fem X -
i 5

__Uoniend pastrd after copy eprrabion

|Data Entaring into a Cell | =

Data Entering imaa Cell |

E__zi I ¥

54



5.2.3Paste Operation

The Paste option pastes everything.

» Select cell E6, right click, and then click Copy (or press CTRL + c).

> Next, select cell E13, right click, and then click Paste under ‘Paste Options:’ (or press

CTRL +v).
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5.2.4 Paste Special

=5 [hata afler paste operddinon

In Excel, we use the Paste Special option when we wish to paste only specific portions of

the data rather than the entire set of data.

» Select cell E6, right click, and then click Copy (or press CTRL + c).
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> Next, select cell E13, right click, and then click Paste Special.
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» The Paste Special dialog box appears.
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» The above-described pasting choices are also available here. Additionally, you can
paste everything except borders, column widths, formulas and number formats, values

and number formats, validation criteria only, and comments.
56



5.2.5 Paste Value
The Values option pastes the result of the formula.
» Select cell E6, right click, and then click Copy (or press CTRL + c).
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> Next, select cell E12, right click, and then click Values under ‘Paste Options:’
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5.2.6 Paste Formula

The Formulas option only pastes the formula.
» Select cell E12, right click, and then click Copy (or press CTRL + c).
> Next, select cell F5, right click, and then click Formulas under ‘Paste Options:’
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5.2.7 Paste Transpose of Dat a Set
The steps to paste transpose of data setin Excel are listed below:

> Select the data we have to transpose. Here I've selected range B4:C9.

» Then goto Home.

» Now, select Copy from the Clipboard group of commands.
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> Now, go to Cell I5 to Paste and Transpose.

» Go to the main Home tab.

» Then select Paste from the commands.

» From the drop-down of Paste option, select Transpose(T).
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> After selecting Transpose(T), we will get our transposed data.
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5.3 Summary
In this chapter, we have studied:
» The Excel toolbar is a place where you can put various commands or tools.

» The Insert menu enables you to add a variety of choices and objects to an Excel
spreadsheet.
» Calculating values in a cell or a group of cells is done by a formula, which is an

expression.
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5.4 Answer to Self-Check exercises

Q.1 What do you mean by Cell Formatting?

Q.2 Explain CUT, COPY, Paste Operation briefly?
Q.3 Explain Paste Value, Paste Function briefly?
Q.4 How to Paste Special Operation in Excel?
Q.5 How to enter data into a Cell?

Q.6 How to clear data from a Cell?

5.5 Suggested Readings
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Ron Mansfield, The Compact Guide to Microsoft office; BPB Publication
Dienes, Sheila s., Microsoft office, Professional for windows 95

Joan Lambert, Curtis Frye, Microsoft Office Step by Step (Office 2021 and Microsoft
365), Microsoft Press Publication

Kenneth N. Berk, Data Analysis with Microsoft Excel
Wayne L. Winston, Microsoft Excel 2013: Data Analysis and Business Modeling

Danielle Stein, Using Excel for business analysis: a guide to financial modelling
fundamentals

Olafusi M., Microsoft Excel and Business Data Analysis for The Busy Professional
Rajiv Mattus: Learning Excel 97 for windows step by step BPB publication.
Lonnie. E. Moseley & David M. Boodey: Mastering office 97.

Micro Soft Office 97: Unleashed: Techmedia.

John Walken Bach: Excel 97.
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Chapter-6
DATA MANAGEMENT

STRUCTURE
6.0 Learning Objectives
6.1 Introduction
6.1.1 Types of Data Management
6.1.2 Importance of Data Management
6.2 Data Transformation
6.3 Arithmetic Operation
6.3.1 Addition
6.3.2 Subtraction
6.3.3 Multiplication
6.3.4 Division
6.3.5 Log Transformation
6.3.6 Exponential Transformation
6.3.7 Square and Square Root
6.3.8 Index Function
6.4 Summary
6.5Answer to Self-Check exercises
6.6 Suggested Readings
6.0 Learning Objectives
After going through this lesson, you will be able to:

. Understand about the data management
. Understand the process of data transformation
. Understand the various functions and formulas for data transformation

6.1 Introduction

Data management is a systematic way of collecting, organizing, protecting, and
storing an Establishment’s data so it can be analyzed to make better business decisions. As
organizations create and consume data at an unprecedented rate, data management solutions
are becoming essential to making sense of the vast amounts of data. Today's leading data
management software ensures that reliable and up-to-date data is always used to make
decisions. The software helps with everything from data preparation to cataloging, searching,
and management, so people can quickly find the data they need for analysis.
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Becoming an Excel expert is more than learning functions and combining formulas. An
important part of using Excel to its full potential is knowing the art of data management. This
covers everything from setting up spreadsheets to data entry and good maintenance practices.
In today’s digital world, organizations have access to more data than ever before. This data
forms the foundation for making important business decisions. Data management methods
improve visibility, reliability, security, and scalability.

6.1.1 Types of Dat a Management

Data management plays a vital role in making essential functions easier and less

time-intensive. Some of the commonly used data management techniques are:

» Data preparation is used to clean and transform raw data into the right shape and
format for analysis, including making corrections and combining data sets.

» Data pipelines enable the automated transfer of data from one system to another.
» ETLsare three operations combined namely, Extract, Transform and Load. These

are made to take the data from one system, transform it, and load it into the system’s
data storage.

» Data catalogs help deal with the metadata to create a complete picture of the data,
providing brief informationabout its changes, locations, and quality while also making
the data easy to find.

» Datawarehouses are places to merge and unite various data sources. It provides
a clear route for data analysis.

» Datagovernance sets standards, processes, and policies to preserve data security
and integrity.

» Data architecture supplies a formal approach for creating and managing data flow.

» Data security defends data from unauthorized access and corruption.

» Datamodeling documents the direction of the transfer of data through an application
or organization.

6.1.2 Import ance of Dat a Management

Data management is an important first step to employing effective data analysis at
scale. Effective data management helps the person to find and access trusted data for their
gueries. A few benefits of effective data management include:

Visibility

Anincrease in the visibility of an organization’s data assets makes it easier for people
to easily and confidently find the right data for their analysis. Data visibility allows your
establishment to be more organized and productive, allowing employees to find the necessary
data they need to better do their jobs.

Reliability

Data management helps minimize potential errors by making data more reliable for
decision-making. With reliable, up-to-date data, the organization can answer more effectively
to market changes and customer needs.

62



Security

Data management protects the data of your organization and its employees from
losses, thefts, and breaches with various authentication and encryption tools. Strong data
security ensures that critical information is backed up and retrievable in case the primary
source becomes unavailable.

Scalability
Data management allows the effective scalability of data in organizations. When

actions are easy to repeat, your establishment can avoid the unnecessary costs of duplication,
such as employees conducting the same operation over and over again.

6.2 Data Transformation

Data transformation means changing the data in some way to meet your data analysis
needs. For example, you can filter rows, delete columns or change the data type. Each of
these actions transforms the data. Data shaping or data processing is a term used to
describetransformations (and aggregations) to a set or sets of data.

Transformation of data gives several benefits:

» Transformation of data to make it betterorganized. Transformed data is easier to
apply for both humans and computers.

» formatting and validation of data in a proper way improves the data quality and
protects applications from possible landmines such as NaN (Not-a-Number), null
values, unexpected duplicates, incorrect indexing, and incompatible formats.

» Datatransformation eases compatibility between various applications, systems, and
types of data. Data used for various purposes may need to be transformed in different
ways.

However, there are challenges to transforming data effectively:

» Data transformation can be expensive. Costs depend on the specific infrastructure,
software and tool used to process the data. Costs may include costs associated
with licensing, computing resources and hiring the necessary personnel.

» Data transformation processes can be resource intensive. Making changes to the
local data store after loading or converting data before it is injected into applications
can create a computational load that slows down other operations. If you use a
cloud-based data warehouse, you can perform transformations after uploading, as
the platform can scale to meet demand.

» Lack of expertise and carelessness can cause problems during the changeover.
Data analysts without proper knowledge are less likely to notice typos or incorrect
data because they do not know the exact and allowed values. For example, a person
working with medical information who is unfamiliar with the relevant terms may leave
unmarked disease names that should be associated with a single value, or notice
typographical errors.
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* Businesses can make transformations that do not meet their needs. Acompany can
convert data to a specific format for one application only, to return the data to the
previous format for another application.

6.3 Arithmetic Operation

An arithmetic operation is carried out by combining two operands with a single
arithmetic operator such as ‘+’, *-’, or *’ etc. An arithmetic operator accepts two operands
and performs computation on them. Most of the programming languages have a collection
of these operators that may be used inside expressions and equations to carry out various
kinds of sequential calculations. Everyone utilizesthem in day-to-day math.

6.3.1 Addition

Addition is a mathematical process of adding numbers or integers together. The
addition process is denoted by the ‘+’ sign. It combines two or more numbers into a single
term. In addition, the order does not matter. It means that the addition process is commutative.
It can involve any type of number whether it be a real or complex number, fraction, or
decimal.

Example: 5.12 + 3.88 =9

The process of adding more than two numbers, values, or terms is also known as a
summation of terms and can involve n number of values.

There are several ways to perform addition operations in Excel. Below is an explanation of
a few of these operations:

1. Sum acolumn in Excel with one click
» Select the column alphabet for which you wish to know the sum by clicking on it.
> You can see the total of the cells in the Excel Status bar (Fig. 6.1).

» To calculate the sum, you can choose a subset of the cells rather than the complete
column. The Excel status bar will directly show the sum of the selected cells. In
addition to the total Sum of the selected cells, it also shows the number of cells
selected with data (not empty cells) and the average of the data in the selected cells.
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2. Calculate the sum in Excel with AutoSum
» Select the blank cell below the column where you wish to add the numbers by clicking

on it (Fig. 6.2).
Mame Marks
A 10
B 20
C 30 Select the cell
D 40 where you want to
E 50 perform Sum
Sum

Fig. 6.2
» Select the AutoSum option in the Editing group under the Home menu.

» Excel will choose the range and insert it into the SUM function automatically. However,
you can also change the range if necessary (Fig. 6.3).
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Fig. 6.3

» The moment you press the Enter key on your keyboard, Excel will display the total
of the values in the range you have chosen (Fig. 6.3).

3. Addition using the SUM function
» Select the blank cell below the column where you wish to add the numbers by clicking
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» Begin the formula with an equal to (=), then add SUM (). By placing the cursor on one
cell and moving it to the last, you can choose the range of the cells in the arguments.
You can choose to provide the number of cell references directly, separated by
commas.

» As soon as you press the Enter key, Excel will calculate the sum of the values.

6.3.2Subtraction

Subtraction gives the difference between two numbers. Subtraction is denoted by
the *-’ sign. It is the inverse process of addition. The addition of the term with the negative
term is known as subtraction. This process is mostly used to find how many are left when
some things are taken away.

Example: 16 -7 =9

There is no predefined function for Subtraction in Excel. But you can still perform the
subtraction using a formula. As you are already familiar with the implementation of formulas
in Excel, let us take an example to perform subtraction.

» Select the cell that will display the outcome.In this example (Fig 6.5), it's cell C5.
Type the “=" sign in the cell. Then choose the first cell, C4 succeeded by the “-”
symbol followed by the second number in Cell C3. Once you press the enter key, the
two values will be subtracted.

A B e
‘5 T 1 a1 Name Marks
3 A [ 10 [IA 10
-4 B | 20 |iB 20
{5 Differancd =(C4-C3) |’ pitference 10
4 i

Fig 6.5

In case one needs to apply the subtraction operation on the set of values in a particular
column, all you need to do is drag down the formula till the last cell in the result column.
6.3.3 Multiplication

Multiplication is a process of repeated addition. It is denoted by the *x’ or **’ symbol.
It also combines with two or more values to result in a single value. The multiplication
process involves multiplicand and multiplier. The multiplication of the multiplicand and the
multiplier gives the product.

Example: 6 x 7 =42

Here, “6” is the multiplier, “7” is the multiplicand, and the result “42” is called the
product.

To use the multiplication operation in Excel one can simply use the * (asterisk) arithmetic
operator.

For example, if you type =5*20 in a cell, the cell displays the result, 100.
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Multiply an entire column of numbers by a const  ant value

Let us say, oneneeds to multiply each cell in a column of seven numbers by a number
that is contained in another cell. In this example (fig. 6.6), the number you want to multiply
by is 2, contained in cell B2.

A B C ]
1 Data Constan’ Farrmiuls Aasuilt
2 10 2 =A*SR52. 20
i 22 =05 SRET. i
4 33 i SRS L1
5 34 =5 SR53 i3
A

Fig. 6.6

> Type =A2*$B$2 in a new column in your spreadsheet (the above example uses
column D for the result). Make sure to include a $ symbol before B and before 2 in
the formula, and press ENTER.

» Drag the formula down to the other cells in the column.
» The formula column is showing the formula used for the multiplication
6.3.4 Division

The division is usually denoted by ‘=" or /' and is the inverse of multiplication. It
includes two values dividend and divisor, where the dividend is divided by the divisor to give
a single-term value. When the dividend is greater than the divisor, the result obtained is
greater than 1, or else it would be less than 1.

There is no Divide function in Excel. To perform Division inExcel use the ‘/’ (forward
slash) arithmetic operator.

For example, if you type =20/10 in a cell, the cell displays 2.

One thing to make sure of is to type an equal sign (=) in the cell before typing the
numbers and the / operator; else, Excel will interpret what one types as a date. Such that,
for typing 7/30, Excel may display 30-Jul in the cell. Or, for 12/36, Excel will first convert that
value to 12/1/1936 and display 1-Dec in the cell.

6.3.5 Log Transformation

It transforms the value x to Log(x). The log function is mostly used in data analysis to
transform the skewed dataset distribution to less skewed. This helps in finding a pattern in
the dataset. Finding a pattern in the dataset help in making an effective decision, which is the
end task in the data analysis.

There are multiple ways to implement the Log transformation in Excel. Two of those
are discussed in this chapter.
1. Use of LOG10 function

This function returns the Logarithm value of a number and the base will be always

10.The function to transform the base to another number is explained later.
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» Select the cell for function application, E2 in our example (Fig 6.7).

» Type the formula ‘=LOG10(D2)’ in the cell and hit enter. You can apply the formula for
multiple cells in the column by dragging the rectangular symbol in the bottom right
corner of the selected cell.

| Jn «LOGLO[DZ)
W g e P
i Number Log
el 20|=LOG10(DZ)
44 LOG1O
C1
63
Fig. 6.7

2. Use of LOG function

This function is similar to the LOG10 function explained above. There is an option to
add a different base in this function. When we do not enter any value for the base, Excel will
assume the base is 10.The value of the base cannot be — negative, 1, or O.

i K Livaflrd, 2

0 F F
Numbar Log
il 20]=LOGI2,2)
44 rier [bose]
[aln]
63
Fig 6.8
The steps to implement the LOG function are the same as the LOG10 function. Just
change the function to ‘LOG(number,[base])’, where number is the cell number, D2 in this
case, and [base] is the base value ofthe Log function. In this example base is 2.
6.3.6 Exponential T ransformation
Excel provides users with two methods to calculate exponents.The first option is to
use the exponent character, the “*” symbol. The second option is to use a built-in POWER()
function. It takes two values, number, and power.
The use of the exponent character ' is demonstrated in fig 6.9. For multiple-cell
implementation of the formula, drag the formula down to the other cells in the column.
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The use of the POWER function is demonstrated in fig 6.10. The way to use this
function is the same as the other functions. Start with the ‘=" and type POWER followed by
number and power. The number value can be replaced by the cell reference.

D E F
Mumbar Exponant

20| =POWER(D2,2}

414
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Fig 6.10
For multiple-cell implementation of the function, drag the function down to the other
cells in the column.
6.3.7 Square and Square Root
Squaring a number:
Excel provides two ways in which one can square a number:
1. Using a Formula
2. Using a Function
Both ways are very quick and quite easy to implement.
1. Using a Formula
The Square of a number simply means multiplying a number by itself.In other words,
raising it to the power of 2.
To square a numberone can write the formula in two different ways:
» Using the multiplication operator to multiply it by itself.
» Using the caret operator to raise the number to the power of 2.
2. Using a Function
As discussed in the previous topic the POWER function is used to find the exponential
of a number. So, the POWER function with power value 2 can be used for squaring a
number.
Square Root
Excel provides the user with the SQRT function to calculate the square root of any
number. The syntax for the function is:
SQRT(number)
Here the number is the number or cell reference which contains the number for which
you want to find the square root. For example, SQRT(400) will give the user value of 20.
6.3.8 INDEX Function
The INDEX function returns a value or the reference to a value from within a table or
range. In case one needs to return the value of a specified cell or array of cells then this
INDEX function is used. It gives the value of an element in a given location, selected by the
row and column number indexes. Syntax is:
INDEX(array, row_num, [column_num])
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» array —This value is required. It is a range of cells or an array constant. This gives the
range of the cells for indexing.

» row_num- This is the row position in the reference or array.
» col_num - [optional] This is the column position in the reference or array.

IMDEXIC 2:05 3,21
C [ E f
. Book Price
. ABC R0
POR 535 '323_
A 523
MG 2313
Fig 6.11

Fig 6.11 demonstrates the use of the INDEX function. Here it is used to find the Price
of the book named XYZ which is 523. You can check the values of parameters in the formula
bar. The range of cells is C2 to D5. Indexing starts at ABC so the index of XYZ is 3. Similarly
for the column value. This concept can be implemented in a large dataset.

6.4 Summary
In this chapter, we have studied:
» Data management, its types and benefits of data management.
> Data transformation and different types of transformation.
» Implementation of different Arithmetic operators in Excel.
>

Data transformation functions in Excel such as LOG, SQRT, POWER and INDEX,
etc.

6.5Answer to Self-Check exercises
Q.1 Define data management and explain its features.
Q.2 What are the various arithmetic operators of Microsoft Excel?
Q.3 Explain the different ways of squaring a number in Excel.

Q.4 What is Log transformation and how we can calculate the Log of a number with
different base values?

6.6 Suggested Readings
» Ron Mansfield, The Compact Guide to Microsoft office; BPB Publication
» Dienes, Sheila s., Microsoft office, Professional for windows 95

» Joan Lambert, Curtis Frye, Microsoft Office Step by Step (Office 2021 and Microsoft
365),Microsoft Press Publication

> Kenneth N. Berk, Data Analysis with Microsoft Excel
» Wayne L. Winston,Microsoft Excel 2013: Data Analysis and Business Modeling
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Danielle Stein, Using Excel for business analysis: a guide to financial modelling
fundamentals

Olafusi M., Microsoft Excel and Business Data Analysis for The Busy Professional
Rajiv Mattus: Learning Excel 97 for windows step by step BPB publication.
Lonnie. E. Moseley & David M. Boodey: Mastering office 97.

Micro Soft Office 97: Unleashed: Techmedia.

John Walken Bach: Excel 97.
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Chapter-7
CONDITIONAL STATEMENT

STRUCTURE
7.0 Learning Objectives
7.1 Introduction
7.2IF Statement
7.2.1 Use of IF statement
7.2.2 Nested IF Statement
7.2.3 SUM, SUMIF, SUMIFS Functions
7.2.4 COUNT, COUNTIF, COUNTIFS Functions
7.2.5AVERAGEIF Function
7.2.6MAX and MIN Function
7.2.7CONCATENATE Function
7.3 Summary
7.4Answer to Self-Check exercises
7.5 Suggested Readings
Learning Objectives
After going through this lesson, you will be able to:
» Understand the conditional Statements
» Understand the use of IF and its variants
» Understand the use of CONCATENATE, AVERAGEIF
7.1 Introduction

There are many scenarios in real life where you need to work on some conditions.
So, while dealing with real-life data in excel one can use the functionality of condition statements
or predefined functions to solve problems. Excel provides a wide range of functions for
condition checking. In this chapter, the most common Conditional statements and functions
are discussed with examples.

7.2 |F Statement

The Excel IF Statement is used to test a given condition and returns one value for a
TRUE result and another value for a FALSE result. For example, if marks are more than
40%, then return a “PASS” asthe result — Otherwise, return a “FAIL” for the result. One can
implement the IF function in different ways, such as to evaluate a single function, or includes
several IF functions in a single formula. The use of Multiple IF statements in Excel is known
as nested IF statements.
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7.2.1 Use of IF st atement

The IF function is commonly implemented to evaluate and analyze data by evaluating

specific conditions.

This function can be used to evaluate text, values, and even errors. It's not just about

checking if one thing is equal to the other and returning a result. According to our standards,
we can also use arithmetic operators and perform additional calculations. One can also
combine multiple IF functions together for multiple comparisons.

The syntax for the IF function:

>

=IF(logical_test, value_if true, value_if false)
The function uses the following arguments:

Logical_test (required argument) — This is the condition that is to be tested and
evaluated as either TRUE or FALSE.

Value_if_true (optional argument) — It isthe value to be returned if the logical_test
evaluates to TRUE.

Value_if_false (optional argument) — It isthe value to be returned if the logical_test
evaluates to FALSE.

When using the IF function to construct a test, we can use the following logical operators:

= (equal to)

> (greater than)

>= (greater than or equal to)

< (less than)

<= (less than or equal to)

<> (not equal to)

Example: In Fig 7.1 three columns are present namely, Student, Score, and Result.

The Result column provides the values PASS or FAIL after evaluating the value in column D
(Score).

The IF function is used here to evaluate the score so that the result will be PASS for

a Score greater than or equal to 40 and FAIL otherwise.

L L L E ] G
Student Score  Result

ARC | _'-.|:||_-|r| ==l PASS” “FRILY)
T POR &0 ~(loglcal test |u
b4 &
WMNTH 50
Fig 7.1

To implement the condition to the whole E column just drag the formula downwards.

The final result is shown in fig 7.2 after implementation.
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I = IF{D =40 " FASS" "FAIL") |

e o E F
Student Score Result
ABC 30{FaIL |
POR 40 PASS
fE 50 PASS
MNO 50 PASS
Fig 7.2

Note that The IF function is not case-sensitive.
7.2.2 Nested IF Statement

Excel provides the functionality of Nested IF. A Nested IF is referred to a case in
which at least one IF condition is implemented inside another IF for evaluating the condition
in more detail and providing a more precise result. It helps narrow down the result and helps
in evaluating more conditions within one IF.

Example: Here we are Grading the students based on their scores in the examination.
See Fig 7.3.

The Grade (column D) gives the final value by evaluating the Score (Column C). The
nested IF is used to evaluate the score and divide the final result into three grades, A, B and
C. Fig 7.3 shows the result for student A.

sEadwinl ] | Orage |
a a | €
Fig 7.3

After implementing the nested IF to the rest of the cells in the table the final result will
look like Fig 7.4. [ :

i | Soudent Sooae g
L] - C
0 = E
[ ™ [
Fig 7.4

While implementing the nested IF, one IF needs to be carefully nested inside the
other so that the proper logic gets evaluated.
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7.2.3 SUM, SUMIF, SUMIFS Functions
SUM

We can use the SUM function for the addition of a range of cells in MS Excel. SUM
function can either be used by directly writing in the cell starting with equal to sign or by
clicking on the AutoSum command from the ‘Editing’ group under the ‘HOME' tab on the
Ribbon.

The example of the Sum function is already discussed in chapter 6.
SUMIF

SUMIF function is also used to add the range of cells based on one condition or
criteria. In the below example (fig 7.5), we are adding the value of the D column only when
the cell value is more than 100.

A B - I E

| AR ninth Englich tertal

Fakh 43 2] 107

| Mlahiima 12 & e

| Arran e 26 o
.'u-::-\.'.'q-\. bl i 113

i [

Fig 7.5

The condition/criteriain the formula are written in the double quote as the second
parameter. Instead of passing the second parameter as less than or equal to,greater than,
one can also put a condition based on other cell range.

For example, if onewants to add the D column value only when it’s corresponding A
column value is “Aman”. To do this, the formula will be written as ‘=SUMIF(A2:A5, “Aman”,
D2:D5).This means adding the value from D2 to D5 only when A2 to A5 value contains
“Aman’”. In this case, the result will be 70. Here, A2:A5 is the range for criteria and D2:D5
is the range for Sum.

SUMIFS

While using the Sum function on a range of cells, if oneneeds to use multiple criteria,
SUMIFS function can be used.

Inthe below example (fig 7.6), we want to sum the value of the D column only if the A column
value is “Aman” and the B column value is greater than 40. This criteria will be written as
‘=SUMIFS(D2:D5, A2:A5, “Aman”, B2:B5, “>40")'.

Wiz as b} o 13

)

Fig 7.6

# -] [ | g F & 3]
1 NAME Math Emgksh Rvtad
¥ Rakhi i3 4 107
I Mahima =] o 1]
4 Aman L1 26 i)
5
6 |
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Here

* D2 to D5 is the sum range

 AZ2:A5 s criteria 1 range

* “Aman’ is the criteria value of A2:A5

» B2:B5 is the criteria 2 range

* “>40” is the criteria value of B2:B5
7.2.4COUNT, COUNTIF, COUNTIFS Functions

COUNT Function

The count() function is used when one needs to count the number of cells. Arange of
cells is defined and the count function gives the total number of cells in that range. The result
of count() does not include cells containing string data.

Let us take an example, Fig 7.7.

C 7] I

Englah SET PO S Commerce
L] 0 . Gl
34 4 1 FE]
io i LE ¥
e 53 % i
4
Fig 7.7

Here cell E7 shows the result of Count() function for the range of cells E1 to E5. But
here, the cell E5 contains the string value which gives the final result 4. As we have already
discussed that this function does not count the cells with string values.

COUNTIF Function

When one needs to count the cells based on one criteria only, then the Countlf
function is used. The criteria can be less than, greater than, equal to, etc. The criteria can
be used either for numerical or string values.

Fig 7.8
Look at Fig 7.8. Here we are counting the number of cells containing a numerical
value greater than 40. Thus, the final result we get is 2. The formula used in the example was
=COUNTIF(D1:D5, “>40").
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COUNTIFS Function

This function is used in the case where one needs to count the cells in arange based
on more than one criteria. The multiple criteria are separated by a comma.
Lirs LT L] man - i

" ] L Al I f G

BOBE Tlath Englak KT PO 5 Caommerce
Feava LE] i 1| n_iJ i}
felahid 5E 34 34 1 13
Aman cd 16 15 o 7]
S EFeamy 5 ir 53 (a1 ]
I L4

Fig 7.9

Let us say, in Fig 7.9 one needs to count the number of cells in column A for a value
equal to AMAN and column E for values greater than 50. The formula will be,
=COUNTIFS(AL:A5, “Aman”,E1:E5, “>507).

* The count of cells in A1:A5 will give the value 1.
* The count of cells in column E will give a value of 2.

Only those cells are counted for which all criteria are met. In this case, only one value
in column E satisfies the first criteria. So, the final result we get is 1.

7.2.5 AVERAGEIF Function

The AVERAGEIF function is a predefined function in Excel, which helps in calculating
the average of a range of cells based on criteria. Criteria can be true or false conditions.

It is typed =AVERAGEIF and has three parts:=AVERAGEIF(range, criteria ,
[average_range] )

The condition in function syntax is referred to as criteria, which can check things like:
» Ifanumber is greater than another number
* Ifanumber is smaller than another number
* If anumber or text is equal to something

The [average_range] is the range of cells where the function calculates the average.
This value is optional. If not specified, the average will be calculated for the same range as
the condition.

AVERAGEIF will automatically ignore the empty cells in the defined range, even
when the criteria match. AVERAGEIF returns the value #DIV/0! if no cells in the range meet
the criteria. While using the AVERAGEIF function one can only apply a single criteria. To
apply multiple criteria, one can use the AVERAGEIFS function.

7.2.6 MAX and MIN Function

The MAX function is a predefined function in Excel, which helps in finding the highest
number in arange. It does not take into account text or logical values and only works for the
cells with numerical values.
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It is typed as ‘=MAX.
The MIN function is a predefined function in Excel, which helps in finding the lowest
number in arange. It is the opposite of the MAX function. Same tothe MAX function, it also
ignores the cells with text values and only works on the cells with numerical values.

I =RAX{ID2:05] = WAL MDD 2 S

) E D E

SKT POL S5ci SKT POL Sei

50 S0 || 50 50

34 2 i 34 7

34 32 34 52

33 o 53 63
ﬂ__5?] [ 351]

Fig 7.10

Fig 7.10 is showing examples of MAX and MIN functions.
7.2.7 CONCATENATE Function

The meaning of ‘Concatenate’ is to join or combine. The CONCATENATE function in
Excel is used to combine the text values from two or more cells. There is one more way to
combine the cells in Excel, i.e., merge cells. The main difference between these two methods
is that merge cells combine the two cells ‘physically’ and shows the result in one larger cell
spanning across multiple rows or columns. On the other hand, CONCATENATE function
combines the text data value from two or more cell and show the result in another cell.

The Excel CONCATENATE function can be used to join up to 30 text items. It gives
theresult as a text.

The syntax of the function is as follows:
Syntax: =CONCATENATE (textl, text2, [text3], ...)

For example, the simple formula to CONCATENATE the values of two cells A3 and B3
are as follows:

=CONCATENATE(A3,B3)
; - fr = =CONCATENATE(A3,83) |
| A B C D : F

. First name Surname Name

|Aman  Sharma |AmanSha r|-n a

Fig. 7.11
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See figure 7.11. Thevalues will be combined without any delimiters. To separate the
values with space, one can use “*“. In that case, the formula will be like this,

=CONCATENATE(A3, “*, B3)
This will produce the result ‘Aman Sharma’.
Concatenating a T ext String and a Cell V alue

There are more things that the Excel CONCATENATE function can do. One can use
the function to join a cell value with a string as well. For example:

=CONCATENATE(AS3, “*“, B3, “ Delhi")
The example is shown in fig 7.12.

[ C3 - fi CONCATENATE(A3," ", B3," Delhi").
| A B C D E F G
.1 | First name Surname Name
2
3 |1 Love | Love DetI_LE
Fig 7.12

When using CONCATENATE function, there should be at least one “text” argument
for it to work. In case of invalid arguments, the formula returns a #VALUE! Error.The result
of the CONCATENATE function is always a text string.

7.3 Summary
In this chapter, we have studied:
» Conditional statements, IF statements, and their types
» Implementation of conditioning while adding cells.
» Implementation of conditioning while counting the cells.
» Some useful functions like AVERAGEIF and CONCATENATE.
7.4 Answer to Self-Check exercises
Q.1 Define conditional statements and explain them with examples.
Q.2 Discuss SUM, SUMIF and SUMIFS?
Q.3 How to count the cell with specified conditions?

Q.4 Explain the use of CONCATENATE function in Excel and how is it different from the
‘merge cell’.

7.5 Suggested Readings
» Ron Mansfield, The Compact Guide to Microsoft office; BPB Publication
> Dienes, Sheila s., Microsoft office, Professional for windows 95

79



YV VYV

YV V V V V

Joan Lambert, Curtis Frye, Microsoft Office Step by Step (Office 2021 and Microsoft
375), Microsoft Press Publication

Kenneth N. Berk, Data Analysis with Microsoft Excel
Wayne L. Winston,Microsoft Excel 2013: Data Analysis and Business Modeling

Danielle Stein, Using Excel for business analysis: a guide to financial modelling
fundamentals

Olafusi M., Microsoft Excel and Business Data Analysis for The Busy Professional
Rajiv Mattus: Learning Excel 97 for windows step by step BPB publication.
Lonnie. E. Moseley & David M. Boodey: Mastering office 97.

Micro Soft Office 97: Unleashed: Techmedia.

John Walken Bach: Excel 97.
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Chapter-8
SORTING AND FILTERING OF DATA
STRUCTURE
8.0 Learning Objectives
8.1 Introduction
8.2 Sort
8.3 Filter
8.4 LOOKUP Function
8.5 Summary
8.6 Answer to Self-Check exercises
8.7 Suggested Readings
8.0 Learning Objectives
After going through this lesson, you will be able to:
* learnto sort the data in excel
* learn the sorting of data in different ways
* understand the concept of sorting and filtering
* learn the method to filter the text and numerical data
» understand the working of the Lookup function
8.1 Introduction

Excel provides various tools and functions for data analysis and management.
Whenever we are dealing with a large volume of data, we need to apply some operations
on the data to easily process the information. One of the most commonly applied such
operations is Sort. Sort is basically used to arrange the data in a particular order like
ascending or descending. Using sort we can arrange the text data values in alphabetical
order.Another usually employed function is Filter. The filter is normally used to find the
selected information from the heap of the data. To narrow down the search area and get the
information more easily different filters are applied to the data. Excel has many predefined
filters for the different data types. In addition to these two functions, in this chapter, we have
also discussed the Lookup function.

8.2 Sort

There are many cases when you need to organize your data in a certain way which
will help in better data analysis. This type of data organizing functionality is provided in the
Excel with SORT function. This function allows the user to:

e SortdataAtoZorZtoA
» Sort data in Ascending or Descending order

» Sort data from lowest to highest or highest to lowest
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The sort function can be applied either row-wise or column-wise. It allows the

applicationof the sorting function to a particular column/row to expand the sorting to the
whole data.

The sort function is given in the HOME tab under the Editing group with the label ‘Sort

& Filter’. You can see fig 8.1.

Fig 8.1

Ascending and Descending sorting

To sort the data in ascending or descending order, abide by the following steps.

Select a column with a numerical value on which sorting is to be carried out.
Then click on the Sort & Filter option in the editing group under the Home tab.

Here, more options will appear. Click on ‘Sort Smallest to Largest’ for sorting the
data in ascending order. In case of descending order sorting, click on ‘Sort Largest
to Smallest'.

Next, a dialogue box will appear with two options;

0 Expand the selection- will apply the sort to other data columns in the sheet
concerning the selected column.

0 Continue with the current selection- will apply the sort to the selected column only.
After selecting the appropriate option, the user can get the sorted data in either
ascending or descending order.

Fig 8.2

An example of steps included in sorting is shown in fig 8.2.
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A-Z and Z-A Sorting

This type of sorting is used to sort text data alphabetically. For example, in figure 8.2
we have a column NAME with text values. We can sort the data in this column in alphabetic
order, either Ato Z or Z to A. To carry out this sorting follow the steps:

» Select a column with text value on which sorting is to be carried out. NAME in our
example.

» Then click on the Sort & Filter option in the editing group under the Home tab.
* Here, more options will appear. Click on ‘Sort Ato Z’' or ‘Sort Zto A'.
* Next, a dialogue box will appear with two options;

o Expand the selection- will apply the sort to other data columns in the sheet
concerning the selected column.

o Continue with the current selection- will apply the sort to the selected column
only.

» After selecting the appropriate option, user can get the alphabetically sorted data.

A B C D E
1T '[NAME Math English  Total
2 |Aman 44 26 70
3 |Mahima 32 54 86
4 |Rakhi 43 64 107
5 |Vishwas 55 77 132
Fig 8.3

Fig 8.3 shows the result of the ‘A to Z’ sort on the NAME column. Refer the fig 8.2 to
compare the data before and after sorting.

Users can apply the sorting function in both ways, column-wise or row-wise. Here,
column-wise sorting is discussed. To apply the sort row-wise, follow the steps mentioned
above after selecting a row you need to sort. The rest of the process is the same.

8.3 Filter

When working with a huge amount of data, one cannot find the specific data easily.
To narrow down the search and find the information quickly, filters can be used. It helps to
narrow down the data in your worksheet, which allows you to view only the information you
need.

To filter dat a:

In our example, we are going to filter the data in the table shown below (Table 8.1)
based on different cases. For correct working filtering, the worksheet should include a
header row, which is used to distinguish each column. In our example, our worksheet is
organized into four columns identified by the header cells in row 1. The data in the worksheet
is shown in table 8.1.
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Table 8.1 Example dat a

NAME MATH ENGLISH TOTAL
Aman 44 26 70
Mahima 32 54 86
Rakhi 43 64 107
Vishwas 55 77 132

To get started with the filtering, follow the steps:
o First, select any cell in the range of data.
o Then go to the ‘DATA' tab,and Click Filter in ‘Sort & Filter’ group.
o Inthe header cell for each column,a drop-down arrow will appear.

MEME - Math = English Tadal

Ao | E1 Fol M

Mesimns .u-] 5 ]

Fuakhi £3 BL 147

el a5 ) 152
Fig. 8.4

o Click the drop-down arrow for the column you want to filter. See fig 8.5.

Now, there are many options under the filter function. Users can also apply the sort
operation on the data of the column. For example, in fig 8.5, one can see the different
options available after clicking the down arrow in the ‘Math’ column.
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Number Filter

Based onthe type of data in the column selected, the user will get the options as
‘Number filters’ or ‘Text Filters’. In our example, we have selected the math column having
numerical values. So, here the option available is ‘Number Filters’. Number Filters allow the
user to manipulate the numerical data in multiple ways. As you can see in fig 8.5, there are
multiple conditions are available under the category of ‘Number filter’.

Let us say, we want to filter the marks in MATHS between 45 and 60.
So, the steps are:
o First, select the ‘Between’ option under Number Filters.

o Adialogue window will appear as shown below.

T mar re e

< aridier than of #igsal b 48
= IO al]

el LT

o KR U0 Depidastl S R R

¥ Ler * m eepeesert any sones of chamcders

Lo Ll Bl

o Now add the condition for filtering, that the value should be ‘greater than or equal
to’ 45 and ‘less than or equal to’ 60. Then press OK.

0 The result you will get is shown below.

.............................................

[NAME - [Math 7 English - Total -

Vishwas 55 77 132

The filtering discussed above is advanced Number Filtering. You can try the different
conditions available for ‘Number Filter’ using the same steps mentioned above.
Text Filter

Similarly, for the column with text data, we have Text Filters.Let us take an example
to understand its works. If we want to find the entry of a person with a name starting with
alphabet A, we will carry out the following steps.

o First, click the down arrow on the Name column. We will get the options shown

below.
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o0 After selecting the ‘Text Filters’, you can see the different conditions available.

o We will choose the option, ‘Begins With'. After selecting this, we will get a dialogue
box as shown below.
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o Enter the Condition, i.e., A and press OK. It will give the following results.

NAME -T_Math +~! English -~ Total @~
Aman 44 26 70

o This s the final result of Text Filtering.

There are also other types of filtering available, such as Date filtering. This option will
appear for the column with the date as data.

Saving the Filtered Dat a

It may be the case, thatStheuser does not want to modify the original data. In that
case, the user can save the result of filtering to another worksheet. There are multiple ways
to save the filtered data to a different worksheet. One of the most common ways is to:
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o Add a new worksheet by clicking the plus (+) sign near Sheet one above the
status bar.

o This will add a new worksheet. You can rename this sheet.
o Now, copy the filtered data by selecting the data and pressing CTRL + C.

o Go to the new sheet, select a cell where you want to paste, and press CTRL +
V.

0 Save the worksheet.
This is the simplest way to save the filtered data into a different worksheet.
8.4 LOOKUP Function

Most of the time, the user wants to look up for a value in the data and need the results
for the matching value to be returned. MS Excel provides the user with a handful of ways to
do lookup. The lookup can be done in horizontal or vertical way. The function given in the
Excel for this purpose is LOOKUP.

In simple terms, one can say that the LOOKUP function searches a value in one
column or row and returns a corresponding value from the same position in another column
or row.Lookup functions are generally very assistive with large sets of data to find specific
information throughout many rows or columns.

There are two forms of LOOKUP in Excel. Namely, Vector and Array. We have
discussed the Vector form in this book.In this context, a vector denotes a one-column or
one-row range.The vector form of LOOKUP is used to search one row or one column of
data for a specified value, and draw a value from the same position in another row or
column. The syntax for vector Lookup is:

LOOKUP(lookup_value, lookup_vector, [result_vector])
Where,

o0 Lookup_value (required value) — This is the value to search for. It can be a number,
text, logical value of TRUE or FALSE, or a reference to a cell containing the lookup
value.

o0 Lookup_vector (required value) — This is the one-row or one-column range of data to
be searched. It must be sorted in ascending order.

o0 Result_vector (optional) —This is the optional one-row or one-column range of data
from which you want to return the result - a value in the same position as the lookup
value. Result_vector must be the same size as lookup_range. If excluded, the result
is delivered from lookup_vector.

The following examples helps in understanding the working of Lookup function.
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Vertical Lookup

We took a data of seller and their product, Fig 8.6. Here, we are doing a vertical
lookup i.e., searching is done in column range. The list of sellers is in column D (D2:D5) and
the products they sold in column E (E2:E5). We are making a dashboard where the user will
enter the seller’s name in B2 and the formula would pull a corresponding product in B3. The
accomplish this task the formula needed will be :

=LOOKUP(B2,D2:D5,E2:E5)

j B3 . LOOKUMEZ D205 E2:E5)

i A B i ] E F
i1 - RESULT Seller Product
L2 Saller resla Agppile Tech
. 3 |Produet | Cai Classmate Stationary
e | : lesla Cad
A Fata Steal
Fig 8.6

Where,

0 B2-isthelookup_value. The user will enter the name of seller here and we need
to check the corresponding product.

o D2:D5-isthe lookup_vector. This is the range of lookup_vector from which the
user will enter the value.

o E2:E5 - is the result_vector. This is the range of values from which the
corresponding value will be searched for.

Horizont al Lookup

There may be the case that the source data has a horizontal layout, i.e., the entries
reside in rows rather than columns, fig 8.7. In this case,issue one-row range in the
lookup_vector and result_vector arguments. Thus, the formula will be like this:

=LOOKUP(B2,E1:H1,E2:H2)

1| B3 =LOOKUP(B2,E1:HLEZ2:HZ)

: A H C E F G H
i1 RESULT Seller Apple Classmate Tesla Tata
i 2 |Seller apple Product tech stationary car steel

1 |Product |tech

Fig 8.7
88



Uses of Lookup function
Some common uses of LOOKUP functions are listed below:
The users can find the exact or suitable match by using the lookup function.

The users can search for data both vertically (columns) and horizontally (rows) in the
worksheet.

o0 Itis easy to use and does not require selecting the complete table.

There are some important points to remember while using the lookup function. They
are listed below:

o LOOKUP assumes that lookup_vector is sorted in ascending order which means
from A to Z or from smallest to largest.

0 Whenlookup_value cannot be found, LOOKUP will match the next smallest value, i.e.
the largest value in lookup_vector that is less than or equal to lookup_value.

o0 Whenlookup_value is greater than all values in lookup_vector, LOOKUP matches the
last value.

0 When lookup_value is smaller than the smallest value in lookup_vector, the Excel
LOOKUP returns #N/A.

Result_vector must be the same size as lookup_vector.

LOOKUP is not case-sensitive,it does not differentiate uppercase and lowercase
text.

8.5 Summary
In this chapter, we have studied:
» Concept of sort and filter
» Different methods in sorting and filtering.
» Lookup function.
8.6Answer to Self-Check exercises
Q.1 Differentiate between sort and filter with examples.
Q.2 How to create a sub sample of dataset using filtering?
Q.3 What is text filter and its different conditions?
Q.4 Explain the concept of horizontal and vertical Lookup.
8.7 Suggested Readings
» Ron Mansfield, The Compact Guide to Microsoft office; BPB Publication
> Dienes, Sheila s., Microsoft office, Professional for windows 95

» Joan Lambert, Curtis Frye, Microsoft Office Step by Step (Office 2021 and Microsoft
385),Microsoft Press Publication

> Kenneth N. Berk, Data Analysis with Microsoft Excel
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Wayne L. Winston,Microsoft Excel 2013: Data Analysis and Business Modeling

Danielle Stein, Using Excel for business analysis: a guide to financial modelling
fundamentals

Olafusi M., Microsoft Excel and Business Data Analysis for The Busy Professional
Rajiv Mattus: Learning Excel 98 for windows step by step BPB publication.
Lonnie. E. Moseley & David M. Boodey: Mastering office 98.

Micro Soft Office 98: Unleashed: Techmedia.

John Walken Bach: Excel 98.
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Chapter-9
DESCRIPTIVE STATISTICS

STRUCTURE
9.0 Learning Objectives
9.1 Introduction
9.2Descriptive Statistics
9.3 Univariate analysis
9.4Multivariate analysis
9.5 Implementation with Excel
9.6 Summary
9.7Answer to Self-Check exercises
9.8 Suggested Readings
9.0 Learning Objectives
After going through this lesson, you will be able to:
* Understand the basics of descriptive statistics
» Understand the univariate and multivariate data analysis
» Understand the concept of central tendency and measure of dispersion.
* Implementation of descriptive statistics in MS Excel.
9.1 Introduction

Statistics is the field concerned with collecting, organizing, analyzing, interpreting,
and presenting data. Statistical formulas and methods are logical and very interesting to
implement. The main reason to use statistical analysis is to make the data more informative
and bring clarity to the research questions. The statistical procedures help in finding the
hidden patterns in the data that are not directly observable. The discovery of these patterns
helps in problem-solving and decision-making.

9.2 Descriptive S tatistics

Descriptive statistics include numerical and graphical procedures to help the person
to understand the data and discover the hidden patterns. In other words, it is the branch of
statistics that focuses on measuring and describing the data in such a way that the person
can find the patterns in the data which are usually not apparent. In this chapter, the numerical
procedures for data analysis are discussed. Normally, a person gathers data, which is not
examined and exists as a series of numerical values with no observable relationship. The
use of descriptive analysis techniques helps the person to present the data in such a way
that hidden patterns can be assessed numerically and visually.
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Before analyzing the data, the motive of analysis is important. Next main point is to
identify the type of analysis, i.e., univariate or multivariate analysis. Based on this, the
methods are selected for final evaluation.

9.3 Univariate analysis

Univariate analysis is the simplest type of analysis where only a single variable is
analyzed. There are many ways to analyze univariate data. The most common manner of
analysis is to check the central tendency and measures of dispersion. These two are the
popular types of summary statistics.

Central Tendency : the measure of central tendency is used to describe a set of
data by identifying the central point of distribution or central position within that set of data.
That's why it is often called a measure of central location. The mean, mode, and median are
the most familiar measures of central tendency. Other measures are used. Let’s discuss
them briefly.

* Mean — It is the average value in a set of data.

« Median- It is the middlemost score in a set of data that has been arranged in the
order of magnitude. The value of the median is not much affected by skewed data
and outliers.

* Mode- The mode is the most commonly occurring value/score in the set of data.

« Trim mean: Itis a method of statistics that is used to get a more realistic mean of
the set of data. To use this method, a percentage of the highest and lowest values
are cut and then the mean is calculated. This step of pre-calculation enhances the
reliability of the mean.

* Geometric mean -Ageometric mean is a mean or average which shows the central
tendency of a set of numbers by using the product of their values. The geometric
mean is mostly used to determine the performance results of an investment or portfolio.
For a set of n observations, a geometric mean is the nth root of their product. The
calculation of geometric mean does not accept negative or zero values, e.g. only
positive values. When working with percentages derived from data values, the
geometric mean is recommended to use.

* Harmonic mean- The use of harmonic mean is averaging of ratios. The ratios are
speed and time, cost, etc. The harmonic mean is the most suitable mean if the data
consists of rates. Thus, if the data values are rates, then use the harmonic mean. The
very common use of harmonic mean is in averaging things like rates (e.g., the average
travel speed given a duration of several travels).

Measures of dispersion — Sometimes, the measures of central tendency are not
enough to describe data. Two sets of data may have the same mean but they can be
completely different. Thus, there is a need to know about the extent of variability to describe
data. And this is given by the measures of dispersion.
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Range - The range is the numerical difference between the largest and smallest
values in the distribution. It is easy to calculate but susceptible to outliers and thus
easily affected.

Quartile deviation —The Quartile Deviation is used to judge the spread of a distribution
about a measure of its central tendency (usually the mean). So, it generally provides
an estimate of the range within which the central 50% of sample data lies.

SD- The standard deviation is used to represent how spread out the values are. The
SD represents a standard amount of distance between the mean and each score in
the distribution. It is the square root of the variance (VAR). The variance is the
average squared distance of the scores in a distribution from the mean.

CV — CV refers to the coefficient of variation. CV is a standard measure of the
dispersion of data points around the mean in a data series. It basically represents the
ratio of standard deviation to the mean.

Gini coefficient :itis used to measure the inequality among the values of frequency
distribution. Normally, like the levels of the income distribution of a population. Value
0 of the Gini coefficient represents perfect equality and 1 (or 100%) represents
maximum inequality among the values.

Moment s and order st atistics

Skewness - A measurement of a data distribution that determines the extent to
which itis “imbalanced” or “leaning” away from a standard bell shape (in the caseof
a normal distribution). Skewness is a term that describes whether, or to what extent,
a set of values is not perfectly balanced but rather trails off to the left or right of the
center.

Kurtosis - Same as skewness the kurtosis is used to represent the distribution.
Kurtosis describes the degree to which values cluster in the tails or the peak of a
frequency distribution. The peak is the tallest part of the distribution, and the tails are
the ends of the distribution.

Rank- Rank is the data transformation in which the numerical values of the distribution
are replaced with their ranks.

Percentile — The use of Percentiles is to represent the point in a distributionof values
below which a given percentage of values fall.

9.4 Multivariate dat a

Multivariate dat a — When data analysis involves three or more variables, it is

categorized under multivariate.

Covariance - the covariance value is the measure of the relationship between two
random variables. Which to what level, do they change together.
Correlation matrix - Itis atabular representation of correlation coefficients for different
variables. The correlation matrix represents the correlation among all possible pairs
of values in a table. It is a way to organize a large set of data which further helps to
identify and visualize the patterns.
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A correlation matrix constitutes the rows and columns that show the variables. Every
single cell in the matrix contains the correlation coefficient. It is often implemented in
conjunction with other statistical analyses. One of the major use of matrix is to
analyze the multiple linear regression models.

» Partial correlation — Partial correlation is a method that is used to measure the
strength of a relationship between two variables, while controlling for the effect of
one or several other variables, on this relationship. For example, it can be used to
measure the correlation between the amount of food eaten and blood pressure,
while controlling for the variables like weight and frequency of exercise. It is noted
that with the increase in the control variables the test becomes less reliable.

* Rank correlation - The Rank correlation is generally used in the case when data is
not normally distributed or the presence of outliers affects the association between
two random variables. Generally, with correlation, we only know about the relationship
between two variables and how one affects the other. But we do not know about the
guantity, that is how much they are related.

9.5 Implement ation with Excel

Now, let us perform the descriptive analysis with MS Excel. First, we need to locate
the Data analysis group in the Data tab as shown below (fig 9.1).
[~ H .

e e REe Bl e -l-— e b 0 i el

Fig 9.1
If you are not able to find this option then follow the steps mentioned below:

1. Click the File tab,click Options in the bottom left, and then click the Add-Ins category.
2. In the Manage box, select Excel Add-ins and then click Go.

3. Inthe Add-Ins dialogue box, check the ‘Analysis ToolPack’ check box, and then click
OK.

» IfAnalysis ToolPak is not listed in the Add-Ins available box, you need to click ‘Browse’
to locate it.

* Ifyou are prompted that the Analysis ToolPak is not currently installed on your computer,
click Yes to install it.

After this step, you will be able to locate the Data Analysis in the Data tab. This
Analysis Toolpackis used to generate descriptive statistics. Here is an example.

We took the scores of 10 participants in a test as data, as shown below (fig 9.2).
To generate the descriptive analysis for these data values follow the steps given below.
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Scores
56
63
77
34
b6
98
65
35
71
77

Fig 9.2
1. Gotothe Data tab, in the Analysis group, and click Data Analysis.

| BB BB | &8 48 @@ T |

What-If  Forecact Group Ungroup Subtstal
Analygis > Shest - "

Forecast Crirtlime s Analysis

2. Select Descriptive Statistics from the list and click OK.

Data Analysis ? X
Analysis Tools _G—K.[}_‘
Anova: Single Factor A ;
Anova: Two-Factor With Replication Cance
Anova: Two-Factor Without Replication
Correlation
Covariance Help

Exponential Smoothing

F-Test Two-Sample for Variances

Fourier Analysis

Histogram v

3. Select the range K2:K12 (range of input data) as the Input Range.
4. Select cell N2(you can choose any blank cell) as the Output Range.
5. Make sure Summary statistics are checked.
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6. Click OK.
Result: -
K L A i £
Srores Scores
&6
b3 Maan (512
7 Standard Error 5460568
E 4] Median 64.5
s Mods )
(£l 7] Standard Deviation 1F.26782
a5 Lample Variance 209817718
B85 Kurtosis 1.368501
F | SkEwmess 047131
i Rangs o
Mimimum 34
haximum S8
Sam G52
Court 10

In the above image, you can check the various statistical information about the data
values we have taken (fig 9.2).

In addition to these measures, we can also evaluate other measures in excel.

* Harmonic mean : HARMEAN function is available in Excel for harmonic mean.The
HARMEAN function takes multiple arguments.The arguments are in the form number
1, number 2, number 3, etc. up to 255. Arguments can be numerical values, cell
references, or a range.

Example: =HARMEAN(1,2,6)

It will return 1.8.
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Geometric mean : The GEOMEAN function is available in Excel for geometric mean.
The GEOMEAN function takes multiple arguments.The arguments are in the form
numberl, number2, number3, etc. up to 255. Arguments can be numerical values,
cell references, or a range.

Example: =GEOMEAN(4,9)

It will return 6.

Trim Mean : The Excel TRIMMEAN function is used to calculate the meanwhile
excluding outliers. The number of data points that will be excluded by the function is
provided in the form of a percentage. This percentage can be either in decimal format
or percent format.

For the data in fig 9.2, the TRIMMEAN will be: =TRIMMEAN (K3:K12,0.2) and it will
return the value 70.

Quartile Deviation: The QUARTILE function is used to calculate the quartile deviation.
First, you need to enter the data set in a single column of the excel sheet. For
example, fig 9.2.

Click on any of the empty cells of the excel sheet for the result display.

If you want to find the first quartile then, you have to type “=QUARTILE(K3:K12,1)”
and hit enter.

Just like this, you need to type “=QUARTILE(K3:K12,3)" to find the third quartile.
Coefficient of V ariance - To calculate the coefficient of variance in Excel, you need
to apply the following formula:

Formula: ‘=STDEV(K3:K12)/AVERAGE(K3:K12)’

Where STDEYV is the function to calculate Standard Deviation and Average is used to

calculate Average or Arithmetic Mean. You can also use the value of Standard Deviation
and Mean from the statistical information returned from Data Analysis.

Gini Coefficient:  To calculate the Gini coefficient in Excel follow the steps given
below:

Enter the data. Two columns namely, the cumulative population % and cumulative
income % of individuals. Shown in the figure below.

A B
1 |Cummulative population % Cummulative Income %
2 0 0
3 20 15
4 50 36
5 60 54
b 100 100
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The meaning of these values is,
- The bottom 20 % individuals of in the country account for 15 % of the total income
- The bottom 50 % individuals of in the country account for 36 % of the total income
- The bottom 60 % individuals of in the country account for 54 % of the total income
- 100% of individuals in the country account for 100% of the total income.

» The next step is to calculate the Area under Lorenz Curve. This curve is used to
visualize the distribution of income in a country. We will use the formula =(A3-
A2)*(B3+B2)*0.5 to calculate the area under Lorenz Curve in column C.

SLIBA * - ' f =(A3-AZN [BI+BT*05
) B C
1  Curmmulative papulation % Cummilative Income !'b_ﬁm wnder Lorens crirve
z % % |
= |_ ik 15% [ ={f3-AZp B3+ R2) 0.5
P4 0% 9%
5 G 5:4%
L 104 100%

» The last step is to calculate the Gini coefficient. For that, we will type the formula
‘=1-2*SUM(C3:C6)’ in D2.

1- s URAIC2:CRY

Ay -] L !
I Cummaulative populaticn % Cummulative Incames % frsa wnder Larens curvs  Gind CosfRicesnt
2 0% 0% [ o.111]
1 0% 15% LS
4 L1 30 O7ES
5 G Sak 0045
& 1355 100% [ERCHH

So, the Gini Coefficient for this population turned out to be 0.111. One can use the
same method to calculate the Gini coefficient for a large dataset also.

« Rank: The RANK function is available in Excel which returns the statistical rank of a
given value within a provided array of values.

Formula: =RANK(number,ref,[order])

L= = fs =RAMKIBZ 5B52:5855)
L Ay B 8 b E F
il Mame English Rank

i |Vishwas .".fl 1_|

3 |Aman 6

4 Rakhi G

i 5 Mahima 54
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As seen above, the formulais applied in the C2 cell. And same is dragged to the last
value in the adjacent column. So the final result will be like this:

i B I':
1 MName English Rank
2 |Vishwas 7 1
i 3 Aman 26 &
i 4 | Rakhi 549 2
5 IMahima 54 3

The final result after using the RANK function can be seen above.

Percentile : The PERCENTILE function returns the Kth percentile of the selected
values in a range. After MS EXCEL 2010 more functions have been introduced.
PERCENTILE.INC() works the same as the PERCENTILE. You can still use the
PERCENTILE().
Formula: PERCENTILE(array,k)
Where,
Array: It is a required argument. The array or range of data that defines relative
standing.
k: Itis required. The percentile value is in the range of 0...1, inclusive. You can either
use percentage or decimal values.
For example, e Tta .
i =FERCEMTILE(EZ:ES D.5)
2 E F
: Scores

10

20

40

30

2]

As you can see in the above image, we have used the value of k as 0.5 i.e., 50%
The value of k cannot be non-numeric otherwise, it will return #VALUE! error value.
Forkis <0 orif k> 1, PERCENTILE returns the #NUM! error value.

Covariance : There are two ways to calculate Covariance in Excel.

COVARIANCE.P(): The first method is to use the Covariance.P() function. It has two
arguments, Arrayl and array 2. These are range of cells for two variables for which
Covariance is to be calculated.
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For example,
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Here, you can see two variables Data 1 and Data 2 are selected as the two arguments.
The value it will return is 5.2.

. Using Dat a Analysis tool.

Just go to the Analysis group in the Data tab and click Data Analysis.
Select Covariance from the list.

Select the input data range.

Select output range.

| Covanance ¥ w
s = Datal Dataz |
rif Range LTI E L ] . al
i
e 1
Grouped By Q) column: . i'i
Binis e E 141
]
B Lateh i first row 5 15|
& I'.l:
Cafpd ephant
D Suipon Raage 334 T

(@)

(@)

R e L \\" [t Datat
i oridhoni Catal F
Daiad 5.2 (N

Check the box for Labels in the first row (if any).

Click OK. The result will beshown in a table form.
An example is shown above. The result is highlighted in the rectangular box, i.e., 5.2.
Correlation Matrix: There are two ways to calculate Correlation in Excel.

CORREL(): This function is used to calculate the correlation. It has two arguments
Array 1 and Array 2. These are range of cells for two variables for which Correlation
is to be calculated.

Using Dat a Analysis tool.
Just go to the Analysis group in the Data tab and click Data Analysis.
Select Correlation from the list.

Select the input data range.
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Select output range.
Check the box for Labels in the first row (if any).
Click OK. The result will be shown in a table form.

Partial Correlation: There is no direct function or tool to calculate the partial
correlation. See the example below to understand the process of calculation of partial
correlation in Excel.

Consider we have two variables X and Y for which correlation is to be calculated. Z
is another variable that is related to both X and Y. So the formula for partial correlation
will be:

Partial Corr (X,Y).Z = (Corr (X,Y) - Corr (X,2)* Corr (Y.Z2)) /
(V1- (Corr (X,2)?* v1- (Corr (Y,2)?)

Below is an example,

A B C (] E F

Intermal macks (%] Howra for study (Y] Final Marks [Z]
i 70 i ag Correlation (X.¥} 0.6EEAD
3 s ] Hh Correlation tl:,zl L3R 514
i4 BE i ) Carrelation [¥,2) 032837
i | 65 & a7 Partial Correlation (%,Y).2] 06345
i 76 7 a0
|

Here, you can see the formula used in the formula bar applied in cell F5. The patrtial
correlation we have is -0.6385

Rank Correlation: There is no predefined function available in Excel to calculate the
rank correlation. The process is similar to the calculation of partial correlation, i.e.,
apply the traditional formula step-by-step in excel.

9.6 Summary
In this chapter, we have studied:

>
>
>

About the descriptive statistics.
Univariate and multivariate data analysis.

Implementation of various statistical methods in excel to perform descriptive data
analysis like the measure of central tendency and measures of dispersion.

9.7 Answer to Self-Check exercises
Q.1 Define descriptive statistics.
Q.2 Discuss the Data Analytical Toolpack in Excel.
Q.3 How to perform the data analysis in Excel?
Q.4 Explain the various measures of descriptive statistics available under data analysis.
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9.8 Suggested Readings

>
>
>
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Ron Mansfield, The Compact Guide to Microsoft office; BPB Publication
Dienes, Sheila s., Microsoft office, Professional for windows 95

Joan Lambert, Curtis Frye, Microsoft Office Step by Step (Office 2021 and Microsoft
395),Microsoft Press Publication

Kenneth N. Berk, Data Analysis with Microsoft Excel
Wayne L. Winston,Microsoft Excel 2013: Data Analysis and Business Modeling

Danielle Stein, Using Excel for business analysis: a guide to financial modelling
fundamentals

Olafusi M., Microsoft Excel and Business Data Analysis for The Busy Professional
Rajiv Mattus: Learning Excel 99 for windows step by step BPB publication.
Lonnie. E. Moseley & David M. Boodey: Mastering office 99.

Micro Soft Office 99: Unleashed: Techmedia.

John Walken Bach: Excel 99.
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Chapter-10
GRAPHICAL PRESENTATION OF DATA

STRUCTURE
10.0 Learning Objectives
10.1 Introduction
10.2 Charts
10.2.1 Types of Charts
10.3 Create a chart with Insert Charts
10.4 Scatter Chart
10.5 Curve Fitting
10.6 Summary
10.7 Answer to Self-Check exercises
10.8 Suggested Readings
10.0 Learning Objectives
After going through this lesson, you will be able to:

. Understand the importance of the graphical presentation of data
. Understands the different types of charts
. Understand the importance and applications of charts

10.1 Introduction

It is sometimes not easy to interpret Excel data due to the complexity and size of the
data. So, charts are a way to represent the data graphically and interpret the data easily.
Charts are the visual representation of data.

Excel provides charts to take advantage of graphical representation. The data
represented through charts is more understandable than the data stored in an Excel table.
This makes the process of analyzing data fast. Excel users can fast analyze the data.

Graphical representation of data using charts makes complex data analysis easier to
understand. Excel has a variety of charts, each with its different functionality and
representation style.

10.2 Charts

A chart is a graphical representation of your data in a worksheet. Using charts to
represent worksheet data often creates a better understanding of your data rather than
simply presenting the numbers in a spreadsheet. They are also a great way to add brandingto
your presentations.
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There is a list of basic and advanced levels of charts used for different scenarios to

analyze the data.

Excel offers various charts to represent the data in different manners, such as - Pie

charts, Bar charts, Line charts, Stock charts, Surface charts, Radar charts, and many more.
You can utilize them as per your data analysis needs.

10.2.1 Types of Chart s

Clustered column and 3-D clustered column

Clustered column 3-1 lumn

A clustered column chart shows values in 2-D columns. A 3-D clustered column chart

shows columns in 3-D format, but it doesn’t use a third value axis (depth axis). Use this chart
when you have categories that represent:

>
>

Ranges of values (for example, item counts).

Specific scale arrangements (for example, a Likert scale with entries like Strongly
agree, Agree, Neutral, Disagree, strongly disagree).

Names that are not in any specific order (for example, item names, geographic
names, or the names of people).

Stacked column and 3-D st acked column : Astacked column chart show valuesin
2-D stacked columns. A 3-D stacked column chart shows the stacked columns in 3-
D format, but it doesn’t use a depth axis. Use this chart when you have multiple data
series and you want to emphasize the total.

— [ |z ]
OH qH

Stacked column 3-D stacked column

100% stacked column and 3-D 100% st acked column : A 100% stacked column
chart shows values in 2-D columns that are stacked to represent 100%. A 3-D 100%
stacked column chart shows the columns in 3-D format, but it doesn’t use a depth
axis. Use this chart when you have two or more data series and you want to emphasize
the contributions to the whole, especially if the total is the same for each category.




e 3-D column : 3-D column charts use three axes that you can change (a horizontal
axis, a vertical axis, and a depth axis), and they compare data points along the
horizontal and the depth axes. Use this chart when you want to compare data across

both categories and data series.
i
I
column

3-D colu

[I. LineCharts

Data that’s arranged in columns or rows on a worksheet can be plotted in a line chart.
In aline chart, category data is distributed evenly along the horizontal axis, and all value data
is distributed evenly along the vertical axis. Line charts can show continuous data over time
on an evenly scaled axis, so they’re ideal for showing trends in data at equal intervals, like
months, quarters, or fiscal years.

A

[ll. Pie Chart

Data that’'s arranged in one column or row on a worksheet can be plotted in a pie
chart. Pie charts show the size of items in one data series, proportional to the sum of the
items. The data points in a pie chart are shown as a percentage of the whole pie.
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Consider using a pie chart when:

» You have only one data series.

» None of the values in your data are negative.

» Almost none of the values in your data are zero values.

» You have no more than seven categories, all of which represent parts of the whole
pie.

Types of pie chart s

» Pie and 3-D pie Pie charts show the contribution of each value to a total in a 2-D or
3-D format. You can pull out slices of a pie chart manually to emphasize the slices.

> Pie of pie and bar of pie Pie of pie or bar of pie charts show pie charts with
smaller values pulled out into a secondary pie or stacked bar chart, which makes
them easier to distinguish.

Pie of pie Bar of pie

IV. Doughnut Chart

Data that’s arranged in columns or rows only on a worksheet can be plotted in a
doughnut chart. Like a pie chart, a doughnut chart shows the relationship of parts to
a whole, but it can contain more than one data series.

P o
e
i [
o

i
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Bar Chart: Data that’'s arranged in columns or rows on a worksheet can be plotted
in a bar chart. Bar charts illustrate comparisons among individual items. In a bar
chart, the categories are typically organized along the vertical axis and the values

along the horizontal axis.

Consider using a bar chart when:

» The axis labels are long.
» The values that are shown are durations.

Types of bar chart s
» Clustered bar and 3-D clustered bar A clustered bar chart shows bars in 2-D
format. A 3-D clustered bar chart shows bars in 3-D format; it doesn’t use a depth
axis.
— —

3-D clustered bar

Clustered bar
» Stacked bar and 3-D st acked bar Stacked bar charts show the relationship of
individual items to the whole in 2-D bars. A 3-D stacked bar chart shows bars in 3-

D format; it doesn’t use a depth axis.

1=
| =

30 stackea Dar

S{acked Dar

100% stacked bar and 3-D 100% st acked bar A 100% stacked bar shows 2-D bars
that compare the percentage that each value contributes to a total across categories.
A 3-D 100% stacked bar chart shows bars in 3-D format; it doesn’t use a depth axis.

o siacked Dar
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VI. Area Chart

Data that’s arranged in columns or rows on a worksheet can be plotted in an area
chart. Area charts can be used to plot change over time and draw attention to the
total value across a trend. By showing the sum of the plotted values, an area chart
also shows the relationship of parts to a whole.

Sales by Region

Types of area chart s

» Areaand 3-D area Shown in the 2-D or 3-D format, area charts demonstrate the
trend of values over time or other category data. A 3-D area chart uses three axes
(horizontal, vertical, and depth) that one can change.

Area 3-D area

» Stacked area and 3-D st acked area  Stacked area charts show the trend of the
contribution of each value over time or other category data in 2-D format. A 3-D

stacked area chart does the same, but it shows areas in the 3-D format without using
a depth axis.

A 1 .
| oy, - i"'- ~ I
| % Vs . 4

“ . ; lI

Stacked area 3-D stacked area

» 100% stacked area and 3-D 100% st acked area 100% stacked area charts
demonstrate the trend of the percentage that each value contributes over time or
other category data. A 3-D 100% stacked area chart does the same, but it presents
areas in the 3-D format without using a depth axis.

A |

100% stacked area 3-D 1

—
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VII. Scatter Chart

Data that's arranged in columns and rows on a worksheet can be plotted in anXY
(scatter) chart. Place the x values in one row or column, and then enter the
corresponding y values in the adjacent rows or columns.

A scatter chart has two value axes: a horizontal (x) and a vertical (y) value axis. It
combines x and y values into single data points and shows them in irregular intervals,
or clusters. Scatter charts are typically used for showing and comparing numeric
values, like scientific, statistical, and engineering data.

Consider using a scatter chart when:

>

YV V V V

>

You need to change the scale of the horizontal axis.
You need to make that axis a logarithmic scale.
Values for the horizontal axis are not evenly spaced.
There are many data points on the horizontal axis.

You want to adjust the independent axis scales of a scatter chart to reveal more
information about data that includes pairs or grouped sets of values.

You want to show similarities between large sets of data instead of differences
between data points.

You want to compare many data points without regard to time—the more data that
you include in a scatter chart, the better the comparisons you can make.

Types of scatter chart s

>

Scatter This chart shows data points without connecting lines to compare pairs of
values.




» Scatter with smooth lines and markers and scatter with smooth lines This chart
shows a smooth curve that connects the data points. Smooth lines can be shown
with or without markers. Use a smooth line without markers if there are many data

points.
=, | |
f L ]
| ® “oe
Scatter with smooth Scatter with
INes and markers smooth lines
» Scatter with straight lines and markers and scatter with straight lines This

chart shows straight connecting lines between data points. Straight lines can be
shown with or without markers.

SCattEr with straight Scatier wit

nes and markers ctraight lines

VIIl. Bubble Chart

Much like a scatter chart, a bubble chart adds a third column to specify the size of the
bubbles it shows to represent the data points in the data series.

Industry Market Share Study

Type of bubble chart s

» Bubble or bubble with 3-D effect Both of these bubble charts compare sets of
three values instead of two, showing bubbles in 2-D or 3-D format (without using a
depth axis). The third value specifies the size of the bubble marker.
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Bubble Bubble with 3-D effect

IX. Radar
A radar chart compares the aggregate values of many data series.
10.3Create a chart with Insert Chart s
Follow the steps:
Step 1 ” Select the data for the chart.
Step 2 ” Click the Insert tab on the Ribbon.
Step 3 ” Click the Desired Chart on the Ribbon.
Step 4. Select Ok.
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To create a chart with a short method, just select the data you want in the chart and
press ALT+FL1. It willimmediately create a chart. The disadvantage of this method is that the
resultant chart may not be the best fit for your data or as per your requirement.

' r & 1
Vo & &

-0 M ) i il i oW | e— g

| 3 T e
| ] = 1
i [ T T—————
= L] T [
1 {reh L T M
4 i M i 7
- L] £} "
&l =T} [ -
el ki i "
Ehan T

J

25 ol W it

If you're not sure which type of chart to use, the Recommended Chart s command
will suggest several different charts based on the source data.
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Change Chart T ype
You can easily change to a different type of chart at any time.
1. Select the chart.
2. Right Click on the chart, and click Change Chart Type.
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Note: On the Chart Design tab, in the Type group, click Change Chart Type.
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3. Select the Chart then click Ok
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The final result will be like this,
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10.4 Scatter Chart

Now, let us see the steps to create a scatter chart. The following procedure will help
you create a scatter chart in easy steps. For this chart, we used the example worksheet
data.

1. Select the data you want to plot in the scatter chart.
2. Click the Insert tab, and then click Insert Scatter (X, Y) or Bubble Chart
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The final result will be like this:

PARTICULATE

10.5 Curve Fitting
Excel charts provide a very convenient way to fit a curve into the experimental data.
> First, create a data set of two variables
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1 . x ¥

2 1 5
3 | 2 13
4 3 13
5 4 53
6 | 5 11
7 3 64
8 7 32
9 8 23
10 9 12
1 10 4
12 11 8
13 12 13
14 13 a4
15 | 14 3
16| 15 a3

&
|

» Create a scatter chart .

Chart Title

» Thenright-click on the data series and select "Add T rendline.” and then click More
Options .

> In the window that appears to the right, click the button next to Polynomial . Then
check the boxes next to Display Equation on chart and Display R-squared value
on chart .

The equation of the curve is as follows:
y = 0.0879x? - 1.0495x + 27.062

The R-squared value state the percentage of variation in the response variable. The
value of R-squared is 0.0138 for this curve.
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The curve we get for this value is not flexible. To make it more flexible we can try to
increase the polynomial order to 4 from 2. This will give the following equation.

y =-0.0083x* + 0.4394x3 - 6.8879x? + 37.319x - 26.659
and the resultant curve will be like this,

Chart Title
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The R-squared value for this particular curve is0.3794. As you can see that this R-
squared value is comparatively higher than that of the previous curve, which shows that it fits
the dataset much more closely.

10.6 Summary
In this chapter, we have studied:
» About the concept of graphs presentation in excel
> Different types of charts available in Excel with their creation
» Modification of charts as per user requirement
> Best Curve fitting for the given set of data
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10.7 Answer to Self-Check exercises

Q.1 What is graph presentation? Give examples.

Q.2 Discuss 5 types of charts with their applications?
Q.3 How to change a chart type?

Q.4 Explain the role of polynomial order in curve fitting.

10.8 Suggested Readings
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Ron Mansfield, The Compact Guide to Microsoft office; BPB Publication
Dienes, Sheila s., Microsoft office, Professional for windows 105

Joan Lambert, Curtis Frye, Microsoft Office Step by Step (Office 2021 and Microsoft
3105),Microsoft Press Publication

Kenneth N. Berk, Data Analysis with Microsoft Excel
Wayne L. Winston,Microsoft Excel 2013: Data Analysis and Business Modeling

Danielle Stein, Using Excel for business analysis: a guide to financial modelling
fundamentals

Olafusi M., Microsoft Excel and Business Data Analysis for The Busy Professional
Rajiv Mattus: Learning Excel 1010 for windows step-by-step BPB publication
Lonnie.E. Moseley & David M. Boodey: Mastering office 1010

Micro Soft Office 1010: Unleashed: Techmedia.

John Walken Bach: Excel 1010.
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Chapter-11
REPORT WRITING

STRUCTURE

11.0 Learning Objectives
11.1 Introduction
11.2 Report Writing
11.3 Features of a Research Report
11.4 Significance of Report Writing
11.5 Different Steps in Writing the Report
11.6 Guidelines for Writing a Report
11.7 Layout of the Research Report
11.7.1 Preliminary Part
11.7.2 Main Body
11.7.3 End Part
11.8 Mechanics of Writing a Research Report
11.9 Ethics in Research
11.10 Summary
11.11 Glossary
11.12 Answers to Self-Check Exercises
11.13 Suggested Readings
11.14 Terminal Questions

11.0 Learning Objectives

After going through this lesson you will be able to:

Define a Report,

Explain the significance of report writing

Discuss the different steps in writing the reports
Identify the Mechanics in writing a research report
Explain the ethics in research

11.1 Introduction

The last and final chapter of the voyage in research is writing of the report. After the
collected data has been analyzed and interpreted and generalizations have been drawn the
report has to be prepared. The task of research is incomplete till the report is presented.
Writing of a report is the last step in a research study and requires a set of skills somewhat
different from those called for in respect of the earlier stages of research. This task should

be accomplished by the researcher with utmost care.
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11.2 Report W riting

Aresearch report is a publication that reports on the findings of a research project or

alternatively scientific observations on or about a subject. Normally the research assignments
like projects, investigations, explorations, theses, dissertations fall in this category. Aresearch
report is a well-crafted document that outlines the processes, data, and findings of a
systematic investigation. Itis an important document that serves as a first-hand account of
the research process, and it is typically considered as an objective and accurate source of
information.

11.3 Features of a Research Report

A good research report is marked by certain features:

)

(2)

(3)

(4)

(5)

(6)

A good research report should be written lucidly, precisely in simple language and
should provide a detailed presentation of the whole of research processes. It should
present the data in tables and figures with suitable objective explanations. The end
part should include the concluding remarks, the prime findings and recommendations,
if any.

The language and style should be academic, formal, less flaunting and simple.

The reportis normally based on the first hand information collected by the researcher.
However, the reports written on the basis of secondary data are also presented in a
systematic and lucid manners.

A research report should normally be written in the third and avoid use of pronouns
like, ‘I, ‘Me’, ‘My’ etc.

The report should facilitate the reader with systematic presentation like proper
headings, titles, sub-tiles, tables, graphs, parts and even bullet points where required.
The reports normally forward recommendations too as the solutions to the problems
and policy making by the concerned authorities, corporate organizations, institutions
and governments.

11.4 Significance of Report W riting
The significance of report writing can be understood from following points.

(1)

()

(3)

(4)

Report gives merged information-  Report presents large information in compressed
form.

Present complicated matters easily-  Report writing is best way to represent any
complicated matter easily and attractively.

Facilit ates Decision making and planning-  Decisions can be easily made based
on the recommendations given in report.

Builds relationship- report build relationship between author and reader. It creates
impression on author’s knowledge and philosophy between author and reader. It
creates impression on author’s knowledge and philosophy and also provides insight
regarding his analytical and critical understanding.
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(5)

(6)

(7)

(8)

(9)

Unveil Unknown Information-  Report gives its readers hitherto to unknown
information about the problem or issue.

Provides foundation for future research- Report provides information in terms of
tables, graphs, charts and illustration and therefore we can be aware of facts and
figures as an update. One can re-use this information for future reference.

Augment writing skills in presenting practical work- Writing report is not a layman’s
task. The rewriting and editing again and again enhances the writing skills of researcher.

Highlight s import ant details about the research process- Report highlights
important details about the research process. By simply going through the report one
can know the objectives, methodology and results of research.

Permanent record and is easy to verify-  The written report is as a permanent
record. When it is needed, important information can be easily collected from the
preserved report. The information and messages that are preserved can be verified
easily. If there arises any misunderstanding any party can easily verify the information.

11.5 Different S teps in Writing the Report

Research reports are the product of slow, painstaking, accurate inductive work. The

usual steps involved in writing report are(a) logical analysis of the subject-matter;(b)
preparation of the final outline;(c) preparation of rough draft;(d) rewriting and polishing; (e)
preparation of the final bibliography; and (f) writing the final draft. Though all these steps are
self-explanatory, yet a brief mention of each one of these will be appropriate for better
understanding. We discuss each of them in detail in the following paragraphs.

(i)

(ii)

(iii)

Logical, analysis of the subject matter- It is the first step which is primarily
concerned with the development of a subject. There are two ways in which to develop
a subject- (a) logically and (b) chronologically. The logical development is made on
the basis of mental connections and associations between the one thing and another
by means of analysis. Logical treatment often consists in developing the material
from the simple possible to the most complex structures. Chronological development
is based on a connection or sequence in time or occurrence. The directions for doing
or making something usually follow the chronological order.

Preparation of the final outline- It is the next step in writing the research report.
“Outlines are the framework upon which long written works are constructed. They
are an aid to the logical organization of the material and a reminder of the points to
be stressed in the report’.

Preparation of the rough draf t- This follows the logical analysis of the subject and
the preparation of the final outline. Such a step is of utmost importance for the
researcher who sits to write down what he has done in the context of his research
study. He will write down the procedure adopted by him in collecting the material for
his study along with various limitations faced by him, the technique of analysis adopted
by him, the broad findings and generalizations and the various suggestions he wants
to offer regarding the problem concerned.
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(iv)

(v)

Rewriting and polishing the rough draf  t- This step happens to be the most difficult
part of all formal writing. Usually this step requires more time than the writing of the
rough draft. The careful revision makes the difference between a mediocre and a
good piece of writing. While rewriting and polishing, one should check the report for
weakness in logical development or presentation. The researcher should also “see
whether or not the material, as it is presented, has unity and cohesion; does the
report stand upright and firm and exhibit a definite pattern, like a marble arch? Or
does it resemble an old wall of moldering cement bricks and loose bricks”. In addition
the researcher should give due attention to the fact that in his rough draft he has been
consistent or not. He should check the mechanics of writing-grammar, spelling and
usage.

Preparation of the final bibliography —  Next in order comes, the task of the
preparation of the final bibliography. The bibliography, which is generally appended
to the research report, is a list of books in some way pertinent to the research which
has been done. It should contain all those woks which the researcher has consulted.
The bibliography should be arranged alphabetically and may be divided into two
parts; the first part may contain the names of books and pamphlets, and the second
part may contain the names of magazine and newspaper articles. Generally, this
pattern of bibliography is considered convenient and satisfactory from the point of
view of reader, though it is not the only way of presenting bibliography. The entries
on bibliography should be made adopting the following order:

For books and pamphlets the order may be as under:

(vi)

1. Name of author, last name first.

2. Title, underlined to indicate italics.

3. Place, publisher, and date of publication
4. Number of volumes.

Writing the final draf t — This constitutes the last step. The final draft should be
written in a concise and objective style and in simple language, avoiding vague
expressions such as “it seems”, there may be” and the like ones. While writing the
final draft, the researcher must avoid abstract terminology and technical illustration
and examples based on common experiences must be incorporated in the final draft
as they happen to be most effective in communicating the research findings to others.
A research report should not be dull, but must enthuse people and maintain interest
and must show originality, It must be remembered that every report should be an
attempt to solve some intellectual problem and must contribute to the solution of a
problem and must add to the knowledge of both the researcher and the reader.
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11.6 Guidelines for W riting a Report

Researcher who are affective in report writing agree that there are a series of

guidelines which should be followed. Such guidelines can be enumerated as under:

Consider the Audience: Make the report clear, use only words familiar to the
readers and defined all technical terms. To make the comparison of figures easier,
usepercentages, rounded off figures, ranks or ratios; put the exact data in a table
within the text or in the appendix.

Address the information Needs:  Remember the research report is designed to
communicate information to decision makers. Make sure that it clearly relates the
research findings to the objectives of the management.

Be Concise, Yet Complete: Most managers will not want to read about the details
of a research report. Knowing what to include and what to leave out is a difficult
task. Itis up to you, the researcher, to take into account the information needs of the
decision maker when writing your report.

Be Objective: You will probably face at least one situation in which you know that
the client will not easily accept the results. The findings may be conflict with the
decision makers experience and judgment or they may reflect unfavorable on the
wisdom of previous decisions. In these circumstances, there is a strong temptation
to start the report by making the result more acceptable to the management. A
professional researcher, however, will present the research findings in an objective
manner and will present the research findings in an objective manner and will defend
their validity if they are challenged by the client.

Style: The style of writing a research report is important because it shows a way
of presentation. Here are a few a tips to help you write a report that is easy to read.
. Use short words and sentences.

. Be concise.

. Use the active voice

. Consider appearance-space makes a long report easier to read.

. Avoid clichés.

. Write in present tense.

11.7 Layout of the Research Report

Major Part s Sections

a) Preliminary Part 1. Title

2. Certificate/Authorisation document
3. Contents

4. Preface & Acknowledgements

5. List of Tables/Figure

6. Acronyms (If applicable)
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b) Main Body . Introduction

. Review of Literature

. Research Objectives/Questions/Hypotheses
. Research Methodology

. Data Analysis/Results/Discussion

. Conclusions and Findings

~N o O~ WODN P

. Recommendations

c) End Part 1. Endnotes/References
2. Appendices

3. Bibliography

4. Index

11.7.4 Preliminary Part

Preliminary part of a research report includes the title page of the report, certificate
of authentication by the research supervisor or letter of accreditation/authorisation by research
sponsoring agency, the contents of the report based on the chapter scheme, foreword,
preface and acknowledgements, and the list of tables or figures, if any. Usually, foreword is
written by an expert of the area. Preface is the face of report i.e. a brief discussion about
the research problem, objectives and researcher’s approach about dealing with it. Tables or
figures are normally numbered on the basis of Chapter No. and tables in continuity e.g Table
No.1.1; 1.2; 1.3; 1.4; 1.5 or Table 2.1; 2.2; 2.3; 2.4 etc.

11.7.5 Main Body
1. Introduction

Introduction is the most important part of the report since it introduces the topic, the
objectives, the methodology and the context or background in which the problem is discussed.
Background information may include a brief review of the literature already available on the
topic so that you are able to ‘place’ your research in the field. Some brief details of your
methods and an outline of the structure of the report and the purpose, significance and
implications of the study should be discussed too.

2. Review of Literature

‘Literature Survey'’ is the first major task to be performed by a researcher before and
after the selection of problem. It could be done even before selection of problem to determine
the research problem to be selected. The reason of carrying out a Literature Survey is to
exhibit and develop one’s familiarity with other people’s works related with the research
problem chosen. It normally involves the survey or search of written works in the shape of
books and papers in academic journals, and also speeches, letters, documents, films or
other outputs. There are many types of Literature Survey, andit depends on one’s needs like
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looking through citations, quotations, bibliographies, indexes etc. In literature review the
major works related with research problems are reviewed in brief. The review could be done
on the basis of classification of works thematically or could be done in chronological order.
The researcher should be able to underline the major argument, content or finding of the
work reviewed and present that analytically in reference to the research problem showing
the existing gap, difference or lag in the study.

3. Research Methodology

Research Methodology means the adoption of the special procedures, tools and
techniques in order to find, categorise, select, process, and analyze information about a
particular research problem. In a research document, be it a paper, dissertation, thesis or
project the methodology section allows the reader to critically evaluate a study’s overall
validity and reliability. Jansen and Warren (2020) observe that the research methodology
simply refers to the practical “how” of any given piece of research. More specifically, it's
about how a researcher systematically designs a study to ensure valid and reliable results
that address the research aims and objectives. It includes research approach, sample plan,
data sources, questionnaire type etc.

In methodology section the researcher discusses in details the research methodology
he has followed i.e. what he did and how he did it. Methodology should be clearly written so
that other researcher could also understand it and follow it in similar kind of research
endeavours. Methodology is normally written in a passive voice e.g. ‘the population was
selected on the basis of stratified sampling’ or ‘the respondents were asked to answer the
guestions’ instead of writing in active voice e.g. | asked the respondents to fill the questionnaire’.

4. DataAnalysis

‘Data Analysis’ is the step to be followed once the first-hand information has been
collected. It refers to the process to examine, elicit, elucidate and explain the data, in the
course of which concepts or theories are likely to be considered, advanced and developed.
The application of tools or techniques depends upon the nature of the data and suitability of
the tools for analysing it. It is also classified into preliminary analysis or hypotheses testing.
While the former involves the presentation of data in graphs or tables the latter refers to
testing of the inferences (hypotheses) made in the beginning. The data can be small, medium
or large in quantum and quantitative (numeric) or qualitative (textual) in nature.

5. Results

The results represent the findings of the study based upon the methodology or
methodologies applied in collection of data and the tools and techniques applied in data
analysis. The results should statethe findings of the research in a systematic manner and in
logical sequence without bias or interpretation. It is here where the researcher indicates
what he has found. In simple words it is the data collected and arranged systematically
ready for interpretation.
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6. Discussion

Discussion mostly forms part of the natural science or quantitative studies. However,
they can be used in social sciences too wherever the data is presented cartographically in
guantitative manner or patterns or figures drawn even in qualitative research. The purpose
of the discussion is to interpret and describe the significance of your findings in light of what
was already known about the research problem being investigated, and to explain any new
understanding or fresh insights about the problem after you've taken the findings into
consideration. The discussion will always connect to the introduction by way of the research
guestions or hypotheses you posed and the literature you reviewed, but it does not simply
repeat or rearrange the introduction; the discussion should always explain how your study
has moved the reader’s understanding of the research problem forward from where you left
them at the end of the introduction’ (Paul 2008). In this section one discusses the relevance
of results and how the findings fit with other research in the area. It will relate back to your
literature review and your introductory thesis statement.

7. Conclusion

Conclusion refers to the broad drawing of the study done and the major findings and
suggestions made. It can also be called the summary of the major findings of the study. In
conclusions the researchers are advised not to include any new information or idea not
discussed in the previous chapters. However, one can specify the limitations of the study
and the zones of its utility and applications.

8. Recommendations

Normally recommendations are included in the concluding part or in conclusions.
However, they can be presented separately too. Recommendations include suggestions for
what needs to be done as a result of your findings. Recommendations are usually listed in
order of priority.

11.7.6 End Part

The End Part’ of the report comprises of endnotes, references, appendices,
bibliography and indexes. It also includes endnotes if foot notes are not used in the report.
Endnotes are like footnotes but are located at the back rather than the bottom of each page.
These would include all of the references for all works cited in the review of related literature
or any other sections of the report as well as the references for quotations, either direct or
indirect, taken from other sources, or any footnote comments that might have been included.
These are listed in numeric order as presented in the text (Hill, 1970).

1. Bibliography
Bibliography includes all the references used in the report or referred to for background

information. Bibliography preparation is based on specific patterns. Kindly check the
stylesheets for learning how to prepare a bibliography.
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2. Appendices

Any information in the forms of tables/figures, acts, documents, letters, speeches or
other materials which is not totally central to the analysis but needs to be mentioned is
placed in appendices. They should add extra information to the report. If you include
appendices they must be referred to in the body of the report and must have a clear purpose
for being included. Each appendix must be named and numbered.

3. Abstract/Synop sis

Many universities have the tradition of asking for the abstracts of the thesis or
dissertations. The purpose is to supply in brief the essence of the work done. Abstracts give
a very brief overview of the report in a condensed form ranging from introduction to the
conclusions.

11.8 Mechanics of W riting a Research Report

There are very definite and set rules which should be followed in the actual preparation
of the research report or paper. Once the techniques are finally decided, they should be
scrupulously adhered to, and no deviation permitted. . The criteria of format should be
decided as soon as the materials for the research paper have been assembled. The following
points deserve mention so far as the mechanics of writing a report are concerned:

() Size and Physical Design- The manuscript should be written on unruled paper
8 "x11’in size. If it is to be written by hand, then black or blue-black ink should be
used. A margin of at least half an inch at the right hand of the paper. There should also
be one —inch margins, top and bottom. The paper should be neat and legible /if the
manuscript is to be typed, then all typing should be double-spaced on one side of the
page only except for the insertion of the long quotations.

(i) Procedure — various steps in writing the report should be strictly adhered

(i) Layout- Keeping in view the objective and nature of the problem, the layout of the
report should be thought of and decided and accordingly adopted.

(iv) Treatment of Quot ations- Quotations should be placed in quotation marks and
double spaced, forming an immediate pat of the text. But if a quotation is of considerable
length (more than four or five type written lines) then it should be single-spaced and
indented at least half an inch to the right of the normal text margin.

(v) The footnotes — Regarding footnotes one should keep in view of the followings:

(a) The footnotes serve two purposes viz., the identification of materials used in quotations
in the report and the notice of materials not immediately necessary to the body of the
research text but still of supplemental value. In other words, footnotes are meant for
cross references, citation of authorities and sources, acknowledgement and elucidation
or explanation of a point of view. It should always be kept in view that footnote is
neither an end nor a means of the display of scholarship. The modern tendency is to
make the minimum use of footnotes for scholarship does not need to be displayed.
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(b)

(c)

(d)

(6)

(i)

(iii)

Footnotes are placed at the bottom of the page on which the reference quotation
which they identify or supplement ends. Footnotes are customarily separated from
the textual material by a space of half an inch and a line about one and a half inch
long.

Footnotes should be numbered consecutively, usually beginning with 1 in each chapter
separately. The number should be put slightly above the line, say at end of a quotation.
At the foot of the page, again, the footnote number should be indented and typed a
little above the line. Thus, consecutive numbers must be used to correlate the reference
in the text with its corresponding note at the bottom of the page, except in the case
of statistical tables and other numerical material, where symbols such as the asterisk(*)
or the like one may be used to prevent confusion.

Footnotes are always typed in single space though they are divided from one another
by double space.

Document ation style— regarding documentation, the first footnote reference to any
given work should be complete in its documentation, giving all the essential facts
about the edition used. Such documentary footnotes follow a general sequence. The
common order may be described as under:

Regarding the single-volume reference

1. Author’s name in normal order(and not beginning with the last name as in a
bibliography) followed by a comma;

2.  Title of work, underlined to indicate italics;
3. Place and date of publication;
4. Pagination references(The page number)
Regarding multi-volumed reference

1. Author’s name in normal order(and not beginning with the last name as in a
bibliography) followed by a comma;

2. Title of work, underlined to indicate italics;

3. Place and date of publication;

4. Pagination references(The page number)
Regarding woks arranged alphabetically

For works arranged alphabetically such as encyclopedia and dictionaries, no pagination
reference is usually needed. In such cases the order is illustrated as under:

Example 1

“Salamanca.” Encyclopaedia Bitannica,14" Edition.
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(iv) Regarding periodicals reference
1. Name of the authorin n
Title of article, in quotation marks;
Name of periodical, underlined to indicate italics’
Volume Number
Date of issuance

R Wb

6. Pagination
(iv) Regarding anthologies and collections reference

Quotations from anthologies or collection of literary works must be acknowledged
not only by author, but also by the name of the collector.

(v) Regarding second-hand quotations reference
In such cases the documentation should be handled as follows:
1. Original autor an title’
2. ‘quoted or cited in”;
3. Second author and work.
Example

J.f.Jones, Life in Ployensia,p.16, quoted in History of the Pacific Ocean area, R.B,
Abel,p.191.

(vii) Case of multiple authorship

If there are more than two authors or editors, then in the documentation the name of
only the first is given and the multiple authorship is indicated by “et al.” or “and others’.

Subsequent references to the same work need not be detailed as stated above. If
the work is citied again without any other work intervening, it may be indicated as
ibid, followed by a comma and the page number. A single page should be referred to
as p., but more than one page be referred to as pp. If there are several pages
referred to at a stretch, the practice is to use often the page number, for example,
pp. 190ff, which means page number 190 and the following pages; but only for page
190 and the following page ‘190f. Roman numerical is generally used to indicate the
number of the volume of a book. Op. cit, (opera citato, in the work cited) or Loc. Cit.
(loco citatao, in the place cited) are two of the very convenient abbreviations used in
the footnotes. Op. cit, or Loc. Cit, after the writer's name would suggest that the
references is to work by the writer which has been cited in detail in an earlier footnotes
but intervened by some other references.

7. Punctuation and abbreviations in footnotes- the first item the number in the
footnote is the author’s name, given in the normal signature order. This is followed by
a comma. After the comma, the title of the book is given: the article (such as “A”,
“An”, “The” etc.) is omitted and only the first word and proper nouns and adjectives
are capitalized. The title is followed by a comma. Information concerning the edition
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10.
11.

is given next. This entry is followed by a comma. The place of publication is then
stated; it may be mentioned in an abbreviated form, N.Y. for New York, N.D. for New
Delhi and so on. This entry is followed by a comma. Then the name of the publisher
is mentioned and this entry is closed by a comma. It is followed by the date of
publication and this entry is closed by a comma. Itis followed by the date of publication
if the date is given on the title page. If the date appears in the copyright notice on the
reverse side of the title page or elsewhere in the volume, the comma should be
omitted and the date enclosed in square brackets[c 1978], [1978]. The entry is
followed by a comma. Then follow the volume and page references and are separated
by comma if both are given. A period closes the complete documentary reference.
But one should remember that the documentation regarding acknowledgements from
magazine articles and periodical literature follow a different form as stated earlier
while explaining the entries in the bibliography.

Use of st atistics, chart s and graphs — A judicious use of statistics in research
reports is often considered a virtue for it contributes a great deal towards the
clarification and simplification of the material and research results. One may well
remember that a good picture is often worth more than a thousand words. Statistics
are usually presented in the form of tables, charts, bars and line-graphs and
pictograms. Such presentation should be self explanatory and complete in itself. It
should be suitable and appropriate looking to the problem at hand. Finally, statistical
presentation should be neat and attractive.

The final draf t— Revising and rewriting the rough draft of the report should be done
with great care before writing the final draft. For the purpose, the researcher should
put to himself questions like: Are the sentences written in the report clear? Are they
grammatically correct? Do they say what is meant? Do the various points incorporated
in the report fit together logically? “Having at least one colleague read the report just
before the final revision is extremely helpful. Sentences that seem crystal clear to the
writer may prove quite confusing to other people; a connection that had seemed self
evident may strike others as a non-sequitur. A friendly critic, by pointing out passages
that seem unclear or illogical, and perhaps suggesting ways of remedying the difficulties
can be an invaluable aid in achieving the goal of adequate communication.”

Bibliography- Bibliography should be prepared and appended to the research report.

Preparation of the index- At the end of the report, an index should invariably be
given, the value of which lies in the fact that it acts as a good guide to the reader.
Index may be prepared both as subject index and as author index. The former gives
the names of the subject-topics or concepts along with the number of pages on which
they have appeared or discussed in the report, whereas the latter gives the similar
information regarding the names of authors. The index should always be arranged
alphabetically. Some people prefer to prepare only one index common for names of
authors, subject-topics, concepts and the like ones.
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11.9 Ethics in research

Ethics are nothing but the accepted codes of conduct. The term is derived from a

Greek word ethos which means custom, habit, character or disposition. In research, ethics
are a method, procedure, or perspective for deciding how to act and for analyzing complex
problems and issues. Ethics are applied on all stages of research, such as planning, conducting
and evaluation. Webster dictionary defines ethical (behavior) as conforming to the standards
of conduct of a given profession or group.”

a)

Ethical Principles in Research
In research itis impossible to construct general ethical principles. But in social science

research there are some ethical principles which are very important.

(i)

(ii)

(iii)

(iv)

Principle of Autonomy- The principle of autonomy requires that protection be given
to potentially vulnerable populations such as children, the elderly, the mentally ill, or
prisoners. Individuals in these groups may be incapable of understanding information
that would enable them to make an informed decision about study participation. They
are considered potentially “vulnerable.” Consequently, careful consideration of their
situation and needs is required and extra care must be taken to protect them.

Principle of non-maleficence — The principle of “Non-Maleficence” requires an
intention to avoid needless harm or injury that can arise through acts of commission
or omission. Non-Maleficence asserts that the primary concern when carrying out a
research is to do no harm.

Principle of Beneficence — Beneficence obligates the researcher to secure the
well-being of all study participants. It is the responsibility of researcher to protect
participants from harm, as well as ensure that they experience the possible benefits
of involvement.

Principle of Justice — This principle of justice raises the question of who ought to
receive the benefits of research and bear its burdens. An injustice occurs when some
benefit to which a person is entitled is denied without good reason or when some
burden is imposed unduly. It requires that the benefits and risks of research should
be fairly distributed among people.

b) Import ant Ethical Guideline for Social Science Research

()

Integrity and Quality- Integrity and Quality relate to the honesty of a research how
honesty he or she undertakes a research. In research confidential communication,
such as papers or grants submitted to publication, personal records, trade or military
secrets, and patient records should be protected. The integrity of investigator is
must because any breach of integrity and quality weakens or even invalidated the
research.
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(ii)

(i)

(iv)

(V)

(vi)

(vii)

(viii)

(ix)

(x)

(xi)

Objectivity — Aresearcher should avoid personal bias and should try to bring objectivity
in research. He should minimize bias or self-deception in experimental design, data
analysis, data interpretation, peer review, grant writing and other aspects of research
where objectivity is expected or required.

Essentiality- For undertaking research, a researcher should give adequate
consideration to existing literature/ knowledge and its relevance. This will justify the
need for the study. It may be possible that there are alternatives available on the
subject/issue under the study and study is not required.

Confidentiality- The confidentiality of respondents should be maintained. They should
be assured that identifying information will not be made available to anyone who is
not directly involved in the study.

Anonymity- Anonymity means that the participant will remain anonymous throughout
the study-even to the researchers themselves. Clearly, it is standard of privacy, but
itis some time difficult to accomplish, especially in situations where participants have
to be measured at multiple time points like pre test and post test measurements, in
different situations, etc.

Free from coercion volunt ary particip ants- It requires that people should not be
compelled or forced to participate in research. This is especially relevant where
researchers has to rely on ‘captive audiences’ for their participants-prisons, universities,
and places like that.

Informed Consent- The prospective research participants must be fully informed
about the procedures and risks involved in research and should be taken in research
only after they give their consent to participate.

Legality- A researcher should be aware of all the legal aspects of the research
problem. He should know and obey relevant laws and institutional and governmental
policies and follow them

Maximization of public interest and of social justice- In social sciences research
is usually carried out for the benefit of society. Aresearcher should strive to promote
social good and prevent or mitigate social harms through research. The research
should be undertaken with the motive of maximization of public interest and social
justice.

Account ability and transp arency- The research should be conducted in a fair and
transparent way. The researcher should always be willing for social and financial
review of his or her research. Researcher should also make appropriate arrangements
for the preservation of research records for a reasonable period of time so that it can
be verified.

Independence and imp artiality of researcher- A researcher should work
independently and impartially. He should not get influenced and pressurized by the
funding agencies and authorities and should report and forecast factual results. He
should also not indulge in pseudo-pilot studies.
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11.10 Summary

Areport is prepared after interpretation of data. It is defined as a document in which
a given problem is examined for the purpose of conveying information, report findings,
putting forward ideas and sometimes making recommendations. A research report can be
classified into decision oriented report and popular report. In the popular report, the main
emphasis is on the methods employed, assumptions made in the course of study and the
detailed presentation of the findings including their limitations and supporting data. The
popular report is intended detail of research methods and terminology.

The contests of the research report must include preliminary pages, main text and
the end matter. Different steps involved in report writing are: logical analysis of the subject
matter, preparation of the final outline, preparation of the rough draft, rewriting and polishing,
preparation of the final bibliography, and writing the final draft.

11.11 Glossary

» Ethics- Ethics are nothing but the accepted codes of conduct. The term is deived
from a Greek word ethos which means custom, habit, character or disposition. In
research, ethics are a method, procedure, or perspective for deciding how to act
and for analyzing complex problems and issues.

* Plagiarism- Plagiarism is using other people’s work without acknowledging their
contribution it can be of passing off somebody else’s ideas, thoughts, theories,
words or stories as own. It is a kind of stealing from the original author.

» Fabrication- Fabrication is the international act of making up data or results and
recording or reporting them. For example suppose a researcher/interviewer completes
a questionnaire for a fictitious subject that he never interviewed.

* Falsification- Falsification is manipulating research materials, equipments, or
processes, of changing or omitting/ suppressing data or results without scientific or
statistical justification, such that the research is not accurately represented.

* Post factum — means occurring after the fact, or ex-post facto design is a quasi-
experimental study examining how an independent variable, present prior to the
study in the participants, affects a dependent variable.

* Quotation- quoting means repeating the author’s exact words. In some disciplines,
such as literary studies and history, quoting is used frequently to support the argument.

* Generalisation— which is an act of reasoning that involves drawing broad inferences
from particular observations, is widely-acknowledged as a quality standard in
quantitative research but more controversial in qualitative research.

11.12 Answers to Self-Check Exercises
1. Explain report writing?
2. What do you understand by ethics in research?

3. Explain Mechanics of report writing?
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11.14 Terminal Questions

1.
2.
3.

What is report writing? Discuss the different types of reports.
Discuss the guidelines to be taken in to account for writing a report.
Explain the layout of the research report.

*kkkk
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Chapter-12
REFERENCES STYLE IN RESEARCH REPORT

Structure
12.0 Learning Objectives
12.1 Introduction
12.2 Reference List (the Format)
12.3 References (Process of Writing)
12.4 Reference List and Print Sources
12.5 Electronic Sources
12.6 Book on CD, Tape and Movie
12.7 Reference Specifications
12.8 Abstract from Secondary Data Base
12.9 Footnotes
12.10 General Guidelines to Write References
12.11 Summary
12.12 Glossary
12.13 Answers to Self-check Exercise
12.14 Suggested Readings
12.15 Terminal Questions
12.0 LearningObjectives
After reading this chapter, you will be able to:

[ explain how to write references in a scientific research report as per APA;
[ describe the art of referencing; and
® write a research report references in APA format.

12.1 Introduction

The reference section is a very important component of the report. It contains all the
necessary literature that have been referred to before, during and after the study and
contains books, journal articles and documents from where the materials have been referred
to. References differ from bibliography in that references are those literature which have
been cited in the main text of the report in different places. Bibliography includes many
referred as well as many unreferred literature in the text of the report. Sometimes a book
would have been consulted but not necessarily referred to in the text. Thus the bibliography
will be inclusive of many materials which have not been referred in the text. Of course it may
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contain the referred materials also. On the other hand the references will contain basically
the referred materials. In this unit we are going to focus on references, how to write the
same and the importance of reference etc. Basically we will be depending on the APA
source for this purpose.

12.2 Reference List (The Format )

As per Publication Manual of American Psychological Association (Sixth Edition,
2009) just as data in the paper support interpretations and conclusions, so Reference
citations support document statements made about the literature.

All citations in the manuscript must appear in the Reference list, and all References
must be cited in the text.

The Reference list should be succinct, not exhaustive; simply provide sufficient
references to support your Research. Choose References judiciously and cite them accurately.
For example, if you retrieve an abstract but do not also retrieve and read the full article, your
Reference should be identified as an abstract.

The standard procedures for citation ensure that References are accurate, complete,
and useful to investigators and readers.

Whenever possible, support your statements by citing empirical work, such as method
and results of an empirical study or a review of empirical studies (Lalumiere, 1993). When
you cite nonempirical work, make this clear in your narrative as given in the examples below
(see the box).

Tripathi (1991) theorized that Pandey (inpress) argued that Parmeshwar( 1993).

Similarly, when you want to direct the reader to background information, signal the
reader with phrases such as “for a review, see” and “(e.g., see [author, year]).

“References” section begins at a new page with the label “References” at the centre.
References comprise all documents including journals, books, technical Reports, computer
programmers and unpublished works mentioned in the text of the Report.

References are arranged in alphabetical order by the last name of the author(s) and
the year of publication in parenthesis or in case of unpublished citations, only the Reference
is cited.

Sometimes no author is listed and then, in that condition the first word of the title or
sponsoring organisation is used to begin the entry. When more than one name is cited within
parenthesis, the References are separated by semicolons.

In parenthesis page number is given only for direct quotations. The Researcher
should check carefully that all References cited in the text appear in.
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12.3 References (Process of Writing)

References should not be confused with Bibliography. A bibliography contains
everything that is included in the Reference section plus other publications which are useful
but were not cited in text or manuscript. Bibliography is not generally included in Research
Reports. Only References are usually included.

Referencesin APA Format

The APA style guide prescribes that the Reference section, Bibliographies and other
lists of names should be accumulated by surname first, and mandatory inclusion of surname
prefixes. For example, “Martin de Rijke” should be sorted as “De Rijke, M” and “Saif Al
Falssi” should be sorted as “Al-Falasi, S.” (The preference forArabic names now is to
hyphenate the prefix so that it remains with the surname.).

Reference citations in text are done using parenthetical referencing. Most usually,
this involves putting the author’s surname and the date of publication within parentheses,
separated by a comma, generally placed immediately after the Reference or at the end of
the sentence in which the Reference is made.

However, it is also common for the authors to be the subject or object of a sentence.
In such a case only the year is in parentheses. In all cases of citation, author name(s) are
always followed immediately by the year in which the article was published. In the case of
a quotation, the page number is also included in the citation.

Full bibliographic information is then provided in a Reference section at the end of the
article. APA style defines that the Reference section may only include articles that are cited
within the body of an article. This is the distinction between a document having a Reference
section and a Bibliography, which may incorporate sources read by the authors as background
but not referred to or included in the body of a document.

Let us now see how to write references if it is single author, multiple author etc.
® Single author

Format should be Author’s last name followed directly by a comma, then the year of
publication. When one makes the Reference to the author(s) directly as a part of the narrative,
then only the year (and page number if needed) would remain enclosed within parentheses.
The same holds for multiple authors.

Examples are given below:

“A recent study found a possible genetic cause of alcoholism (Pauling, 2005).” “Pauling
(2005) discovered a possible genetic cause of alcoholism.”
® Two authors

Authors should be presented in order that they appear in the published article. If they

are cited within closed parentheses, use the ampersand (&) between them. If not enclosed
in parentheses then use expanded “and”.

Examples are given below:
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“A recent study found a possible genetic cause of alcoholism (Pauling & Liu, 2005).”
“Pauling and Liu (2005) discovered a possible genetic cause of alcoholism.”

® Three to five authors

With three to five authors, the first Reference to an article includes all authors.
Subsequent citations in the same document may refer to the article by the principal author
only plus “et al.”

All authors must be present in the References section.
A recent study found a possible genetic cause of alcoholism (Pauling, Liu, &Guo, 2005).
Examples are given below:

“Pauling, Liu, and Guo (2005) conducted a study that discovered a possible genetic cause
of alcoholism.”

“Pauling et al. (2005) discovered a possible genetic cause of alcoholism.”
“A recent study found a possible genetic cause of alcoholism (Pauling et al., 2005).”
® Six or seven authors
The correct format in the text is (First Author et al., Year) or First Author et al. (Year).
Examples given below:
“Brown et al. (2005) discovered a possible genetic cause of alcoholism.”

In the Reference section, all authors’ names should be included if there are six or seven
authors.

® Eight or more authors

In the text, the first and all subsequent References should be to First Author et al.
(Year) or (First Author et al., Year).

In the Reference list, list the first six authors, and then put an ellipsis (three periods),
and then list the last author.
Example given below:

“Brown, A.B., Johnson, C., Laird, K., Howard, O. P., Evans, S., . . . Pritchard, J.
(2004) (study has eight or more authors)”
® Multiple publications, same author

If an author has multiple publications that you wish to cite, you use a comma to
separate the years of publication in chronological order (oldest to most recent). If the
publications occur in the same year, the Publication Manual recommends using suffixes a,

b, c, etc. (note that corresponding letters should be used in the Reference list, and these
References should be ordered alphabetically by title).

Example given below:

“Recent studies have found a possible genetic cause of alcoholism (Pauling, 2004,
2005a, 2005b).”
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“Pauling (2004, 2005a, 2005b) has conducted studies that have discovered a possible
genetic cause of alcoholism”

® Multiple publications, different authors

Follow the rules for one author above, and use a semicolon to separate articles.
Citation should first be in alphabetical order of the author, thenchronological.

Example given below:

“Recent studies found a possible genetic cause of alcoholism (Alford, 1995; Pauling,
2004, 2005; Sirkis, 2003)”
® Direct quotes

The same rules as above apply here, the format being (Author, Year, Page Number).
Example given below:

“When asked why his behaviour had changed so dramatically, Max simply said, “I
think it's the reinforcement” (Pauling, 2004, p. 69).”

12.4 Reference List and Print Sources

The APA style guide prescribes that the Reference section, Bibliographies and other
lists of names should be accumulated by surname first, and mandates inclusion of surname
prefixes. For example, “Martin de Rijke” should be sorted as “de Rijke, M.” and “Saif Al-
Falasi” should be sorted as “Al-Falasi, S.”

For names in non-English languages, follow thecapitalisation standards of that
language. For each of the source types below a hanging indent should be used where the
first line is flush to the left margin and all other lines are indented.

Book by one author

Sheril, R. D. (1956). The terrifying future: Contemplating color television. San Diego,
CA: Halstead.

Book by two authors

Kurosawa, J., & Armistead, Q. (1972).Hairball: An intensive peek behind the surface
of an enigma. Hamilton, Ontario, Canada: McMaster University Press.

Chapter in an edited book

Mcdonalds, A. (1993). Practical methods for the apprehension and sustained
containment of supernatural entities. In G. L. Yeager (Ed.),Paranormal and occult studies:
Case studies in application (pp. 42—64). London, England: OtherWorld Books.
Dissertation (Ph.D. or masters)

Mcdonalds, A. (1991). Practical dissertation title (Unpublished doctoral
dissertation).University of Florida, Gainesuville, FL.

Article in a journal with continuous pagination (nearly all journals use
continuous pagination)
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Rottweiler, F. T., &Beauchemin, J. L. (1987). Detroit and Narnia: Two foes on the
brink of destruction. Canadian/American Studies Journal, 54, 66—-146.

Kling, K. C., Hyde, J. S., Showers, C. J., &Buswell, B. N. (1999). Gender differences
in self-esteem: A meta-analysis. Psychological Bulletin, 125, 470-500.
Article in a journal paginated separately Journal_pagination

Crackton, P. (1987). The Loonie: God’s long-awaited gift to colourful pocket change?
Canadian Change, 64(7), 34-37.
Article in a weekly magazine

Henry, W. A,, 1. (1990, April 9). Making the grade in today’s schools. Time, 135, 28-31.
Article in a weekly magazine with DOI

Hoff, K. (2010, March 19). Fairness in modern society.Science, 327, 1467-1468.
doi:10.1126/science.1188537
Article in a print newspaper
Wrong, M. (2005, August 17). “Never Gonna Give You Up” says Mayor. Toronto Sol, p. 4.
12.5 Electronic Sources

For electronic References, websites, and online articles, APA Style asserts some
basic rules, including to direct readers specifically to the source material using URLS which

work include retrieval date ONLY when content is likely to change (e.qg., wikis) include all
other relevant APA Style details for the source.

Online article based on a print source, with DOI (e.g., a PDF of a print source from
a database)

Example is given below:

Krueger, R. F., Markon, K. E., Patrick, C. J., &lacono, W. G. (2005).Externalizing
psychopathology in adulthood: a dimensional-spectrum conceptualisation and its implications
for DSM-V. Journal of Abnormal Psychology, 114, 537-550. doi:10.1037/ 0021-
843X.114.4.537

Online article based on a print source, without DOI (e.g., a PDF of a print source
from a database)

Marlowe, P., Spade, S., & Chan, C. (2001).Detective work and the benefits of color
versus black and white.Journal of Pointless Research, 11, 123-127.

Online article from a database, no DOI, available ONLY in that database (proprietary
content—not things like Ovid, EBSCO, and PsycINFO)

Liquor advertising on TV. (2002, January 18). Retrieved from http://
factsonfile.infobasepublishing.com/
or

Liquor advertising on TV. (2002, January 18). Retrieved from Issues and Controversies

database.
139



Article in an Internet-only journal

McDonald, C., & Chenoweth, L. (2009). Leadership: A crucial ingredient in unstable
times. Social Work & Society, 7. Retrieved fromhttp://www.socwork.net/2009/1/articles/
mcdonaldchenoweth
Article in an Internet-only newsletter (eight or more authors)

Paradise, S., Moriarty, D., Marx, C., Lee, O. B., Hassel, E., . . . Bradford, J. (1957,
July). Portrayals of fictional characters in reality-based popular writing: Project update. Off
the Beaten Path, 7. Retrieved from http://www.newsletter.offthebeatenpath.news/otr/
complaints.html
Article with no author identified

Britain launches new space agency. (2010, March 24). Retrieved fromhttp://
news.ninemsn.com.au/technology/1031221/britain-launches-new-space-agency
Article with no author and no date identified (e.g., Wiki article)

Harry Potter. (n.d.).In Wikipedia.Retrieved March 12, 2010, from http://
en.wikipedia.org/wiki/Harry _Potter

Entry in an online dictionary or Reference work, no date and no author identified
Verisimilitude.(n.d.).In Merriam-Webster’s online dictionary (11" ed.). Retrieved from http:/
/www.merriam-webster.com/dictionary/verisimilitude

E-mail or other personal communication (cite in text only) Monterey, personal
communication, September 28, 2001)
12.6 Book on CD, T ape and Movie

Nix, G. (2002).Lirael, Daughter of the Clayr[CD]. New York, NY: Random House/
Listening Library.
Book on tape

Nix, G. (2002).Lirael, Daughter of the Clayr[Cassette Recording No. 1999- 1999-
1999]. New York, NY: Random House/Listening Library.
Movie

Gilby, A. (Producer), & Schlesinger, J. (Director).(1995). Cold comfort farm [Motion
picture]. Universal City, CA: MCA Universal.
12.7 Reference Specifications

Text citations: Source material must be documented in the body of the paper by citing
the author(s) and date(s) of the sources. The underlying principle is that ideas and words of

others must be formally acknowledged. The reader can obtain the full source citation from
the list of References that follows the body of the paper.

When the names of the authors of a source are part of the formal structure of the
sentence, the year of publication appears in parentheses following the identification of the
authors. Consider the following example:
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Wirth and Mitchell (1994) found that although there was a reduction in insulin dosage
over a period of two weeks in the treatment condition compared to the control condition, the
difference was not statistically significant. [Note: and is used when multiple authors are
identified as part of the formal structure of the sentence. Compare this to the example in the
following section.]

When the authors of a source are not part of the formal structure of the sentence,
both the authors and year of publication appear in parentheses. Consider the following
example:

Reviews of Research on religion and health have concluded that at least some types
of religious behaviours are related to higher levels of physical and mental health (Gartner,
Larson, & Allen, 1991; Koenig, 1990; Levin &Vanderpool, 1991; Maton&Pargament, 1987,
Paloma& Pendleton, 1991; Payne, Bergin, Bielema, & Jenkins, 1991). [Note: &is used when
multiple authors are identified in parenthetical material. Note also that when several sources
are cited parenthetically, they are ordered alphabetically by first authors’ surnames and
separated by semicolons.]

When a source that has two authors is cited, both authors are included every time the
source is cited.

When a source that has three, four, or five authors is cited, all authors are included
the first time the source is cited. When that source is cited again, the first author’s surname
and “et al.” are used. Consider the following example:

Reviews of Research on religion and health have concluded that at least some types
of religious behaviours are related to higher levels of physical and mental health (Payne,
Bergin, Bielema, & Jenkins, 1991).

Payne et al. (1991) showed that ...

When a source that has six or more authors is cited, the first author’'s surname and
“et al.” are used every time the source is cited (including the first time).

Every effort should be made to cite only sources that you have actually read. When
itis necessary to cite a source that you have not read (“Grayson” in the following example)
that is cited in a source that you have read (“Murzynski&Degelman” in the following example),
use the following format for the text citation and list only the source you have read in the
References list:

Grayson (as cited in Murzynski&Degelman, 1996) identified four components of
body language that were related to judgments of vulnerability.

To cite a personal communication (including letters, emails, and telephone interviews),
include initials, surname, and as exact a date as possible. Because a personal communication
is not “recoverable” information, it is not included in the References section. For the text
citation, use the following format:

B. F. Skinner (personal communication, February 12, 1978) claimed ...
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To cite a Web document, use the author-date format. If no author is identified, use
the first few words of the title in place of the author. If no date is provided, use “n.d.” in place
of the date. Consider the following examples:

Degelman (2009) summarises guidelines for the use of APA writing style.

Changes in Americans’ views of gender status differences have been documented
(Gender and Society, n.d.).

To cite the Bible, provide the book, chapter, and verse. The first time the Bible is cited
in the text, identify the version used. Consider the following example:

“You are forgiving and good, O Lord, abounding in love to all who call to you” (Psalm
86:5, New International Version). [Note: No entry in the References list is needed for the
Bible.]

Quotations: When a direct quotation is used, always include the author, year, and
page number as part of the citation.

A quotation of fewer than 40 words should be enclosed in double quotation marks
and should be incorporated into the formal structure of the sentence. Consider the following
example:

Patients receiving prayer had “less congestive heart failure, required less diuretic
and antibiotic therapy, had fewer episodes of pneumonia, had fewer cardiac arrests, and
were less frequently intubated and ventilated” (Byrd, 1988, p. 829).

A lengthier quotation of 40 or more words should appear (without quotation marks)
apart from the surrounding text, in block format, with each line indented five spaces from the
left margin.

References: All sources included in the References section must be cited in the body
of the paper (and all sources cited in the paper must be included in the References section).

Pagination: The References section begins on a new page.
Heading: “References” (centered on the first line below the running head)

Format: The References (with hanging indent) begin on the line following the
References heading. Entries are organised alphabetically by surnames of first authors.
Most Reference entries have the following components:

Authors: Authors are listed in the same order as specified in the source, using surnames
and initials. Commas separate all authors. When there are eight or more authors, list the
first six authors followed by three ellipses (...) and then the final author. If no author is
identified, the title of the document begins the Reference.

Year of Publication: In parentheses following authors, with a period following the
closing parenthesis. If no publication date is identified, use “n.d.” in parentheses following
the authors.

Source Reference: Includes title, journal, volume, pages (for journal article) or title,
city of publication, publisher (for book). Italicize titles of books, titles of periodicals, and
periodical volume numbers.
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Electronic Retrieval Information  : Electronic retrieval information may include digital
objectidentifiers (DOIs) or uniform resource locators (URLS). DOIs are unique alphanumeric
identifiers that lead users to digital source material. To learn whether an article has been
assigned a DOI, go to http://www.crossref.org/guestqueryy/.

Example of APA-formatted Internet References: Go to http://www.vanguard.edu/
uploadedFiles/Psychology/References.pdfExamples of sources

Journal article with DOI

Murzynski, J., &Degelman, D. (1996).Body language of women and judgments of
vulnerability to sexual assault.Journal of Applied Social Psychology, 26, 1617- 1626.
doi:10.1111/j.1559-1816.1996.tb00088.x

Journal article without DOI, print version

Koenig, H. G. (1990). Research on religion and mental health in later life: A review
and commentary. Journal of Geriatric Psychiatry, 23, 23-53.

Journal article without DOI, retrieved online

For articles retrieved from databases, include the URL of the journal home page.
Database information is not needed. Do not include the date of retrieval.]

Aldridge, D. (1991). Spirituality, healing and medicine.British Journal of General
Practice, 41, 425-427. Retrieved from http://www.rcgp.org.uk/publications/bjgp.aspx

Book

Paloutzian, R. F. (1996). Invitation to the psychology of religion (2nd ed.). Boston,
MA: Allyn and Bacon.

Informally published Web document

Degelman, D. (2009). APA style essentials.Retrieved from http://www.vanguard.edu/
faculty/ ddegelman/detail.aspx?doc_id=796

Informally published Web document (no date)

Nielsen, M. E. (n.d.). Notable people in psychology of religion.Retrieved from http:/
Iwww.psywww.com/psyrelig/psyrelpr.htm

Informally published Web document (no author, no date)
Gender and society.(n.d.). Retrieved from http://www.trinity.edu/~mkearl/gender.html
12.8 Abstract from Secondary Dat abase

Garrity, K., &Degelman, D. (1990).Effect of server introduction on restaurant
tipping.Journal of Applied Social Psychology, 20, 168-172. Abstract retrieved from PsycINFO
database.

Article or chapter in an edited book Shea, J. D. (1992).Religion and sexual adjustment.
In J. F. Schumaker (Ed.),Religion and mental health (pp. 70-84). New York, NY: Oxford
University Press.

Diagnostic and Statistical Manual of Mental Disorders
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American Psychiatric Association.(2000). Diagnostic and statistical manual of mental
disorders (4th ed., text rev.). Washington, DC: Author.

12.9 Footnotes

Footnotes: Content footnotes are occasionally used to support substantive information
in the text. A content footnote may be placed at the bottom of the page on which it is
discussed or on a separate page following the References.

Pagination: Footnotes begin on a separate page.
Heading: “Footnotes” is centered on the first line below the running head.

Format: Indent the first line of each footnote 5-7 spaces and number the footnotes
(slightly above the line) as they are identified in the text.

Example of APA-formatted

Footnotes: http://www.vanguard.edu/uploadedFiles/Psychology/Footnote.pdf

Tables: A common use of tables is to present quantitative data or the results of
statistical analyses (such as ANOVA). See the Publication Manual (2010, pp. 128- 150) for
detailed examples. Tables must be mentioned in the text.

Pagination: Each Table begins on a separate page.

Heading: “Table 1” (or 2 or 3, etc.) is typed flush left on the first line below the running
head. Double-space and type the table title flush left (italicized in uppercase and lowercase
letters).

Example of APA-formatted Tables.
http://www.vanguard.edu/uploadedFiles/Psychology/table.pdf

Figures: A common use of Figures is to present graphs, photographs, or other
illustrations (other than tables). See the Publication Manual (2010, pp. 150-167) for detailed
examples.

Pagination: Figures begin on a separate page.

Figure Caption: “Figure 1.” (or 2 or 3, etc.) is typed flush left and italicized on the first
line below the figure, immediately followed on the same line by the caption (which should be
a brief descriptive phrase).

Example of APA-formatted

Figure: http://www.vanguard.edu/uploadedFiles/Psychology/figure.pdf

Appendixes: A common use of appendixes is to present unpublished tests or to
describe complex equipment or stimulus materials.

Pagination: Each Appendix begins on a separate page.

Heading :If there is only one appendix, “Appendix” is centered on the first line below
the manuscript page header. If there is more than one appendix, use Appendix A (or B or C,
etc.). Double-space and type the appendix title (centered in uppercase and lowercase

letters).
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Format: Indent the first line 5-7 spaces.
Example of APA-formatted Appendix
http://www.vanguard.edu/uploadedFiles/Psychology/Appendix.pdf
12.10 General Guidelines to Write References
Start on a new page. Center the word References at the top. As usual, double space.

Any citations made in the manuscript must be presented in this section and vice
versa. That is, if something is not cited in the text, then it should not appear in this section.
In still other words, this is not a bibliography.

In any of the previous sections, whenever you say something like studies have shown
you must provide a citation. This section tells the reader where they can find these citations.

This section is alphabetized by last name (of the first author involved in the study).

A hanging indent is employed for each Reference, that is, the first line is not indented
and the rest are five-space indented.

For each author, give the last name followed by a comma and the first (and middle)
initials followed by periods.

Separate multiple authors with commas and the last author with the ampersand (‘&)
rather than the word “and”.

After the author(s) comes the year (in parentheses and followed by a period).

For a journal Reference, italicize the title of the journal and the volume number. Note
that issue numbers are typically not included. Also, capitalize the important words of the
journal title.

For a book Reference, just italicize the title. Only capitalise the first word of the title.
Do include the city, state (as a two-letter abbreviation without periods), and the publisher’s
name.

See the example Reference section. It provides several types of References, including:
Single and multiple author, journal articles, book, and book chapter, web page, as well as a
government document.

12.11 Summary

In this unit we have tried to present how the references shouldbe written. We have
tried to differentiate between references and bibliography. We pointed out that a list of
Reference is an integral part of the Research Report. It may be headed as ‘References’ or
‘Bibliography’. While Bibliography is a comprehensive term which includes, in addition to
referred literature, other related and very useful literature which readers may like to read
which the Researcher has himself read but not referred to it in the text of the thesis. All
literature referred to in the text must appear in the Reference list. We learnt all about the
guidelines to follow while writing references, in the style of American Psychological Association
(APA) format.
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We also discussed how to write the reference when it is a single author, more than

one author and multiple authors. When there is more than one author, the initial of the first
author must be followed by ‘a comma’. The wording of the title should appear exactly as it
does on the title page of the book or first page of the article. The name of the journal should
either appear as it is or be abbreviated according to accepted abbreviations.

We also learned about how to write the reference for the same author who has

published in different years and also in the same year. How to write a journal reference and
a book reference were also presented.

12.12 Glossary

References: comprise all documents including journals, books, technical Reports,
computer programmers and unpublished works mentioned in the text of the Report.

Bibliography : contains everything that is included in the Reference section plus
other publications which are useful but were not cited in text or manuscript.

APA style : uses the author/date method of citation in which the author’s last name
and the year of the publication are inserted in the actual text of the paper. It is the
style recommended by the American Psychological Association and used in many of
the social sciences.

12.13 Answers to Self-check Exercise

1. What is the significance of References in a Research Report?
2. How will you differentiate between references and bibliography
3. If the same author has multiple books how would you write the reference for them?

12.14 Suggested Readings

Bhandarkar, P.L. and Wilkinson, T.S. (2016). Methodology and Techniques of Social
Research. Himalaya Publishing House: New Delhi.

Donald R. Cooper and Pamela S. Schindler. (2006). Business Research Methods.
9th Edition, Tata McGraw Hill.

Ghosh, B.N. (2015). Scientific Method and Social Research. Himalayan
PublishingHouse, New Delhi.

Goode, William J., and Hatt, Paul K. (1952). Methods in Social Research, New York:
McGraw-Hill.

Gopal, M.H. (1970). An introduction to research procedures in social sciences.
AsiaPublishing House, New Delhi.

Gupta, S.P. (2021). Statistical Method (46th edition), Sultan Chand and Sons, New
Delhi.

Kothari, C.R. (2004). Research Methodology Methods and Techniques, New
Agelnternational (P) Limited: New Delhi.
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12.15

Panneerselvam, R. (2013). Research Methodology. Prentice-Hall of India Pvt. Ltd.,
New Delhi.

Publication Manual of the American Psychological Association (Sixth Edition, 2009).
American Psychological Association. Washington, DC.

Rao K.V. (1993). Research Methodology in Commerce and Management, Sterling
Publishers Private Limited: New Delhi.

SadhuA.N. and A. Singh. (2017). Research Methodology in Social Sciences, Himalaya
Publishing House, New Delhi.

Saravanavel, P. (2019). Research Methodology. KitabMahal. Allahabad.
Sekaran, U. (2006). Research methods for Business, Wiley India, New Delhi.

Singh, AK. (2009). Test Measurements and Research Methods in Behavioural Sciences
(Fifth Edition). BhartiBhawan Publishers & Distributors.

Thakur, H.K. (2021). Research Methodology in Social Sciences. Corvette Press,
NewDelhi.

Terminal Questions

Elaborate upon the central guidelines for writing references from diverse sources.
Give suitable examples.

How will you write references for the internet resources?

Elucidate the style of referencing according to the APA format, especially single
author and multiple authors

How will you write the references for internet books in particular? Give examples.

*kkkk
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Chapter-13
REFERENCING SOFTWARE

STRUCTURE
13.0 Learning Objectives
13.1 Introduction
13.2 Referencing Softwares
13.3 Use of Referencing Software
13.4 Best Referencing Software
13.4.1 Mendeley
13.4.2 EndNote
13.4.3 Zotero
13.4.4 Docear
13.4.5 Citavi
13.4.6 Wizfolio
13.4.7 Paperpile
13.4.8 RefWorks
13.4.9 Papers
13.4.10 Sciwheel
13.5 Guide to Best Referencing Softwares for Academic Research
13.6 Summary
13.7 Glossary
13.8 Answers to Self-Check Exercises
13.9 Suggested Readings
13.10 Terminal Questions
13.0 Learning Objectives
After going through this lesson, you will be able to:
* Know why the referencing softwares use in research, and

» Listthe most common referencing softwares used in the research with their strengths
and weakness.

13.1 Introduction

In the research work, referencing softwares help you to gather, organize, and cite
your sources more effectively- saving you time and energy in the long run. Good referencing
softwares can make all the difference for academic researchers and Ph.D. students from
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making sure your references are formatted correctly to helping you find and use them
quickly and easily. They allow you to keep track of your references, create bibliographies,
and collaborate with other researchers.But with so many different types of software to
choose from, how do you know which one is right for you? This chapter aims to give you an
overview of the most common referencing softwares used in the research and discussed
their strengths and weakness.

13.2 ReferencingSof tware

Referencing software, or citation manager, is a program or online service that helps
you collect, organize, cite, and share your research sources. Most of these programs also
allow you to create bibliographies and footnotes in your research papers.

Referencing or Citation softwares help you find sources more quickly and easily.
Most softwares have built-in search engines that allow you to quickly find articles and other
resources related to your topic. They also allow you to save search parameters and customize
your results. The more sources you find, the better equipped you will be to make an informed
decision about how to word your paper’s thesis statement and plan out the rest of the writing
process.

13.3Use of Referencing Sof tware for Research

Whether you are a Ph.D. student or an academic researcher, it's important to use
referencing software for research. Here are three reasons why:

1. Itcan help you find information quickly and easily. With the right software, you can
quickly and easily find the information you need- no more wasted time searching
through endless pages of results.

2. Itmakes collaboration much easier. Have a group project? Reference management
software will help you share resources with ease. No more passing around notes or
spending hours trying to compile everything together by hand!

3. It can help you stay organized. When you're dealing with a lot of information, it's
important to have a system for keeping track of it all. Reference manager can help
you do just that.

13.4 Best Referencing Sof twares
13.4.1 Mendeley

Mendeley is a software that helps researchers manage their references. It can be
used to create bibliographies and citations, and it also allows users to collaborate with other
researchers. Mendeley can be accessed online or offline, and it is available for both Windows
and Mac users.

Mendeley reference manager allows you to store, organize, and search all of your
references from just one reference library. It makes it easy to add references and
bibliographies to your google docs. Mendeley reference manager allows you to read, highlight,
and annotate PDFs, and retain all of your ideas in one location across numerous pages.
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Strengths

» Increased collaboration as it allows you to invite your teammates who have Mendeley
to share the same paper.

» Portability is made easier as the software can simultaneously be installed on different
devices.

» It offers a browser plugin that works with Firefox and Google Chrome, so all you
need to do is bookmark your desired web pages, and it saves on your Mendeley
library.

Weakness

* Not allow you to edit subscript and superscript characters in the title. For instance,
number 2 in H20 needs to be in a small subscript which cannot be done through it.

Pricing/Free V ersion
* Free Version available with up to 2GB of cloud storage.
« Paid plans start from $4.99/month.

13.4.2 EndNote

Endnote software is used to manage and import references. It can help Ph.D. students
with compiling, storing, and managing references. Endnote desktop software helps to create
citations and bibliographies. It also allows for the sharing of references with colleagues.
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Strengths

* Endnote basic allows you to search databases and import citation info in Microsoft
word.

» Ithas both online and offline options, the ability to edit output styles based on Journal
requirements, and allows you to attach pdfs to references.

Weakness

* Does NOT work well with Google Drive

* Not free and takes longer to learn
Pricing/Free V ersion

* Free 30-day trial available.

« Paid version comes with a one-time cost of $99.
13.4.3 Zotero

Zotero is a reference management software that can be used by students and
researchers of all levels. It's a great way to keep track of your sources, as well as easily
create citations and bibliographies. Here are some of the ways Zotero can be especially
helpful for Ph.D. students.

Zotero helps you stay organized by allowing you to collect and save information
about your sources in one place.lt can be used to create citation information and bibliographies
in no time, so you can spend less time on paperwork and more time on your research.Zotero
integrates with many popular word processing programs, so you can easily use it as a
citation management program for your papers as you write them.
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Strengths
* Itis an open-source and free citation management software.

* Works as a plugin to your web-based browser thus allowing one-click import of the
references.

» Italso has social features(shared bibliographies) and can import BibTeX and export
to various word processing software (MS Word, Latex, etc.)

e Zotero saves your citation library to your local computer but syncs with multiple
computers so you can work from wherever you want.

Weakness

* The only shortcoming I noticed is that it does not work with WordPress, where | write
a lot of my papers. Although there is a WordPress widget for Zotero, it still needs
some work.

Pricing/Free V ersion
* Free plan available.
13.4.4 Docear

Docear is one of the most unique and powerful reference management tools that
helps researchers manage their references and PDFs. It integrates a number of features,
such as PDF management, reference management, mind mapping, and note-taking. Because
of its versatile features, Docear is an ideal tool for students, academics, and professionals.

Strengths
* Not just a reference manager, but also a composer of all research work.
» Very good for drafting your new paper by automatically including all of your comments
in pdf files in your word file.
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Weakness
* Might not be easy to understand at first, as it has a unique way of handling all of your
references.
Pricing/Free V ersion
» Free — open source
13.4.5 Citavi

Citavi is incredibly versatile which makes it so popular among academic researchers.
It can be used to manage references for all types of research projects, from essays and
theses to books and articles. This makes it an essential tool for any researcher who wants
to stay organized and efficient.Citavi is easy to use. It's simple enough that even novice
researchers can quickly learn how to use it without any trouble. But it's also powerful enough
that more experienced researchers will appreciate all its features.

Strengths

» Compatible with the most common writing software that makes it easy to get your
manuscript done in a brief period.

* It is easy to handle and is able to sort all the things you will need in your
research(references, notes, tasks).

» Citavi's Add-In for MS Word and its LaTeX support ensures accurate citations. You
can choose the style of the bibliography you want automatically inserted. There are
over 10,000 professional citation styles available for all academic disciplines.

Weakness
* The software is not always compatible with all devices, which can be a problem for
researchers who want to work on their references on the go.
Pricing/Free V ersion
* Free trial available
13.4.6 Wizfolio

There are a number of different software options available for reference management,
each with its own pros and cons. But if you're looking for software that can help you manage
your references effectively and efficiently, Wizfolio is definitely worth considering.

Wizfolio is a cloud-based reference management software that was designed
specifically for academic researchers. It allows you to quickly and easily gather all of your
references in one place, as well as organize them according to your own personal preferences.
Wizfolio also comes with a number of helpful features that make it fairly convenient to use.

Strengths
» It integrates with the web browser and word processing software.

* The web browser integration is very useful as all you have to do is click to add a page
as a reference. It is also an operating system independent.
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* It also integrates with WordPress and allows you to easily share references easily
between researchers.
Weakness
» It can be difficult to keep track of all your references if you don’t use the software
correctly.
Pricing/Free version
» Contact Wizfolio to get a customized quote.
13.4.7 Paperpile

If you're an academic researcher, Paperpile should be your go-to reference
management software. It's designed specifically for academics, making it the perfect choice
for those who need to keep track of a large number of citations. Paperpile makes it easy to
import references from a variety of sources, including PubMed, Google Scholar, and Web
of Science.

It also has powerful search features that allow you to quickly find the information you
need. And if you're working on a collaborative project, Paperpile makes it easy to share
references with your colleagues.

Strengths

» They can link to your Google account, so theoretically, you'll have 15GB of storage
and a nice Chrome extension, so adding papers to your library is incredibly simple. In
addition, Google Docs integration for citations is available, and a beta test for Word
is currently underway.

» Paperpile is a web-based reference management software that makes it easy to
import references from databases, journals, and websites.

* It automatically formats citations and bibliographies in a variety of styles, including

APA, MLA, and Chicago.

Weakness

» Paperpile is not as comprehensive as some of the other software options available.
Pricing/Free V ersion

* Free to use for one user and two papers.

« Paid plans from $2.99/month.
13.4.8 RefWorks

If you're an academic researcher, then you know the importance of using the right
tools for the job. And when it comes to reference management, there’s no better tool than
RefWorks. RefWorks is a web-based application that allows you to create and manage
your references from anywhere in the world. With RefWorks, you can easily import citations
from databases, journals, and websites, and then create bibliographies in any format you
need.
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But perhaps the best thing about RefWorks is its collaborative features. With RefWorks,
you can share your references with colleagues or classmates and work together on projects.
You can also create groups to collaborate on research topics.

Strengths

* Has Proprietary, Operating system support, Export file formats, Citation styles and
Word processor integration.

» Offers partial support for reference list file formats.
* Supports import file formats.
Weakness
» Does not have database connectivity.
» Doesn't store copies of articles.
Pricing/Free V ersion
* Free trial subscription available.
* Get a customized quote from the sales team.
13.4.9 Papers

Papers is a Mac OS X and Windows reference management program for academic
researchers and Ph.D. students used for managing bibliographies and references for writing
essays and articles. It's mostly used to collect references and maintain a PDF document
library, but it also offers a unified interface for document repository searches, metadata
editing, full screen viewing, and a range of document import and export options.

Strengths
» Itis very easy to fill with PDFs and bibliographic data can easily added.
* lItis integrated well to work with Word for Mac.

* It is available for the iPhone/iPad, which offers the opportunity to carry all your
references with you in your smartphone.

Weakness

* Many users have complained about the software’s clunky interface and how difficult
it can be to navigate.

Pricing/Free V ersion
» 30 day free trial available.
* From $3/month.

13.4.10 Sciwheel

SciWheel is a referencing software that can be very significant for academic
researchers. It helps manage references, PDFs, notes, and ideas. SciWheel has a powerful
search engine that makes it easy to find any document you need. It also allows you to create
groups for your documents, making it easy to keep track of your research.
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Strengths
» Auser-friendly interface that is easy to learn and use.

* Integrated search capabilities that allow you to search for information both inside and
outside of SciWheel.

* Collaborative features that allow you to share information with other researchers.
Weakness

* The software can be slow and cumbersome at times.

» It can be difficult to find information that is buried deep in the system.
Pricing/Free V ersion

* Free plan available.

* From $9.95/month.
13.5 Guide to Best Referencing Sof twares for Academic Research

When looking for referencing software, it's important to consider the features that will
be most helpful for academic researchers. Some features include:

1) The ability to import citations from a variety of sources, including online databases,
journals, and the internet.

2) The ability to organize citations into folders or groups.

3) The ability to create bibliographies or reference lists in a variety of formats, such as
MLA, APA, and Chicago.

4) The ability to export citations and bibliographies into Word documents or PDFs.
5) A search function that allows you to quickly find the citation you need.
6) A user-friendly interface that allows for quick and efficient organization.

13.6 Summary

In scholarly articles and research documents, citations play an important role for both
researchers and readers. Itis also very time-consuming to integrate these citations accurately
into research documents without the aid of referencing software. In this chapter, the most
common referencing softwares used in research are discussed with their strengths and
weaknesses.

13.7 Glossary

* Referencing sof tware :is a program or online service that helps to collect, organize,
cite, and share the research sources.

» References: comprise all documents including journals, books, technical Reports,
computer programmers and unpublished works mentioned in the text of the Report.

» Bibliography : contains everything that is included in the Reference section plus
other publications which are useful but were not cited in text or manuscript.
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APA style : uses the author/date method of citation in which the author’s last name
and the year of the publication are inserted in the actual text of the paper. It is the
style recommended by the American Psychological Association and used in many of
the social sciences.

13.8 Answers to Self-Check Exercises
1. What are the uses of referencing software for academic research

2. Write a note on Mendeley referencing software

3. How does EndNote referencing software use for academic research.
13.9 Suggested Readings

Bhandarkar, P.L. and Wilkinson, T.S. (2016). Methodology and Techniques of Social
Research. Himalaya Publishing House: New Delhi.

Donald R. Cooper and Pamela S. Schindler. (2006). Business Research Methods.
9th Edition, Tata McGraw Hill.

Ghosh, B.N. (2015). Scientific Method and Social Research. Himalayan Publishing
House, New Delhi.

Goode, William J., and Hatt, Paul K. (1952). Methods in Social Research, New York:
McGraw-Hill.

Gopal, M.H. (1970). An introduction to research procedures in social sciences. Asia
Publishing House, New Delhi.

Gupta, S.P. (2021). Statistical Method (46™ edition), Sultan Chand and Sons, New
Delhi.

Kothari, C.R. (2004). Research Methodology Methods and Techniques, New Age
International (P) Limited: New Delhi.

Panneerselvam, R. (2013). Research Methodology. Prentice-Hall of India Pvt. Ltd.,
New Delhi.

Rao K.V. (1993). Research Methodology in Commerce and Management, Sterling
Publishers Private Limited: New Delhi.

SadhuA.N. andA. Singh. (2017). Research Methodology in Social Sciences, Himalaya
Publishing House, New Delhi.

Saravanavel, P. (2019). Research Methodology. Kitab Mahal. Allahabad.

Sekaran, U. (2006). Research methods for Business, Wiley India, New Delhi.

Thakur, H.K. (2021). Research Methodology in Social Sciences. Corvette Press,
New Delhi.

13.10 Terminal Questions

1.

Discuss the most common referencing softwares used for academic research with
their strengths and weaknesses.
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Chapter-14
ANALYZING ECONOMICS IN NEWS

STRUCTURE

14.0 Learning Objectives

14.1 Introduction

14.2 The Role of Economics in the News

14.3 Economics Reporting: Opportunities and Challenges
14.4 Key Economic Topics in the News

14.5 The Influence of Economics Reporting on Policy
14.6 The Role of Economic Data and Statistics in News
14.7 Bias and Objectivity in Economic Reporting

14.8 Case Studies: Notable Economic News Events
14.9 The Future of Economics Reporting

14.10 Summary

14.11 Glossary

14.12 Answers to Self-Check Exercises

14.13 Suggested Readings

14.14 Terminal Questions

14.0 Learning Objectives

After going through this lesson, you will be able to:

Understand the role of economics in the news

List the key economic topics in the news

Understand the Influence of economics reporting on policy
Discuss therole of economic data and statistics in news
Understand the future of economics reporting

14.1 Introduction

Economics plays a pivotal role in shaping the world we live in. It governs decisions
made by governments, businesses, and individuals, impacting everything from employment
rates to the prices of goods and services. Consequently, the study of economics is essential
for understanding the mechanisms that drive our global society. One way to gain insight into

these mechanisms is by analyzing economics in the news.

The news media, in its various forms, serves as a powerful conduit for disseminating
economic information and shaping public opinion. Whether it's reporting on unemployment
figures, stock market fluctuations, trade policies, or inflation rates, economics is a frequent
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topic in the news. This chapter delves into the importance of analyzing economics in the
news, highlighting its role in informing the public, influencing decision-makers, and shedding
light on the complex web of economic factors that shape our world.

14.2 The Role of Economics in the News

Economics is often referred to as the “dismal science,” but it is anything but dismal
when it comes to its impact on society. From the decisions of central banks to the daily
budgeting choices of households, economics plays a critical role in our lives. Here, we
explore the multifaceted role of economics in the news.

1. Economic Education and Literacy

One of the fundamental roles of economics in the news is education. The news media
serves as a platform to educate the public about economic concepts, policies, and their
implications. Many individuals lack formal training in economics, making news outlets a vital
source of economic education.

When news articles explain topics like supply and demand, fiscal policy, or international
trade, they contribute to economic literacy. A well-informed public is better equipped to
make financial decisions, engage in public discourse, and hold policymakers accountable.
This education is essential in a world where economic decisions can have far-reaching
consequences.

2. Public Awareness

Economic news stories keep the public informed about significant developments that
affect their lives. Whether it’s rising gas prices, changes in mortgage rates, or shifts in the
job market, people rely on the news to understand how these changes impact their daily
routines.

For example, during a financial crisis, news reports can help individuals make informed
decisions about their investments and job security. Public awareness is a crucial tool for
mitigating the adverse effects of economic shocks, as it enables individuals and businesses
to adapt and plan accordingly.

3. Influencing Decision-Makers

Economics in the news has the power to influence policymakers, both at the government
and corporate levels. News outlets often play a role in shaping public opinion, which can, in
turn, impact the decisions of elected officials. For instance, widespread coverage of income
inequality may lead to public pressure on lawmakers to implement policies addressing this
issue.

Furthermore, businesses closely monitor economic news to make strategic decisions.
A report on potential changes in trade policies, for example, can prompt multinational
corporations to reassess their supply chains or investment strategies. Thus, economics in
the news can act as a catalyst for change, prompting decision-makers to respond to economic
challenges and opportunities.
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14.3 Economics Reporting: Opportunities and Challenges

While economics reporting has a vital role to play, it also faces several opportunities
and challenges in the modern media landscape. Understanding these dynamics is essential
for critically assessing economic news.

1. Opportunities in Digit al Media

The rise of digital media has expanded opportunities for economics reporting. Online
platforms, blogs, and social media allow for a diverse range of voices and perspectives on
economic matters. This democratization of information has enabled economists, researchers,
and analysts to share their insights directly with the public.

Additionally, digital media provides interactive tools and data visualization, making
complex economic concepts more accessible. Info-graphics, interactive charts, and multimedia
presentations can help individuals grasp economic trends and their implications.

2. Challenges of Sensationalism

In the competitive world of news media, sensationalism is a constant challenge.
Economic stories with sensational headlines tend to attract more readers or viewers, even
if the content lacks nuance or accuracy. This can lead to misinterpretation of economic
events and policies.

For example, a headline that screams “Stock Market Crash Imminent” might generate
more clicks than a balanced analysis of market fluctuations. Such sensationalism can fuel
panic, misinformation, and hasty decision-making among investors and the public.

3. Economic Complexity

Economics is a complex field that often involves intricate models, data analysis, and
a deep understanding of human behavior. Simplifying economic concepts for a general
audience without oversimplifying them is a constant challenge for economics reporters.

Economists may disagree on the interpretation of data or the effectiveness of policy
measures, leading to conflicting narratives in the news. It's essential for consumers of
economic news to be critical thinkers, recognizing that economic issues often involve multiple
perspectives and ongoing debates.

14.4 Key Economic T opics in the News
Economics in the news covers a wide range of topics, reflecting the diversity of

economic issues that impact society. Here, we delve into some of the key economic topics
that frequently make headlines:

1. Unemployment and Labor Market:

. Unemployment rates
. Job creation or loss
. Labor force participation
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. Inflation and Price Levels:

. Consumer Price Index (CPI)
. Producer Price Index (PPI)
. Impact on purchasing power

. Financial Market s:

. Stock market indices
. Bond yields

. Commodity prices

. Cryptocurrencies

. Monetary Policy:

. Central bank decisions (e.g., interest rates)
. Quantitative easing

. Money supply

. Fiscal Policy:
. Government budgets
. Tax policies
. Stimulus packages

. International T rade:

. Trade deficits/surpluses
. Tariffs and trade disputes
. Exchange rates

. Income Inequality:

. Wage disparities
. Wealth distribution
. Policies addressing inequality

. Economic Crises:

. Financial crises
. Banking crises
. Responses and bailouts

. Technological Advancement s:
. Impact on industries and employment
. Innovation and economic growth
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10.Environment al Economics:

. Climate change policies
. Sustainability and economic development
. Green technologies

Each of these topics has its own set of complexities, implications, and potential

consequences, making them crucial subjects for economic reporting. Moreover, they are
interconnected, with developments in one area often affecting others.

14.5 The Influence of Economics Reporting on Policy

Economics reporting plays a significant role in shaping public opinion, which can, in

turn, influence policy decisions. Here’s how economics in the news impacts policymaking:

1.

Public Awareness and Pressure: When economic issues gain widespread media
attention, the public becomes more aware and concerned. This increased awareness
can lead to public pressure on policymakers to address specific economic challenges.
For example, extensive reporting on the negative effects of income inequality can
lead to demands for policy reforms.

Policy Proposals and Debates : Economics reporting often covers proposed policy
measures to address economic problems. These proposals can spark public debates
and discussions. Policymakers pay attention to these debates and may modify their
policies in response to public sentiment.

Account ability: The media holds policymakers accountable for their economic
decisions. Investigative reporting can uncover corruption, inefficiencies, or misguided
policies, leading to increased scrutiny and potential policy changes.

International Relations : Economics reporting also affects international relations.
Coverage of trade disputes, currency manipulations, or sanctions can influence
diplomatic negotiations and trade policies.

Central Bank Independence: Central banks often rely on maintaining public trust
and credibility. Media coverage of their decisions and statements can affect financial
markets and economic stability. Consequently, central banks are often cautious in
their communications, aware of the potential market reactions.

14.6 The Role of Economic Dat a and Statistics in News

Economic reporting heavily relies on data and statistics to provide accurate and

timely information. Government agencies, research institutions, and private organizations
collect and analyze data on various economic indicators. Here’s the significance of economic
data in news reporting:

1.

Timely Information : Economic data releases, such as the monthly jobs report or
quarterly GDP figures, provide timely snapshots of the economy’s health. These
releases often generate headlines and discussions in the news.
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. Market Expect ations : Financial markets closely watch economic data releases and

often have expectations about the outcomes. Surprises, whether positive or negative,
can lead to market volatility. News outlets report on how these surprises impact
market sentiment.

Policy Decisions : Economic data can influence central bank decisions. For example,
a strong jobs report may lead a central bank to consider raising interest rates to
prevent overheating. The anticipation and analysis of these data points are integral to
economic reporting.

Long-Term Trends: Economic data also help identify long-term economic trends.
News stories that track trends in income inequality, technological advancements, or
demographic shifts contribute to our understanding of the evolving economic landscape.

Global Economic Interactions : International economic data, such as trade balances
and currency exchange rates, are essential for understanding global economic
interactions. Reporting on these data informs the public about international economic
dynamics.

14.7 Bias and Objectivity in Economic Reporting

The objectivity of economic reporting is a subject of debate and scrutiny. It's essential

to consider the potential biases and challenges associated with reporting on economic
matters:

1.

Political and Ideological Bias : Some news outlets may have political or ideological
biases that can influence their economic reporting. For instance, a conservative-
leaning media outlet may have a different perspective on tax policy than a liberal-
leaning one. Consumers of economic news should be aware of potential biases and
seek diverse sources of information.

Complexity and Simplification : Economics reporting often involves simplifying
complex topics for a general audience. However, oversimplification can lead to
misinterpretation or misunderstanding. Striking a balance between simplicity and
accuracy is a constant challenge for economic reporters.

Data Interpret ation: Economists and analysts may interpret the same economic
data differently, leading to divergent viewpoints in the news. It's important for
consumers of economic news to be critical thinkers, examining the data and
methodology behind the analysis.

Confirmation Bias: Consumers of economic news may seek out information that
confirms their existing beliefs or biases. This confirmation bias can lead to a skewed
understanding of economic issues. It's essential to engage with a variety of
perspectives and challenge one’s own preconceptions.

Sensationalism: As mentioned earlier, sensationalism can be a challenge in economic
reporting. News outlets may prioritize sensational headlines over nuanced analysis,
potentially leading to misguided perceptions of economic events.
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14.8 Case Studies: Not able Economic News Event s

To illustrate the impact of economic reporting, let's explore a few case studies of

notable economic news events:
1. The 2008 Financial Crisis:

The 2008 financial crisis was extensively covered in the media, leading to public
awareness and pressure for action.

Economic reporting highlighted the role of subprime mortgages, complex financial
products, and regulatory failures in the crisis.

Public sentiment influenced policymakers, leading to the Troubled Asset Relief Program
(TARP) and subsequent financial reforms.

2. Brexit:

The Brexit referendum and negotiations were closely monitored by the media.

Economic reporting discussed the potential economic consequences of Brexit, including
trade disruptions and investment uncertainties.

Public opinion and economic analyses played a role in shaping the negotiations between
the UK and the EU.

3. COVID-19 Pandemic:

The pandemic’s economic impact received extensive media coverage, from job losses
to government stimulus packages.

Economic reporting helped individuals understand the economic consequences of
lockdowns, travel restrictions, and supply chain disruptions.

Policymakers relied on economic data and public sentiment to design economic relief
measures.

4. Rise of Cryptocurrencies:

The surge in cryptocurrencies like Bitcoin garnered significant media attention.

Economic reporting discussed the potential implications of cryptocurrencies for financial
systems and investment portfolios.

Public interest in cryptocurrencies influenced market dynamics and regulatory
discussions.

These case studies highlight how economics reporting can shape public perception,
influence policy decisions, and provide valuable insights into complex economic events.

14.9 The Future of Economics Reporting

The landscape of media and journalism is constantly evolving, and economics reporting

IS no exception. Several trends and considerations are shaping the future of how economic
news is delivered and consumed:
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1. Digital Transformation : The shift to digital platforms continues, with more people
consuming news online and through mobile devices. This trend allows for greater
interactivity, multimedia content, and real-time updates.

2. Data Visualization: As data becomes increasingly integral to economic reporting,
the use of data visualization tools is likely to grow. Interactive charts, graphs, and
infographics can help readers better understand economic trends and statistics.

3. Fact-Checkingand Account ability : Fact-checking organizations and tools are playing
a critical role in holding news outlets accountable for accuracy. Ensuring the credibility
of economic reporting is essential in an era of information overload.

4. Diverse Voices: The digital era allows for a more diverse range of voices in economic
reporting. Independent bloggers, economists, and subject matter experts can
contribute to a richer and more inclusive economic discourse.

5. Challenges of Misinformation : Misinformation and “fake news” are challenges that
the news media must address. Economic reporting is notimmune to false or misleading
information, and combating it is an ongoing concern.

6. Ethical Considerations :Aseconomic reporting influences public opinion and policy,
ethical considerations become paramount. Journalists must balance the need for
transparency and accuracy with the potential impact of their reporting.

7. Global Perspective : In an interconnected world, understanding global economic
dynamics is crucial. Economics reporting should provide insights into international
economic relations and their impact on local economies.

14.10 Summary

Analyzing economics in the news is essential for understanding the complex forces
that shape our world. Economics reporting serves as an educational tool, informing the
public, influencing decision-makers, and holding institutions accountable. However, it also
faces challenges, such as bias, sensationalism, and the need to simplify complex topics.

As consumers of economic news, it's imperative to be critical thinkers, seeking diverse
perspectives and fact-checking information. The media’s role in economic reporting is evolving
in the digital age, with opportunities for data visualization, interactivity, and diverse voices.
Ultimately, a well-informed public and responsible journalism are essential for a thriving and
economically literate society.

14.11 Glossary
» Data visualization : is the graphical representation of information and data.

» Digital media: is digitized content that can be transmitted over the internet or
computer networks.

* Economics reporting : reporting that follows any news that impacts the economy
of a community or country.

165



* Sensationalism : the presentation of stories in a way that is intended
to provoke public interest or excitement, at the expense of accuracy.

14.12 Answers to Self-Check Exercises
1. Write briefly on the role of economics in the news
2. How does Economics Reporting influence Policy?
3. What is the future of Economics Reporting?
14.13 Suggested Readings

*  Snow, N. (2020). The role of the media in shaping economic narratives. Journal of
Economic Journalism, 8(2), 123-145.

* Williams, J. R. (2018). Economics reporting in the digital age: Challenges and
opportunities. Journal of Business and Economic Reporting, 6(1), 45-67.

* The Economist. (2022). How the news media influences economic policy. The
Economist, 437(9521), 33-35.

*  Financial Times. (2021). The impact of economic news on financial markets. Financial
Times, 25(7), 12-14.

*  Smith, L. (2019). Economics reporting in the age of fake news. Journal of Economic
Analysis, 12(3), 89-101.

* Reuters. (2020). Reporting on global economic crises: Lessons from the past. Reuters
Economics Review, 7(4), 321-334.

14.14 Terminal Questions
1. Explain the role of economics in the news. Also mention the key economic topics in
the news.
2. What are the opportunities and challenges of economics reporting?
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Chapter-15
CONTEMPORARY ECONOMIC EVENTS

STRUCTURE
15.0 Learning Objectives
15.1 Introduction
15.2. Significance of Writing about Contemporary Economic Events
15.3 Role of the Media in Covering Economic Events
15.4 Key Contemporary Economic Events in Recent History
15.5 Challenges and Responsibilities of Journalists
15.6 Contemporary Economic Events in a Digital Age
15.7 Summary
15.8 Glossary
15.9 Answers to Self-Check Exercises
15.10 Suggested Readings
15.11 Terminal Questions
15.0 Learning Objectives
After going through this lesson, you will be able to:
» Understand the significance of writing about contemporary economic events,
* Know the role of the media in covering economic events,
» List the key contemporary economic events in the recent history,
* Understand the challenges and responsibilities of journalists
* Know about thecontemporary economic events in a digital age
15.1 Introduction

In today’s interconnected world, staying informed about contemporary national and
global economic events is of paramount importance. Economic events, whether they are
local fiscal policies or global trade agreements, have far-reaching implications that can
affect individuals, businesses, and nations on a large scale. This chapter deals with the
significance of writing about contemporary economic events, the role of the media, key
events in recent history, and the challenges and responsibilities of journalists in covering
these topics.

15.2. Significance of W riting about Contemporary Economic Event s

Contemporary economic events serve as windows into the complex machinery that
drives our world. They are the outcomes of decisions made by governments, central banks,
corporations, and individuals, all of which have ripple effects on various aspects of society.
Here are several reasons why writing about these events is vital:
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Informed Decision-Making : Knowledge of contemporary economic events
empowers individuals and businesses to make informed decisions. Whether it's
investing in the stock market, planning for retirement, or starting a new business,
understanding economic events is essential.

Policy Implications : Economic events often stem from government policies and
decisions. Writing about these events can shed light on the impact of these policies,
promote transparency, and influence public opinion.

Global Interconnectedness : In anincreasingly globalized world, economic events
in one part of the globe can reverberate across borders. Writing about these events
helps people understand how global interconnectedness affects their lives.

Predictive V alue: Analyzing contemporary economic events can offer insights into
future trends. For instance, a series of declining manufacturing orders may indicate
an impending economic downturn.

Education: Writing about economic events can help educate the public about
economic concepts, theories, and principles. Awell-informed public is more likely to
engage in meaningful discussions and make responsible choices.

15.3 Role of the Media in Covering Economic Event s

The media plays a crucial role in shaping public understanding of contemporary

economic events. Whether through newspapers, television broadcasts, online articles, or
social media, the media is a primary source of information for most individuals. Here’s how
the media fulfills this role:

1.

Information Dissemination:  The media’s primary function is to disseminate
information. Journalists gather data, conduct interviews, and analyze economic events
to provide accurate and timely reports to the public.

Education: Journalists explain complex economic concepts and events in a way that
is accessible to a broad audience. This educational aspect helps demystify economics
and empowers individuals to engage with these topics.

Transp arency and Account ability : By reporting on economic events, the media
holds institutions and decision-makers accountable for their actions. Investigative
journalism can uncover corruption, inefficiencies, and unethical practices.

Influence on Public Opinion:  Media coverage can shape public opinion and influence
the decisions of policymakers. Well-researched and balanced reporting can lead to
more informed public discourse.

Market Imp act: The media also has a direct impact on financial markets. Breaking
news can trigger market reactions, affecting stock prices, exchange rates, and
commodity prices.
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15.4 Key Contemporary Economic Event s in Recent History

To understand the importance of writing about contemporary economic events, let’s

examine some key events from recent history that have had a significant impact on national
and global economies:

1. The Global Financial Crisis (2007-2008):

This crisis, triggered by the collapse of Lehman Brothers and the housing market
bubble burst, had far-reaching consequences.

It led to a severe recession, bank bailouts, and a global credit crunch.

The crisis prompted widespread discussions about financial regulation, responsible
lending practices, and risk management.

2. The Eurozone Debt Crisis (2010-2015):

Several Eurozone countries, including Greece, Spain, and Italy, faced crippling levels
of public debt.

The crisis tested the stability of the Eurozone and the European Union.

Policymakers implemented austerity measures, leading to protests and social unrest
in some countries.

3. Brexit (2016):

The United Kingdom’s decision to leave the European Union had significant economic
and political ramifications.

It led to uncertainty in financial markets, currency fluctuations, and changes in trade
relationships.

Negotiations on trade agreements continue to affect the UK and EU economies.

4. The COVID-19 Pandemic:

The pandemic had a profound impact on the global economy, leading to lockdowns,
business closures, and travel restrictions.

Governments implemented stimulus packages to mitigate economic damage, leading
to increased government debt.

Supply chain disruptions and shifts in consumer behavior have affected various
industries.

5. Trade Wars (e.g., U.S.-China T rade War):

Trade tensions between major economies, such as the United States and China,
have led to tariffs and trade restrictions.

These trade disputes have had implications for global supply chains and international
trade relationships.

These events highlight the multifaceted nature of contemporary economic events, as

they involve a mix of financial, political, and social factors. Writing about these events
provides context, analysis, and insights into their causes and consequences.
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15.5 Challenges and Responsibilities of Journalist s

Covering contemporary economic events is not without its challenges and

responsibilities. Journalists face several hurdles when reporting on complex economic topics:

1.

Complexity : Economics is often viewed as a complex and technical field. Journalists
must simplify economic concepts without oversimplifying them to ensure clarity while
maintaining accuracy.

Bias and Objectivity: Maintaining objectivity in economic reporting can be challenging,
especially when political or ideological factors come into play. Journalists must strive
for balanced reporting and avoid partisanship.

Data Interpret ation: Economic data can be subject to interpretation, and different
experts may have varying views on the same data. Journalists should provide context
and multiple perspectives.

Sensationalism : The media’s pursuit of attention-grabbing headlines can sometimes
lead to sensationalism, which can distort the true nature of economic events.
Timeliness : In a fast-paced news environment, journalists often face pressure to
report quickly. Balancing speed with accuracy is crucial to avoid errors.

Access to Information : Some economic events involve proprietary or confidential
information, making it challenging for journalists to access critical data.
Globalization: Understanding the global nature of contemporary economic events
requires a broad perspective and access to international sources.

To address these challenges and fulfill their responsibilities, journalists should adhere

to ethical principles such as accuracy, fairness, and transparency. Fact-checking, thorough
research, and seeking diverse viewpoints are essential practices in economic reporting.

15.6 Contemporary Economic Event s in a Digit al Age

The digital age has transformed the way we access and consume information about

contemporary economic events. Several trends are shaping the landscape of economic
journalism:

1.

Online Media : The shift to online media has allowed for real-time updates and a
global audience. News websites, blogs, and social media platforms are primary
sources of economic news.

Data Visualization: Interactive data visualizations, including charts, graphs, and
infographics, help readers understand economic trends and statistics more easily.
Citizen Journalism : The rise of citizen journalism and social media platforms has
enabled individuals to report on economic events and share their perspectives.
Data Journalism: Data-driven journalism involves using data analysis and visualization
to tell stories. This approach adds depth and context to economic reporting.
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5. Fact-Checking: Fact-checking organizations play a crucial role in verifying information
and holding news outlets accountable for accuracy.

6. Personalization: Some news platforms use algorithms to personalize content based
on readers’ interests, ensuring that individuals receive relevant economic news.

7. Global Perspective : Online access to international news sources allows readers to
gain a global perspective on economic events and their impact.

The digital age has democratized access to economic information, allowing more
voices to contribute to the discourse. However, it has also brought challenges related to
misinformation, filter bubbles, and the need for media literacy.

15.7 Summary

Writing about contemporary national and global economic events is not merely a
journalistic endeavor; it is a societal imperative. These events shape our economic well-
being, our policy choices, and our understanding of the world. The media plays a pivotal role
in providing the public with the information needed to navigate this complex landscape.

While journalists face challenges in reporting on economics, they also have a
responsibility to ensure accuracy, objectivity, and transparency. In a digital age where
information flows freely and rapidly, the role of journalists in curating, analyzing, and
contextualizing economic news is more critical than ever.

Ultimately, the public’s understanding of contemporary economic events influences
not only individual decisions but also the direction of nations and the global economy. Therefore,
the pursuit of excellence in economic journalism is an essential component of a well-informed
and empowered society.

15.8 Glossary

» Citizenjournalism : journalism that is conducted by people who are not professional
journalists but who disseminate information using Web sites, blogs, and social media.

» Data visualization : is the graphical representation of information and data.

* Digital media : is digitized content that can be transmitted over the internet or computer
networks.

» Economicsreporting :reporting that follows any news that impacts the economy of
a community or country.

* Online media: refersto contentthatis presented electronically (digital media formats)
on websites or servers whereby detail is able to be retrieved through web browsers.

* Sensationalism : the presentation of stories in a way that is intended to provoke public
interest or excitement, at the expense of accuracy.

15.9 Answers to Self-Check Exercises
1. Define the term ‘Citizen Journalism’.
2. What are the challenges and responsibilities of journalists?
3. Explain the role of the media in covering economic events.
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15.10 Suggested Readings

Snow, N. (2020). The role of the media in shaping economic narratives. Journal of
Economic Journalism, 8(2), 123-145.

Williams, J. R. (2018). Economics reporting in the digital age: Challenges and
opportunities. Journal of Business and Economic Reporting, 6(1), 45-67.

The Economist. (2022). How the news media influences economic policy. The
Economist, 437(9521), 33-35.

Financial Times. (2021).The impact of economic news on financial markets. Financial
Times, 25(7), 12-14.

Smith, L. (2019). Economics reporting in the age of fake news. Journal of Economic
Analysis, 12(3), 89-101.

Reuters. (2020). Reporting on global economic crises: Lessons from the past. Reuters
Economics Review, 7(4), 321-334.

15.11 Terminal Questions

1. Explain the significance of writing about contemporary economic events.
2. What are key contemporary economic events in recent history.
3. What are contemporary economic events in a digital age.
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Chapter-16
CONTEMPORARY INDIAN ECONOMIC DATA AND POLICIES

STRUCTURE
16.0 Learning Objectives
16.1 Introduction
16.2 Economic Overview
16.3 Employment and Labour Market
16.4 Industrial and Trade Policies
16.5 Fiscal Policies and Government Finances
16.6 Infrastructure and Development
16.7 Healthcare and Education
16.8 Environmental Sustainability
16.9 Financial Inclusion and Digital Economy
16.10 Indian Economic Survey
16.10.1 Content of Indian Economic Survey
16.10.2 Impact of Indian Economic Survey
16.11 Indian Budget
16.11.1 Content of Indian Budget
16.11.2 Impact of Indian Budget
16.12 Annual Policy Data of RBI
16.12.1 Content of Annual Policy Data of RBI
16.12.2 Impact of Annual Policy Data of RBI
16.13 Summary
16.14 Glossary
16.15 Answers to Self-Check Exercises
16.16 Suggested Readings
16.17 Terminal Questions
16.0 Learning Objectives
After going through this lesson, you will be able to:

* Understand some significance subjects of the contemporary Indian economic events,
and

* Analyse the Indian Economics Survey, Indian Budget and Annual Policy Reports
issued by RBI.
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16.1 Introduction

India, the world’s second-most populous country, has been a dynamic player on the
global economic stage in recent decades. Its growth trajectory, economic policies, and
development challenges have drawn the attention of economists, policymakers, and investors
worldwide. This chapter delves into contemporary Indian economic data and policies, aiming
to provide a comprehensive understanding of the country’s current economic landscape and
the policies that shape it. Indian Economic Survey, Indian Budget, and various annual policy
reports issued by RBI are also analysed in this chapter.

16.2 Economic Overview
1) GDP Growth

India’s economic performance has been characterized by fluctuating GDP growth
rates in recent years. In the early 2010s, the country experienced robust growth, often
exceeding 7 per cent annually. However, this growth decelerated in the latter part of the
decade. As of the most recent data available, India’s GDP growth rate has been affected by
various factors, including the COVID-19 pandemic and the subsequent economic recovery
efforts.

2) Sectoral Composition

The structure of India’s economy is multi-sectoral, with agriculture, manufacturing,
and services playing significant roles. Analyzing data on sectoral contributions to GDP
sheds light on the country’s economic diversification. It also highlights the shifts in employment
patterns, productivity, and the potential for future growth.

3) Inflation and Monet ary Policy

Inflation is a critical economic indicator affecting the purchasing power of individuals
and the stability of the economy. Examining the data on inflation rates and the Reserve Bank
of India’s monetary policy interventions provides insights into the country’s inflation
management strategies.

16.3 Employment and Labour Market
1) Unemployment Rate

The employment situation in India has been a subject of debate and concern. A
comprehensive analysis of contemporary employment data, including the unemployment
rate and underemployment trends, reveals the challenges faced by the labor market. This
section also explores the impact of the COVID-19 pandemic on employment.

2) Labour Force Particip ation

Understanding labour force participation rates, particularly among various demographic
groups, provides insights into the evolving dynamics of India’s workforce. Analyzing gender
disparities and regional variations in labor force participation is essential for policymaking.
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16.4 Industrial and T rade Policies
1) Make in India Initiative

The “Make in India” initiative, launched to promote domestic manufacturing, has been
a prominent policy in recent years. Analyzing the data on foreign direct investment (FDI),
export trends, and the success of this initiative helps evaluate its effectiveness in bolstering
the manufacturing sector.
2) Trade Agreement s

India’s trade policies and agreements have a significant impact on its economic
interactions with the rest of the world. Investigating data on trade volumes, tariff structures,
and the effects of trade agreements can shed light on the country’s international economic
relations.
16.5 Fiscal Policies and Government Finances
1) Fiscal Deficit

The fiscal deficit is a critical indicator of a government’s financial health. Analyzing
India’s fiscal policies, government spending, and revenue collection provides insights into
the country’s budgetary priorities and sustainability.
2) Tax Reforms

Recent tax reforms, such as the Goods and Services Tax (GST), have aimed to
simplify India’s tax structure and enhance tax compliance. Evaluating the impact of these
reforms through data analysis helps assess their effectiveness and the challenges they have
posed.

16.6 Infrastructure and Development
1) Infrastructure Investment

Infrastructure development s crucial for sustained economic growth. Examining data
on infrastructure investment, including transportation, energy, and digital infrastructure, offers
insights into the government’s commitment to improving the country’s economic backbone.
2) Rural and Urban Divide

India grapples with disparities between rural and urban areas. Analyzing data on
rural development programs, access to basic services, and the rural-urban income gap can
help gauge the progress made in bridging these divides.

16.7 Healthcare and Education
1) Public Health Expenditure

The COVID-19 pandemic underscored the importance of healthcare infrastructure
and public health expenditure. Evaluating data on healthcare spending and access to medical
services helps assess India’s preparedness for health crises.
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2) Education Quality and Access

Education is a vital determinant of human capital development. Analyzing data on
literacy rates, school enrollment, and educational outcomes provides insights into the state
of education in India and its implications for future economic growth.

16.8 Environment al Sust ainability
1) Pollution and Emissions

Environmental sustainability is an increasingly important consideration in economic
policymaking. Examining data on pollution levels, greenhouse gas emissions, and government
initiatives for environmental protection helps assess India’s commitment to sustainability.

2) Renewable Energy

The promotion of renewable energy sources is a key component of India’s sustainable
development strategy. Analyzing data on renewable energy adoption and investment in the
sector provides insights into the country’s progress toward clean energy goals.

16.9 Financial Inclusion and Digit al Economy
1) Financial Inclusion Metrics

Financial inclusion is vital for inclusive economic growth. Analyzing data on financial
access, digital payment adoption, and the impact of financial inclusion initiatives helps assess
progress in this area.

2) Digit al Transformation

The digital economy is rapidly growing in India. Examining data on internet penetration,
e-commerce, and the adoption of digital technologies sheds light on the country’s digital
transformation and its potential economic benefits.

16.10 Indian Economic Survey

The Indian Economic Survey is an annual document prepared by the Department of
Economic Affairs, Ministry of Finance, Government of India. It serves as a prelude to the
Indian Budget and provides a comprehensive review of the country’s economic performance,
challenges, and opportunities. The survey'’s significance lies in its role as a policy blueprint
and a source of vital economic data for various stakeholders.

16.10.1 Content ofIndian Economic Survey
The survey encompasses a wide range of economic aspects, including:

1) Economic Growth and Outlook : It evaluates India’s economic growth in the previous
year and presents projections for the future, considering sectors like agriculture,
industry, and services.

2) Fiscal Paolicy : The survey discusses government revenue, expenditure, deficits, and
debt management strategies. It outlines fiscal priorities and policies.

3) Monetary Policy: It provides insights into India’s monetary policy, including inflation
rates, interest rates, and measures adopted by the RBI to regulate the money

supply.
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4)

5)

6)

7)

8)

External Sector : This section reviews India’s trade balance, balance of payments,
foreign exchange reserves, and their implications for the Indian economy.

Social Sectors : The survey assesses the progress made in social sectors such as
education, healthcare, and poverty alleviation, shedding light on the government’s
initiatives.

Agriculture and Rural Development:  Given the significance of agriculture in India,
the survey analyzes the performance of this sector and discusses policies related to
rural development.

Industry and Infrastructure: It provides an overview of industrial growth,
infrastructure development, and related challenges and opportunities.

Environment al Sust ainability : Recent surveys have included a chapter dedicated
to environmental and sustainability concerns, reflecting global awareness of these
ISsues.

16.10.2 Impact of Indian Economic Survey

The Indian Economic Survey plays a vital role in shaping economic policy decisions:

1)

2)

3)

Policy Recommendations: The survey offers policy recommendations to address
economic challenges, influencing budgetary allocations and policy priorities.
Informed Decision-Making:  Policymakers use the survey’s data and analysis to
make informed decisions regarding fiscal, monetary, and sectoral policies.

Public Discourse: The survey’s findings spark public discourse and debates on the
government’s economic policies, enhancing transparency and accountability.

16.11 Indian Budget

The Indian Budget is an annual financial statement presented by the Finance Minister

to the Parliament of India. It outlines the government’s revenue and expenditure for the fiscal
year, which typically runs from April 1st to March 31st. The budget is a crucial tool for
resource allocation, taxation, and policy implementation.

16.11.1 Content of Indian Budget

The Indian Budget comprises several key components:

1)

2)

3)

Revenue and Expenditure: It presents the government’s estimates of revenue
receipts, including tax revenue and non-tax revenue. It also outlines planned
expenditures, categorizing them into capital and revenue expenditures.

Taxation: The budget provides details of changes in tax rates, exemptions, and
other fiscal measures. It influences the taxation landscape for businesses and
individuals.

Sectoral Allocations : The budget allocates resources to various sectors, including
education, healthcare, defense, infrastructure, and social welfare. It reflects the
government’s policy priorities.
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4)

Fiscal Deficit and Borrowings: It highlights the fiscal deficit, which is the gap
between government revenue and expenditure. The budget details how the deficit

will be financed, including domestic and external borrowings.

16.11.2 Impact of Indian Budget
The Indian Budget’s impact is multi-faceted:

1)

2)

3)

Resource Allocation: It allocates resources to sectors and programs, impacting
economic development, social welfare, and infrastructure.

Economic S tability: The budget’s fiscal deficit and borrowing strategies affect
economic stability and investor confidence.

Policy Direction: The budget sets the policy direction for taxation, public spending,
and economic reform initiatives.

16.12 Annual Policy Dat a of RBI

The Reserve Bank of India (RBI) publishes its annual policy statement, outlining its

monetary policy decisions and macroeconomic assessments. This document is instrumental
in steering India’s monetary policy, influencing interest rates, inflation, and financial stability.

16.12.1 Content of Annual Policy Dat a of RBI
The annual policy data of RBI typically includes:

1)

2)

3)

4)

5)

Monetary Policy Review: It outlines the RBI's decisions regarding key interest
rates like the repo rate, reverse repo rate, and cash reserve ratio (CRR).

Inflation Assessment : The document provides an analysis of inflation trends, factors
influencing inflation, and the RBI’s inflation targets.

Economic Outlook: It offers insights into the RBI's assessment of India’s economic
prospects, growth expectations, and challenges.

Financial S tability : The annual policy statement discusses financial stability, risks,
and regulatory measures.

Banking and Credit Policies : The RBI's stance on banking regulations, credit
availability, and measures to enhance the efficiency of the financial sector is detailed.

16.12.2 Impact of Annual Policy Dat a of RBI
The annual policy data of RBI has a profound impact on the Indian economy:

1)

2)

3)

4)

Interest Rates: RBI’'s decisions on interest rates directly affect borrowing costs for
individuals and businesses, influencing consumption and investment.

Inflation Control:  The policy statement outlines measures to control inflation, ensuring
price stability and economic predictability.

Financial Market s: Monetary policy decisions impact financial markets, including
equity, bond, and currency markets.

Banking Sector : It guides the banking sector in terms of lending practices, regulatory

compliance, and financial stability.
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16.13 Summary

In conclusion, analyzing contemporary Indian economic data and policies reveals a
complex economic landscape marked by both challenges and opportunities. To navigate
these challenges and capitalize on the opportunities, policymakers must consider evidence-
based recommendations across various sectors, including employment, fiscal policy,
infrastructure, healthcare, education, and sustainability. India’s economic trajectory will
continue to influence its position on the global stage, making data-driven policymaking more
critical than ever.

The Indian Economic Survey, Indian Budget, and annual policy data of RBI are the
cornerstones of India’s economic governance. They collectively define the country’s economic
priorities, policies, and resource allocation strategies. These documents serve as critical
references for policymakers, economists, investors, and the general public, shaping the
economic direction of the nation. Their coordination and alignment are essential in ensuring
India’s economic stability, growth, and development

16.14 Glossary

» Fiscal Policy :is defined as the policy under which the government uses the instrument
of taxation, public spending and public borrowing to achieve various objectives of
economic policy.

* Monetary Policy : Monetary policy refers to the steps taken by a country’s central
bank to control the money supply for economic stability

» Fiscal deficit: is the difference between the total revenue and total expenditure of a
governmentin afinancial year.

* Make in India : initiative is based on four pillars, which have been identified to give
boost to entrepreneurship in India, not only in manufacturing but also other sectors.

» Labour Force Particip ation : The labour force participation rate is calculated as the
labour force divided by the total working-age population.

» Digital Economy: is defined as an economy that focuses on digital technologies,
i.e., itis based on digital and computing technologies.

16.15 Answers to Self-Check Exercises
1. Define Digital Economy.
2. Write a note on Indian Economic Survey
3. What is meant by Indian Budget?

16.16 Suggested Readings

*  Snow, N. (2020). The role of the media in shaping economic narratives. Journal of
Economic Journalism, 8(2), 123-145.

 Williams, J. R. (2018). Economics reporting in the digital age: Challenges and
opportunities. Journal of Business and Economic Reporting, 6(1), 45-67.

179



The Economist. (2022). How the news media influences economic policy. The
Economist, 437(9521), 33-35.

Financial Times. (2021).The impact of economic news on financial markets. Financial
Times, 25(7), 12-14.

Smith, L. (2019). Economics reporting in the age of fake news. Journal of Economic
Analysis, 12(3), 89-101.

Reuters. (2020). Reporting on global economic crises: Lessons from the past. Reuters
Economics Review, 7(4), 321-334.

16.17 Terminal Questions

1.

How does the Indian government use data from the Economic Survey and Union
Budget to formulate economic policies? Provide examples of recent policy decisions
influenced by these documents and their impact on the Indian economy.

Examine the key economic indicators outlined in the annual policy data released by
the Reserve Bank of India (RBI). How do changes in interest rates, inflation, and
monetary policy affect the Indian economy, and what role does the RBI play in
managing these factors?

Examine the government’s initiatives in sectors such as agriculture, manufacturing,
and services to promote sectoral growth and employment generation.
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